
DiversityDescriptions 
DiversityDescriptions (version 4) is part of the database framework Diversity Workbench. Each
DWB module is devoted to a specific data domain. The domain of DiversityDescriptions covers
the knowledge about descriptions of organisms and descriptions of any other item/ element/
entity which are object of diversity research. It can be used to describe individual organisms,
research items/ objects (e.g. specimens, observation and measurement events, plots) as well
as taxa, syntaxonomic entities (e.g. species, plant-sociological entities, ecosystems).   

 The descriptions are characterized by a triple structure, namely
'item-descriptor-state' or 'item-descriptor-value' or 'item-character-character state' or
'entity-attribute-value' or 'element-property-value'. 

 The states or values, which build the item/description, can be generalized to one of
the presently supported data types (categorical states, quantitative values and
statistical measures, molecular sequence data and free-form text as a fall-back
option). 

 The descriptors (= characters, attributes, properties) are not limited to morphological
characters and functional traits, but could address physiological, ecological, behavioral
and even interview parameter, some molecular descriptors and descriptors of data
content schemes. 

    

The image below gives a rough overview how the triple structure is represented in the data
tables of DiversityDescriptions. A detailled database diagram including all tables and their data
columns can be found here. At the right side you can see the descriptors and categorical
states that build the "descriptive terminology". Currently four descriptor types are
supported:

1. Categorical descriptor
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may be used for representing discrete enumerable categorical states, e.g. color: red -
green - blue   

2. Quantitative descriptor
may be used for storing numeric values, e.g. minimum, maximum, mean   

3. Text descriptor
free-form text, applicable if no other descriptor type is suitable   

4. Molecular sequence descriptor
may be used for storing nucleotide or protein sequences   

While the first three descriptor types are most commonly known in the context of descriptive
data, the molecular sequence descriptor is designed according the SDD standard of TDWG.
(An alternate entry point to SDD can be found here.) In most cases molecular sequence data
may be mapped to text descriptor data, e.g. for export to a DELTA file. 

    

At the left side of the image above there are the "descriptive data", which consist of the
single description or item and the associated summary data. In analogy to the four descriptor
types there are categorical and quantitative summary data, text descriptor data and
molecular sequence data that reference the corresponding descriptor and store the actual
values for the item (green lines).  For an item description scopes can be specified, e.g. taxon
names or specimens, which may optionally be linked to the corresponding module of the 
Diversity Workbench (orange lines at the very left). Additionally for each descriptor a data
status may be specified, e.g. to indicate that a certain descriptor/character should be
specified but actually no data are available (Descriptor Status Data).  

To make this very abstact overview a little bit more tangible, find in the image below a tiny
example taken from the tutorial. The "Example plant" is a "Tree" and has the "Leaf color"
"green" (Categorical Summary Data). Its "Leaf length" is between 5 and 10 cm (Quantitative
Summary Data) and for "Literature" (currently) no data are available. Additionaly the taxon
name "Ulmus campetris" has been associated to the "Example plant" (Description Scope).  
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DiversityDescriptions keeps only descriptive data. Data of other realms like e.g. taxonomy are
handled in separate modules. For an overview of the available modules see Diversity
Workbench. DiversityDescriptions might also be used as a stand-alone application. 

Besides the descriptive data that represent the summarized data e.g. for a certain species,
Diversity Descriptions provides the feature of appending Sample Data to each description.  

To each description or item several "sampling events" may be appended, which build the
anchor for the "sampling units". The sampling event holds additional data like the date and
time or a time span when the data were collected, the geographic location and coordinates.
The sampling unit represents a tuple of values that belong to an individual probe, e.g. an
evaluated organism (see image above). The sample data may be exported together with the
descriptive data to the SDD format, which provides full sample data support. Optionally sample
data may be exported to the DELTA format, where each sampling unit is mapped to a separate
item.  

DiversityDescriptions 4 is based on Microsoft SQL-Server (version 2008 R2 or newer
recommended) and the .Net Framework, Version 4.8. 

For licence and copyright see the licence section. 
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Even if you are already familiar with other Diversity Workbench modules, it is strongly
recommended to take a look into the Tutorial to get an overview of the main features of
DiversityDescriptions. 
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Installation
To run DiversityDescriptions, you need the database and the client. All parts are free and can
be downloaded from http://www.microsoft.com/downloads/ and
http://www.diversityworkbench.net/Portal/.

The image below gives an overview of the installations and files needed. Starting with
Diversity Descriptions 4.x.x an installer tool will be provided, which copies the needed files into
the program files directory of the system. For installation Windows admin rights are required.
As an alternate way the well-known method of providing a .zip file with the program directory
might be provided, too. In any way the user files will be kept separated from the program files
(see Resources directory).

 

Client

The client is based on the .Net framework version 4.8 from Microsoft. If not already present,
you have to install the framework first. Download and install the Microsoft .NET Framework
(see http://www.microsoft.com/downloads/ for the latest versions).

Download the files for DiversityDescriptions from http://www.diversityworkbench.net/Portal/
provided as a zip archive. In case of a setup file (.msi) execute the installer and follow the
instructions. In case of a compressed program folder, copy all files (DiversityDescriptions.exe 
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, DiversityDescriptions.chm , DiversityWorkbench.dll  ...) into your working directory. 

Please observe the general download notes of the DiversityWorkbench page!

 

Database

For the installation of a local database see the section Installation of the database.
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Menu
Overview of the menu in DiversityDescriptions:

Connection 

    Database ... Choose one of the databases available on the server. Only those databases
will be listed to which the user has access permission. 

    Reconnect to database Reconnect to the actual database and reload basic data. 
         Auto connect   Automatically connect to database (only with windows login). 

    Module connections ... Edit the connections to the other modules within the Diversity Workbench. 
    Timeout for database ... Set the timeout for database queries. 
    Timeout for web requests ... Set the timeout for web requests. 

    Transfer previous settings ... 
Transfer the settings for IP-Address and port of the server, name of the
database, login etc. of a previous version of the client to the current
version. 

    Current server activity ... View current activities on the database server. 
    Quit Quit the application and stop all processes started by the application. 

Edit 
        Descriptions Select edit mode for descriptions. 
        Descriptors Select edit mode for descriptors. 
        Projects Select edit mode for projects. 
    Tranlsations ... Edit or view translations. 
    Summarize descriptions ... Summarize description data. 
    Summarize sampling data ... Summarize sampling data. 

Grid 
    Description grid ... Edit or view descriptions in a grid. 
    Sample data grid ... Edit or view sample data in a grid. 
    Table editor   
       Projects ... Edit the projects in the query result list.  
       Sampling events ... Edit the sampling events for the descriptions in the query result list.  
       Descriptions ... Edit the descriptions in the query result list.  
       Description scopes ... Edit the scopes of the descriptions in the query result list.  
       Description resources ... Edit the resources for descriptions in the query result list.  
       Descriptors ... Edit the descriptors in the query result list. 
       Descriptor resources ... Edit the resources for descriptors in the query result list.  
       Categorical states ... Edit the categorical states of the descriptors in the query result list.  

       Categorical state resources ... Edit the resources for the categorical states of the descriptors in the query
result list.  

       Descriptor tree node resources ... Edit the resources for the descriptor tree nodes of the projects in the query
result list.  

       Resource variants ... Edit the resources for entities in the query result list.  
       Translations ... Edit the translations for entities in the query result list.  

Query 
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        Show query Show the query window.   
        Preferred project ... Set or view the preferred project for query windows.   
    Extended query ... Extended query for description data.   

Data 
     Save dataset Save the actual dataset in the database.   

     Restore from log ... Restore deleted datasets from the log tables in the database (only for
administrator).    

    Generate document ... Generate a document with descriptions, descriptors or projects from the
query list.   

    Import 
       Import wizard Import wizard.   

          Matrix wizard ... Import descriptor, description and sample data from a tabulator separated
text file. 

          Sample data ... Import sample data for descriptions from a tabulator separated text file.   
          Descriptions ... Import descriptions from a tabulator separated text file. 
          Descriptors ... Import descriptors from a tabulator separated text file. 
          Import resources Import resources. 
             Description resources ... Import description resources from a tabulator separated text file.   
             Descriptor resources ... Import descriptor resources from a tabulator separated text file. 
             Categorical state resources ... Import categorical state resources from a tabulator separated text file. 
             Descriptor tree node resources ... Import descriptor tree node resources from a tabulator separated text file.  

             Resource variants ... Import resource variants from a tabulator separated text file -special import
to append resource variants. 

       Organize sessions ... Organize import sessions.   
       Import SDD ... Import SDD files. 
      Import DELTA ... Import DELTA files. 
       Import questionnaire data ... Import revised data received from HTML forms.   
    Export 

       Matrix wizard ... Export descriptor and description data as tabulator separated list and
generate an import schema for the Matrix Import Wizard.   

      Export data ... Export data in a structured data file format (SDD, DELTA, EML).   
       Export questionnaires ... Export description data of a project or from a query list as HTML forms.   
       Export lists   Export tabulator separated lists.   
          Sample data list ... Export sample data list. 

          Descriptions list ... Export descriptions list. 

          Descriptors list ... Export descriptors list.   

         Resource data list ... Export resource data list document for review and possible re-import of
modified data.   

       Export CSV ... Export database tables in CSV format.   
    Cache database ... Export data of selected projects into a cache database.   
    Backup database ... Create a backup of the database.   
    File operations File operations (no database connection needed).   
       Convert SDD file ... Convert a SDD file to DELTA or EML without database access.   
       Convert DELTA file ... Convert an DELTA file to SDD or EML without database access.   
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       Check SDD file ...   Check if an SDD file is compliant to the XML schema SDD 1.1 rev 5.   
       Check EML file ...   Check if an EML file is compliant to the XML schema EML 2.1.1.   

Administration 
   Change password ... Changing the password of a user.   
   Database   

       Database tools ... Tools for the administration of the objects in the database. For experts only!
 

       Documentation ... Generate documentation of the information model.   

       Logins ... Administration of the logins of the server their permissions in the databases. 
  

       Maintenance ... Maintenance of database entries, especially, if connected to other modules. 

       Rename database ... Rename the current database.   
       Set published address ... Setting the address published for links by other modules.   
    Linked server ... Administration of the linked servers.   
     Projects ... Administration of the projects.   
   Resources directory ... Changing the the resources directory.   

Help 
    Manual Opens the user manual.   
    Feedback ... Opens a window for sending feedback.   
    Feedback history ... Opens a window for browsing former feedback.   
    Edit feedback ... Opens a window for feedback editing - only for special users possible.   
    Statistics ... Overview of statistical data for the database contents.   
    Info ... Show the version of the program and corresponding information.   
    Websites Websites related to Diversity Descriptions.   

        Download application ... Download Diversity Descriptions from the website of the Diversity Workbench
project.   

        Information model ... 
Inspect the information model on the website of the Diversity Workbench
project.   

        SDD homepage ... Visit the TDWG homepage for the SDD standard.   
        EML homepage ... Visit the KNB homepage for the EML standard.   
        DELTA homepage ... Visit the DELTA homepage for the DELTA standard.   
        Example files ... Visit the repository of Diversity Descriptions example files. 
    Error log View the actual error log file.   
            Keep error log Change the error log settings to "Keep error log". 
            Clear error log at program start Change the error log settings to "Clear error log at program start".   
    Clear error log Clear the actual error log file.   

Update 
     Update database ... Update the database to the current version.   
     Update client ... Download the current version of the client.   

 

Page 9



 

 

 

 

Page 10



Manual
The online manual DiversityDescriptions.chm must be placed in your application folder,
together with the application DiversityDescriptions.exe and the library DiversityWorkbench.dll.
To get information to any topic in the application DiversityDescriptions and open this manual,
just click on the field you need information about and press F1. To open the manual from the
menu, choose Help -> Manual ....
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Statistics
For statistical information about the database contents choose Help -> Statistics ....

The Users tab shows information about the users with access to the database. This output
may be restrictied to your own data if you do not have sufficient acces rights (see image
below). 

The Projects tab shows information about the local projects in the database and the entered
data (see image below). 
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The Descriptor trees tab shows information about the local projects in the database, their
descriptor trees and nodes and the number of assigned descriptors (see image below). 
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Version
For information about the version of the client application and the database choose Help->

Info ...

The current version in the example above is 4.1.1. The required database version is 3.1.4.
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License
This manual is copyrighted work licensed under a Creative Commons License.

All material in this manual is the property of the contributing authors and fully copyrighted. By
choosing this way of publication, the contributing authors have agreed to license the work
under a Creative Commons License permitting reproduction, distribution, and derivative works,
requiring attribution, notice, and share-alike, and prohibiting commercial use.

 For information about the license of the client software choose Help -> Info ...

The client software is free software: you can redistribute it and/or modify it under the terms
of the GNU General Public License as published by the Free Software Foundation. 

The client software is distributed in the hope that it will be useful, but WITHOUT ANY
WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A
PARTICULAR PURPOSE. See the GNU General Public License (GPL) for more details. 
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Update of database and client
DiversityDescriptions is still in development. Therefore regular updates for the database and
the client will be provided. When you start the program and connect to a database, the
program will check if it is compatible with the database or if the database needs an update. In
any of these cases write access to the database will be locked to prevent possible data
corruption. If a new client version is required, an Update entry in the menu bar will appear.
This menu will contain an Update client ... entry. Click on it to open the webpage where
you can download the cient as shown below. 

 

If you are database owner (role = "db_owner" or user = "dbo") and the database needs to be
updated, the Update entry will appear in themenu bar and contain an Update database
... entry. Select this entry to open a window as shown below to run the provided update
scripts, delivered with the client software. These scripts needs to run consecutively, so e.g.
to update from version 3.0.7 to 3.0.10 you have to run the scripts
DiversityDescriptionsUpdate_030007_to_030008,
DiversityDescriptionsUpdate_03008_to_030009 and
DiversityDescriptionsUpdate_030009_to_030010. The program will guide you through these
steps and check for the scripts. All you have to do is click the Start update button.  
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In some cases updates may be optional, e.g. if a special adjustment for dedicated projects
shall be introduced. By default these optional updates will be skipped (see picture above, last
update script). By clicking on  Optional you get a description of the optional update and
will be offered to activate it (see pictures below). 

 

 

If you do not have sufficient rights to update the database, a message window will appear
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that informs you about a compatible client version. You may contact the database owner to
perform the database update or download the appropriate client software by selecting Help
->  Websites ->  Download application ... from the menu.  
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Resources directory
In the resources directory all files are stored that have been generated by Diversity
Descriptions, e.g. due to export. Furthermore you may store files here that shall be used for
data import into the Diversity Descriptions database and the error log file. The resources
directory may be set via the menu Administration->  Resources directory ... (see image
below).

There are 3 possibilities for the resources directory: 

 Select the "Home directory" of the user (may  be definded via
%HOMEDRIVE%%HOMEPATH%) 

   Select the "My Documents" directory of the user 
 Select any directory you have read/write access (User defined) 

The default is set to Home. Below this node the directories "DiversityWorkbench" will be
created and below that "DiversityDescriptions", which will contain all files that a Diversity
Descripiton user needs user need access to. If you install additional Diversity Workbench
applikations and use resources directory option "Home directory", they will all get dedicated
directories under "..<user>\DiversityWorkbench\". 

Certain directories are hidden (Query, Settings, Spreadsheet) and are handled by the software
i.e. the content should not be changed by the user. The other folders (Export, Import and so
on) are a copy of folders placed in the program directory (see below). 
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Feedback
If you have suggestions for improvement, need any changes in the program or encounter an
error you can give a feedback to the administrator. Click on the [ALT] and [PRINT] buttons to
get a screen shot of your current form. After creating the screen shot choose Help -> 
Feedback from the menu to open the feedback window as shown below.

 

Click on the button to insert the screen shot and give a comment about your

problem. Then click on the button to send your feedback to the administrator. If
you want to receive a message, when the problem you described is solved, please enter you
e-mail address in the field under the descrption. 

To inspect you former feedbacks, choose Feedback history... from the Help menu. A
window will open, where you can browse your old feedback together with the state of
progress. 

In case you do not have access to the central database for the feedbacks, the program will
open your mail client to send an e-mail. In case of bugs in the program it would help if you
attach the file DiversityDescriptionsError.log located in your application directory (see
below). 

 

Error logging
If any error messages show up through working with the application you can find further
details concerning the part of the application where the error occured and the parameters
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involved in the file DiversityDescriptionsError.log located in your application's resources
directory (see image below). 

You may open the error log file by clicking Help -> Error log. By default the error log file
will be cleared each time when the application ist started. With option Help-> Error log ->
Keep error log you may change this setting to keep the error log (see image below).   

With option Help-> Error log -> Clear error log at program start you change this setting
to the original default. If you decide to keep the error log file, you have the option to clear its
contents with option Help-> Clear Error log  (see image below).   
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Tutorial - first steps
This tutorial will guide you through the first basic steps in DiversityDescriptions. After the 
installation, make sure you have access to the database. To start the programm double click
on the DiversityDescriptions.exe in the directory where you copied the files of
DiversityDescriptions. The main window will open.

 

In this tutorial it is assumed that you installed a local database server and are running
DiversityDescriptions with the DiversityDescriptions_Base database available at the 
DiversityWorkbench portal.  If you open this window for the first time, you need to connect to
the database. Click on the button or choose Connection -> Database... from the menu. A
window will open where you may enter your account information and choose the database
(see image below, for further information see database access). 

Page 24

http://diversityworkbench.net/Portal/DiversityDescriptions


 

After connecting to the server and choosing a database click on the OK button to return to
the main form. As indicated by the symbol in the right upper corner, you are now connected
to the database. The tooltip of the button will show your current login information (see
below). To enable an automatic connection for the next start of DiversityDescriptions select
menu item Connection->Auto connect. 

 

To get access to at least one workbench project open the login administration from menu
Administration->Database ...->Logins .... Assumed you are working with the same
Windows accout the has been used for installation of the Microsof SQL-Server, you are the
"database owner" (dbo), which has the highest database access rights. In this case select
entry "dbo" from "Logins", then click on the database "DiversityDescriptions_Base" and open
the "Projects" tab in the login administration (see below). There is only one entry in, the
default workbench project "DiversityWorkbench", in the "No access" area. Select this entry
and click the > button to make it accessible. Usually "DiversityWorkbench" is not used but a
project is loaded from DiversityProjects instead. However in this tutorial we want to
demonstrate use of DiversityDescriptions as a stand-alone application. Finally close the login
administration window.  
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This tutorial is continued in the sections listed below. 

 section Create a new local project
 section Enter a text descriptor
 section Enter a quantitative descriptor
 section Enter categorical descriptors
 section Enter description data
 section Searching the database 
 section Generate an HTML document 
 section Sort the descriptors
 section Assign modifiers
 section Enter descriptor dependencies
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Tutorial - Create a new local project 
To create a new local project, select edit mode projects from menu Edit->Projects. Now
click on the button in the upper left panel (see point 1 in image below). In case of more
than one workbench project being available in the database, the software will ask you to
select the workbench project assigned to the new local project (see Projects for further
information). 

The new local project is created with a numeric name. Change it to "Tutorial" (see point 2 in
image above). Then check the workbench project (should be "DiversityWorkbench") and that
no other local project is selected as a parent of the new one (see points 3 and 4 in image
above). Finally save the project (see point 5 in image above) and the project name will be
updated in the header and the query panel at the left side of the window (see image below). 

If you like, you may now enter additional project data like a detailled project descripition
("Details"), a copyright text ("Rights"), the address of a license text in the internet ("License"
- button opens a browser window to navigate to the license page) and you may select the
project's lanuage (see point 1 in image below). 
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If you want to use scope values for sex in your descriptive data, select the scope category
"sex" (see point 2 in image above). Now the "Add" button is enabled. When you click on the
button (see point 3 in the image above) a drop-down menu offers predefined sex values.
Select "Male", then again click on the "Add" button and select value "Female". The two
values are now appended to item "sex". To make them available for the tutorial project click
on the boxes before the values to set them checked (see image below). 

  

For the other scope categories no predefined values exit. When you click the "  Add" button,
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values with a numeric name will be appended that can be renamed by clicking on button "
Edit" and selecting menu item "  Edit scope name". 

A more detailled description of all editing options can be found in the Edit projects section of
this manual.

 

This tutorial is continued in the sections listed below. 

 section Enter a text descriptor
 section Enter a quantitative descriptor
 section Enter categorical descriptors
 section Enter description data
 section Searching the database 
 section Generate an HTML document 
 section Sort the descriptors
 section Assign modifiers
 section Enter descriptor dependencies
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Tutorial - Enter a text descriptor 
To create a new text descriptor, select edit mode descriptors from menu Edit->Descriptors.
Now click on the button in the upper left panel (see point 1 in image below).  

The new descriptor is created with a numeric name. Change it to "Literature" (see point 2 in
image above), because this descriptor shall allow insert of literature references or citations as
free form text into the description data. Then set the descriptor type to "Text" (see points 3
in image above) and set the sequence number to "1" (see points 4 in image above). Finally
save the descriptor (see point 5 in image above) and the descriptor name will be updated in
the header and the query panel at the left side of the window. 

If you like, you may now enter additional descriptor data like a detailled project descripition
("Details") or "Notes". But we want to attach a resource link to our new text descriptor, that
symbolizes the descriptor's duty. Therefore select the "Resource links" tab (see point 1 in
image below) and enter the resource name "Literature" (see point 2 in image below). Now you
can enter the URL of a picture that is reachable in the internet (see point 3 in image below, a
link to Wikipedia was used). Alternatively you may double-click on the "URL" field to open a
browser window, where you can navigate to the picture location. Finally, don't forget to save
your changes (see point 4 in image below). 

Page 30

http://upload.wikimedia.org/wikipedia/commons/0/04/Carl_Spitzweg_021.jpg


  

Until now the descriptor is not assigned to any project, i.e. it cannot be used for entering
descriptive data. Assignment of descriptors to projects is done by using "descriptor trees".
This allows on the one hand a thematical grouping of the descriptors, on the other hand the
descriptors may be appended to several trees simultaniously. I.e. descriptors my be used in
several distinct projects.

Since no descriptor tree has been created yet, select the "Descriptor tree" tab (see point 1 in
image below), right-click the project "Tutorial" and select context menu entry "Add descriptor
tree" (see point 2 in image below). A new descriptor tree is appended to the project "Tutorial"
with a numeric name. Right-click the descriptor tree and select "Edit name" from the context
menu to change the name to "Descriptor tree for tutorial" (see point 3 in image below). To
append the actual descriptor to the tree, click button at the right tool bar (see point 4 in
image below). In the "Descriptor tree" tab most functions are alternatively accessible by the
tool bar at the right or by the context menu that opens when you right-click a tree node.
Finally, don't forget to save your changes (see point 5 in image below). 
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A more detailled description of all editing options can be found in the Edit descriptors section
of this manual.

 

This tutorial is continued in the sections listed below. 

 section Enter a quantitative descriptor
 section Enter categorical descriptors
 section Enter description data
 section Searching the database 
 section Generate an HTML document 
 section Sort the descriptors
 section Assign modifiers
 section Enter descriptor dependencies
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Tutorial - Enter a quantitative descriptor 
To create a new quantitative descriptor, select edit mode descriptors from menu 
Edit->Descriptors. Now click on the button in the upper left panel (see point 1 in image
below).  

The new descriptor is created with a numeric name. Change it to "Leaf length" (see point 2 in
image above) and set the sequence number to "2" (see points 3 in image above). Now switch
to the main tab and set the descriptor type to "Quantitative" (see points 4 and 5 in image
above). For the quantitative descriptor we enter the measurement unit "cm", a minimum and a
maximum value (see points 6 and 7 in image above). Finally save the descriptor (see point 8 in
image above) and the descriptor name will be updated in the header and the query panel at
the left side of the window. 

As for the text descriptor we want to attach a resource link to our new quantitative
descriptor, that symbolizes the descriptor's duty (see image below, a link to Wikipedia was
used). 
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Certainly the quantitative descriptor shall be attached to the "Descriptor tree for tutorial" that
was created in the last step. In the descriptor tree tab select "Descriptor tree for tutorial" and
click button tab select "Descriptor tree for tutorial" and click button at the right tool bar
(see image below). 
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For quantitative descriptors a number of statistical measures are defined, for which values can
be entered in the descriptive data. In the descriptor tree fo each descriptor of descriptor tree
node may be specified, which values shall be used in the descriptive data. A click on button 

opens the recommended statistical measures on the right side of the window (see image
below). Select the quantitative descriptor in the descriptor tree and then check the statistical
measures "Minimum value", "Maximum value" and "Mean" (see image below). 

A more detailled description of all editing options can be found in the Edit descriptors section
of this manual.

 

This tutorial is continued in the sections listed below. 
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 section Enter categorical descriptors
 section Enter description data
 section Searching the database 
 section Generate an HTML document 
 section Sort the descriptors
 section Assign modifiers
 section Enter descriptor dependencies
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Tutorial - Enter categorical descriptors 
To create a new categorical descriptor, select edit mode descriptors from menu 
Edit->Descriptors. Now click on the button in the upper left panel (see point 1 in image
below).  

The new descriptor is created with a numeric name. Change it to "Leaf length" (see point 2 in
image above) and set the sequence number to "3" (see points 3 in image above). Now switch
to the main tab and check that the descriptor type is "Categorical" (see points 4 and 5 in
image above). Finally save the descriptor (see point 6 in image above) and the descriptor
name will be updated in the header and the query panel at the left side of the window. 

As for the other descriptors we want to attach a resource link to our new categorical
descriptor, that symbolizes the descriptor's duty (see image below, a link to Wikipedia was
used). 
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Certainly the categorical descriptor shall be attached to the "Descriptor tree for tutorial" that
was created in the last step. In the descriptor tree tab select "Descriptor tree for tutorial" and
click button at the right tool bar (see image below). 
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For categorical descriptors we have to define categorical states, which define the possible
character values. Select the "Categorical states" tab (see point 1 in image below) and enter
the three categorical state names "green", "yellow" and "red" in the table (see points 2 in
image below). Finally save the descriptor (see point 3 in image below). 
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For each categorical state resources may be assigned. Therefore select the categorical state
where you want to enter the resources (see point 1 in image below) and enter a resource
name (see points 2 in image below). In this case we do not assign an URL to a picture but
attach color values. Therefore click the color button in the task bar and select a color
value (see points 3 to 5 in image below). Finally save the descriptor (see point 6 in image
below). 

For our tutorial we need a second each categorical descriptor. Create the categorical
descriptor "Plant growth type" (see points 1 to 4 in image below). This descriptor shall always
be used in the descriptions, therefor mark it as mandatory (see point 5 in image below). Finally
save the descriptor (see point 6 in image below). 
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For descriptor "Plant growth type" enter the categorical states "Tree", "Shrub", "Herb",
"Succulent" and "Other" (see image below). 

Finally append descriptor "Plant growth type" to the descriptor tree for tutorial (see image
below). 
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A more detailled description of all editing options can be found in the Edit descriptors section
of this manual.

 

This tutorial is continued in the sections listed below. 

 section Enter description data
 section Searching the database 
 section Generate an HTML document 
 section Sort the descriptors
 section Assign modifiers
 section Enter descriptor dependencies
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Tutorial - Enter description data 
Now that we have entered several descriptors and categorical states we have defined a
"terminology" to enter descriptive data. To create a new description, select edit mode
descriptions from menu Edit->Descriptions. Now click on the button in the upper left panel
(see point 1 in image below). If you are asked for the project, select "Tutorial". 

The new description is created with a numeric name. Change it to "Example plant" (see point 2
 in image above) and check that project "Tutorial" is assigned to the new description (see
points 3 in image above). Finally save the description (see point 4 in image above) and the
description name will be updated in the header and the query panel at the left side of the
window. 

 

Enter resources for the description 

As described for the descriptors, for each description resources may be assigned. Therefore
click on the "Resource links" tab, which looks exactly the same as described in chapter "Enter
a text descriptor" (see image below, a link to Wikipedia was used). 
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Enter descriptive data 

Now let's start entering the descriptive data. Open the "Descriptor view" tab (see point 1 in
image below). In the left part of the window there is a list of the desriptors. Select descriptor
"Plant growth type" (see point 2 in image below) and on the right side the associated
categorical states are diplayed. Click on the square in columne "x" besides the state "Tree" to
set the check mark (see point 3 in image below). Finally save the description (see point 4 in
image above). 
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Next select the descriptor "Literature" tab (see point 1 in image below). In principle you could
enter a text in the right area "Descriptive text", but for this example two other things shall be
demonstrated. In the first column of the descriptor list the sequence number ("Nr.") is
displayed. A small square behind the number indicates that resources have been attached to
the descriptor (see point 2 - upper arrow - in image below). You can view the attached
resources by a double-click on the sequence number (see point 2 - right arrow - in image
below). In some cases you do not have data available for a certain descriptor but you want to
express that data should be entered. Therefore you can sen one or more "Status data" values
in the right lower part of the window  (see point 3 in image below). Finally save the descriptor
(see point 4 in image below). 
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For each categorical state resources may be assigned. Therefore select the categorical state
where you want to enter the resources (see point 1 in image below) and enter a resource
name (see points 2 in image below). In this case we do not assign an URL to a picture but
attach color values. Therefore click the button in the "..." column and select a color value
(see points 3 and 4 in image below). Finally save the descriptor (see point 5 in image below). 
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The last descriptor not yet used is "Leaf color". Select it from the descriptor list an chek the
categorical state "gree" (see points 1 and 2 in image below). The square in column "Nr." of the
"Categorical states" indicates that resources are attached. Double-click it to view the
resources (see point 3 in image below). Since we attached three different colors for that
categorical state, you may scroll through the different resources by using the "right" and "left"
arrow key on the keyboard (see point 4 in image below). Finally save the descriptor (see
point 5 in image below). 
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An alternate description data view 

If you have defined many descriptors and one specific description references only a small
amount of the descriptors, the "Descriptor view" might be quite confusing. In this case an
alternate representation, the "Continuous view" might be helpful (see image below). Here only
the descriptors that have been referenced in the description data are shown and the values
(categorical states, statistical measures or plain text data) are attached at the descriptors.
Additionally some extra information is color coded, e.g. "Plant type" is displayed in light red
text because it is a mandatory descriptor. For details check the Edit descriptions section of
this manual. 
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Enter description scope 

As last step in this section the insert of "Description scopes" shall be demonstrated. In our
example we want to enter a taxon name and link it to a taxon name service in the internet. 
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First select the "Main attributes" tab and click button if visible (see points 1 and 2 in image
above). When you now select the scope type "Taxon name" (see point 3 in image above) you
could enter a taxon name, e.g. "Ulmus campestris", in the text box that appears right from the
scope type. But we want to create a link to the internet service "Catalogue Of Life", therefore
press button . Now a separate window opens (see image below). Select "CatalogueOfLife"
as database (see point 1 in image below). Enter the search string "ulmus camp" in the query
field and start a search (see points 2 and 3 in image below). When you select a search reult
(see point 4 in image below), you can watch the stored data in the lower part of the window.
Finally click "OK" to store the link (see point 5 in image below).   
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For scope type "Taxon name" links to three different internet services may be set. If you use
the DiversityWorkbench module DiversityTaxonNames, you can build an own taxon database
and link entries to descriptions. Other scoe types that allow linking to DiversityWorkbench
modules are "Geographic area" (DiversityGazzeteers), "Reference" (DiversityReferences),
"Specimen" (DiversityCollection) and "Observation" (DiversityCollection also). Additionally there
are the scope types "Sex", "Stage", "Part" and "Other scope", which have certain values
defined in the Edit projects section. Remember that in step Create a new project we inserted
the sex values "Male" and "Female" and assigned them for the tutorial project. Try to insert
the scope value "Female" for the example description! 

A more detailled description of all editing options can be found in the Edit descriptions section
of this manual.

 

This tutorial is continued in the sections listed below. 

 section Searching the database 
 section Generate an HTML document 
 section Sort the descriptors
 section Assign modifiers
 section Enter descriptor dependencies
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Tutorial - Searching the database 
To search for data in the database use the query sector in the left part of the window.
Depending on the actually chosen edit mode - Descriptions, Descriptors or Projects - the
query searches for descriptions, descriptors or (local) drojects. The query conditions are
changed depending on the edit mode, too (see images below). 
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To select the query conditions click on the button in the top panel. A window will open as
shown below.
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With the Maximum number of results you may limit the package size which should be
retrieved from the server. For a slow connection to the database server choose a low value
(e.g. 100 as set by default). 

The Limit for drop-down lists restricts the maximum number of drop-down lists which should
be created. For a slow connection to the database server choose a low value. The default is
set to 0 which means no drop-down lists will be created.

Click on the Check none button to clear the previous selection or click Check all to select all
conditions. Alternatively you may display or hide each single query condition by checking or
unchecking the entry in the list. 

After all query conditions are set, click on the button to start the query. In the result list
you should find the description, descriptors or project created in this tutorial. To save your
current query click on the button on the right of the button. A window will open as shown
below. For more details see the section Save query.

When you enter new descripors to the databas it may happen that you forgot to assign it to
descriptor tree. That means, those desriptor cannot be used for entering description data.
Another action that may generate such orphaned descriptors is to delete a project. With that
action implicitely the associated descriptions and descriptor trees will be removed from the
database, but the descriptors will not be deleted, because they might be assigned to a
different descriptor tree (and project).

To find and delete orphaned descriptors, set mode "Edit descriptors" (see point 1 in image
below). Then set query condition "Descriptor tree - Assignment" to "missing" (see point 2 in
image below) and start the search (see point 3 in image below). If you want to deleted the
found descriptors, you can select them in the resulg list (multiple selection is possible) and
click button to delete them.  
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This tutorial is continued in the sections listed below. 

 section Generate an HTML document 
 section Sort the descriptors
 section Assign modifiers
 section Enter descriptor dependencies
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Tutorial - Generate an HTML document 
Now that we have entered our first description data and learned how to find them in the
database, we want to share that data. Search for the description of the example plant as
described in the previous tutorial step (see image below). 

       

From the menu choose Data ->  Generate document ... and a window will open as shown
below. Select the "Example plant" (see point 1 in image below). Then set the options Include
resources to show the images we have assigned and Include descriptors to generate the
descriptor definitions in the same document (see point 2 in image below). Finally click on
button Create HTML documentation and the data will be shown in the HTML window (see
point 3 in image below). If you scroll down or click on a descriptor name in the description
data you will find the descriptor data. In the working directory of Diversity Descriptions a
HTML file has been generated that might be used to publish your data.  
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This tutorial is continued in the sections listed below. 

 section Sort the descriptors
 section Assign modifiers
 section Enter descriptor dependencies
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Tutorial - Sort the descriptors 
In the tutorial steps when we created a new descriptor, we usually set the field "Nr."
(sequence number), which determines the sequence the descriptors are displayed in several
lists, e.g. when you enter description data. If you like to change that display sequence, it is
quite uncomfortable, to go through all descriptors and change the sequence numbers
manually, but there is a much more comfortable way. Select edit mode projects from menu 
Edit->Projects or from the bottom control (see point 1 in image below). Now click on the 
button to find the project "Tutorial" (see points 2 and 3 in image below). Open the "Descriptor
tree" tab and expand the trees (see points 4 and 5 in image below).  

The "Descriptor tree" tab in the "Edit projects" mode looks almost like that one in the "Edit
descriptors" mode. But there are some important differences. If you are in the "Edit descriptor"
mode, only the actually selected descriptor will be displayed in the tree. In the "Edit projects"
mode all descriptors are diplayed! Therefore the descriptors may now be shifted up and down
to change the order (see points 1 and 2 in image below).  
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Now select the "Descriptor tree for tutorial" and click button (see image below left). With
this action you indicate that this descriptor tree should be complete, i.e. it contains all
descriptors for the project. Now the additional button is displayed that allows to take over
of the descriptor tree order to the descriptor's sequence numbers (see image below right). 
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When you click on button a window opens that displays the changed sequence numbers of
the descriptors (see imabe above). After confirming the changes with "OK" the new order will
be effective in the descriptor list of the "Edit descriptions" (see image below). 

 

This tutorial is continued in the sections listed below. 

 section Assign modifiers
 section Enter descriptor dependencies
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Tutorial - Assign modifiers  
Modifiers may be used in the description data for an additional characterization of categorical
or quantitative descriptor data. There are five different modifier categories: Certainty,
Seasonal, Diurnal, Misinterpretation and Other. An additional modifier class, Frequency is
only applicable for categorical descriptors. Although you are allowed to define own modifier
values, there is a large number of commonly used predefined modifier and frequency values,
which should be preferred. We now want to insert those predefined values into the
database.  

Select edit mode projects from menu Edit->Projects and open the "Modifier/Frequency" tab
(see point 1 in image above). The modifier and frequency tables should both be empty. A click
on button in the modifier section (see point 2 in image above) opens a window with the
predefined values (see impage below left). Click on button selects all values from the list.
Click "OK" and all modifier values are now inserted in the modifier table. Proceed in the same
way with the frequency values (see point 3 in image above and image below right). The
values are now available for all projects in the database.  
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To use certain modifiers in the descriptive data, the allowed values must be assigned to
certain descriptors. This is done int the descriptor tree in almost the same way as the
assignment of statistical measures to quantitative descriptors. Select the "Descriptor tree" tab
(see point 1 in image below) and click button to dispay the recommended values. Then
select descriptor "Leaf color" and select some modifier and frequency values (see point 3 in
image below). Finally save all changes (see point 4 in image below).  
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Now let's try out the modifiers in our example description. Select edit mode descriptions and
search for the example plant (see points 1 and 2 in image below). Open the "Descriptor view"
tab and select descriptor "Leaf color" (see points 3 and 4 in image below). In the "Categorial
states" section you can now find two additional columns "Modifier" and "Frequence" where you
may select from the values you assigned in the previeous step (see point 5 in image
below). Finally save all changes (see point 6 in image below). 
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This tutorial is continued in the section listed below. ow. 

 section Enter descriptor dependencies
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Tutorial - Enter descriptor dependencies  
In our final tutorial step we take a short look on the descriptor applicability rules. In out
example we have two descriptors dealing with leaf properties, "Leaf color" and "Leaf length". If
you have chosen the categorical state "Cactus" for the descriptor "Plant growth type", it
usually does not make sense specifying leaf properties. You can enter such kind of descriptor
dependencies in a formal way.  

Select edit mode projects from menu Edit->Projects , search for project "Tutorial" and open
the "Descriptor applicabilities" tab (see points 1 to 3 in image above). Select the controlling
descriptor "Plant type" (see point 4 in image above) and in the section "Controlling states" a
list of the descriptor's categorical states is displayed. Select the controlling state "Succulent"
(see point 5 in image above) and then click on button to enter the first controlled
descriptor (see point 6 in image above). This opens a selection window where you select
descriptor "Leaf color"  (see point 7 in image above). Repeat the last step to insert descriptor
"Leaf length" as second controlled descriptor.  

After that check that for the two dependent descriptors the applicability rule "inapplicable" is
set (see point 1 in image below). Finally save all changes (see point 2 in image below).  
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To try out the applicability rules,  select edit mode descriptions and search for the example
plant (see points 1 and 2 in image below). Open the "Descriptor view" tab, expand the tree
and select descriptor "Plant growth type" (see points 3 to 5 in image below). Click on button

to show the "Categorial states". Deselect state "Tree" and select state "Succulent" instead
(see point 6 in image below). In the "Summary data" section the text color of the descriptors
"Leaf color" and "Leaf length" changes to grey to indicate that the descriptor is not
applicable. Since for that descriptors values have been specified, the backround color is
changed to yellow to indicate that the applicability rules are broken (see point 7 in image
below). 
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In the "Descriptor view" tab the "descriptor inapplicable" property is indicated by an "x" in
column "!" of the descriptor list (see image below). 
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Queries - overview
With the user defined queries, you can define any query condition - this is the default query
mode. 

Depending on the active edit mode you get one of three different query option panels as
shown in the pictures below.

The extended query provides a detailled seach for descriptions with specific descriptor data.
It is accessible from the menu Query -> Extended query ... if the edit mode Edit
descriptions is selected.  
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Result list
The result list displays the descriptions, descriptors or projects found in a query.
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For example the descriptors may be displayed with their name or their sequence number as
shown in the images above. 

You can restrict the maximal number of results together with the query options (click on the

button), for example if you have a slow connection to the database. As a default the
maximal number is set to 100. If the number of datasets according to your query is higher
than the maximal value set in the query options this will be indicated in the header of the list. 

To search for items, enter the restrictions in the fields for the search conditions and click on

the button. The items found in the database will be shown in the result list. To add items
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that match differing search conditions click on the button. If the list of items is longer than

your maximal number of returned items you can browse the next items with the button. If

you want to remove entries from the selected list, choose them in the list and click on the 
button. If you want to keep the selected entries in the list and remove the rest, click on the 

button. This will not delete the data from the database, but remove them from your query
result.
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Query
Depending on the activated edit mode you get one of the three query options pannel below.
The options for a fast search are displayed in the main window beneath the list of the items.

You can change this arrangement using the / button to place the query options on the
left side of the item list.

To search for an item enter the restrictions in the fields for the search conditions and click on

the button. The entities found in the database will be shown in the result list. To add

items with differing search conditions click on the button. To clear all entries in the query

fields use the button. If the list of items is longer than your maximal number of returned

items you can browse the next items with the button. To move back to the previous block

of items click on the button. 
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If you want to remove entries from the selected list, choose them and click on the button.

If you want to keep the selected entries in the list and remove the rest, click on the 
button. This will not delete the data from the database, but remove them from your query

result. With the resp. buttons you can change the order of the results between
ascending and descending. 

To hide the area containing the search fields click on the  button. If the search area is

hidden and you want to start a new search, just click on the  button. 

With the button you may control auto-remember of the last submitted query parameter. If
you re-start the application and connect to the same database, the last used query will

automatically be submitted. If you prefer to switch off auto-remember, click the button 

and it will change to . In the main menu Query -> Preferred project ... you may select a
project that will be used as a pre-selection for Description and Descriptor query, if no other
query parameter have been restored.  

Within the query options you have several possibilities to specify your search restriction. Use
the drop down button to change between the operator. The available operators are shown in
the table below. 

Operator Meaning Example 
Text 

∼ search for an entry like ... Pinus s[iy]lvestris % (you can use 
wildcards) 

= search for an entry exactly equal to ... Pinus silvestris L.

≠ search for an entry not like ... Pinus s[iy]lvestris % (you can use 
wildcards) 

∅ search for an entry where a value is missing
... 

• search for an entry where a value is present
... 

- search for an entry between ... and ... 2000 - 2005 

| search within a list of entries, separated by
"|" 2000 | 2003 | 2005 

Numeric 
= search for an entry exactly equal to ... 2006 
< search for an entry lower than ... 2006 
> search for an entry bigger than ... 2006 
- search for an entry between ... and ... 2000 - 2005 

| search within a list of entries, separated by
"|" 2000 | 2003 | 2005 
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∅ search for an entry where a value is missing
... 

• search for an entry where a value is present
... 

Date 
= search for an entry exactly equal to ... 20.3.2006 
< search for an entry lower than ... 20.3.2006 
> search for an entry bigger than ... 20.3.2006 

∅ search for an entry where the date is missing
... 

• search for an entry where the date is present
and complete ... 

Hierachy 
= search for an entry exactly equal to ... M-Fungi 
≠ search for an entry that is not equal to ... M-Fungi 

∅ search for missing entry ... 

• search for present entry ... 
Δ search including childs in a hierarchy ... M-Fungi 
XML 

/ Search for entries containing a given XML
node settings 

¬ Search for entries not containing a given
XML node settings 

∅ search for missing entry ... 

• search for present entry ... 

For yes/no fields you will get an checkbox with 3 options: = yes, = no, = undefined 
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Save query
If you want to save a current query, click on the button. A window as shown below will
open where you can specify the title and description of you query.

After you entered title and description of the query, click OK to specify the query group. A
window as shown below will open.
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Choose a group from the tree or create a new one an click OK. The new query will be included
in the selected group. 
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Finally you can edit the titles and descriptions of the groups an queries. Click the button to
store the changes. To delete items from the tree, select it and click on the button. Click OK
to save the new query and close the window.

Load query
If you want to load a query that has been stored previously, click on the button. A window
as shown below will open. 
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Choose a query from the tree and click OK to close the form and filter the datasets according
to the selected query.
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Query options
The maximal number of items shown in a query result can be set in the window for the query
options. The default value is set to 100. If you have a fast connection to your database or
need to see more or less results, you may change this value to any number you like.
To change the displayed search fields click on the  button. This opens a form where you
can select and deselect the fields shown for searching specimens. You might also change the
maximum number of items that will be shown in the result list. 

The limit for the creation of drop down lists is by default set to 0, that means no dropdown
lists will be created. If you set the limit to e.g. 1000 and connect to a database, the
programm will create drop down list based on the entries in the database to ease the entry in
the query. For slow connections you may set this to lower value to speed up the start of the
program. If you set the value to 0 no drop down lists will be created.

The minimal numbers of characters for a selection from the drop down list is by default set to
3.

After having edited the query options click OK to store your selection. The new selection will
become active for the next query. To ease the selection and deselection of query options you
may use the buttons Check all, Check none, Expand and Collapse. 

To search for a field within the database, use the search function that will check the names
and descriptions of the fields and mark them as shown below. 
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After having edited the query options click OK to store you selection. The new selection will
become active for the next query. 
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Wildcards in SQL
There are 4 different possibilities for wildcards in SQL:

%     any string consisting of no, one or many characters, e.g. Pinus % will find anything like
Pinus, Pinus sylvestris, Pinus strobus etc. 

*     any string consisting of no, one or many characters, e.g. Pinus * will find anything like
Pinus, Pinus sylvestris, Pinus strobus etc. 

_      a single character, e.g. Pinus s_lvestris will find Pinus sylvestris and Pinus silvestris etc. 

[]      any character out of a given range like [abcde] or [a-e], e.g. Pinus s[iy]lvestris will find
Pinus sylvestris and Pinus silvestris. 

[̂ ]   any character not in a given range like [̂ abcde] or [̂ a-e], e.g. Pinus s[̂ i]lvestris will
find Pinus sylvestris but not Pinus silvestris. 
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Extended query - introduction
With this form you can search description data from the database that match specific
descriptor values. Choose Query -> Extended query ... from the menu to open the
extended query window. With the button  you can set the timeout for critical database
queries, with button you can set the timeout for the web access to resource data.
Feedbacks can be sent with the button .

 

First the Project must be selected from the combo box in the upper window area. The
Matches: field shows the number of available description datasets. If any matches are
available, the Show matches button is available and by clicking it the datasets are listed
in the Result list section (see image below). 
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If you want to view a single entry of the result list, you may select it by a single click on the
entry and press the View in separate window button. You may check all entries by
clicking the all button, uncheck all entries by clicking the none button or toggle the
check marks by clicking the swap button. You may export the checked results to a
tab-separated text file by clicking the button and view the exported list by clicking .
When you close the window by a click on the OK button, the checked entries are passed to
the main window of Diversity Descriptions (see below). If you do not want to take over the
query results to the main window, close the extended query by pressing the Cancel button. 

 

Continue with:

 Extended query parameter
 Save and load extended query
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Extended query parameter
Press button Add in the Query parameter tool strip to insert a new query parameter. A
control representing a single descriptor filter will be added at the end of the query parameter
list. Now you have to select the descriptor that shall be included in the search filter. This can
be done by selecting the descriptor's sequence number with combo box No.:, from an
alphabetical descriptor list with combo box Descriptor: or by selecting from the descriptor
tree with button (see picture below).  

 

After selecting the descriptor the query control shows query parameters depending on the
descriptor type (see below). The currently marked parameter control is shown with light blue
background. You can delete the current query control by clicking on button Remove or all
query controls by clicking on button in the Query parameter tool strip. 
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In the parameter control the descriptor type is indicated by symbols in the beginning of the
first line (  categorical, quantitive, text or sequence). If additional information for
the descriptor are available in the database, you can show them as bubble help by moving the
mouse cursor over the symbol. If resource data are available for a descriptor, the symbol is
displayed with coloured background and you can view them by double-clicking the it (see
image below). 
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Each parameter control has two main sections: 

 At the left you find the section for the descriptor parameter, depending on its type (
Categorical states, Statistical measures, Descriptor text or Molecular sequence
). If this section is checked and no other data have been entered, the query filters for
all descriptions that include any value for that descriptor, e.g. any descriptor text or
any categorical state. By entering additional query data, the filter becomes more
restrictive.  

 At the right you find the section for the descriptor Data status. If this section is
checked and no status value has been selected, the query filters for all descriptions
that include any status data for that descriptor. By checking dedicated data status
values, the filter becomes more restrictive.  

If both sections have been checked, matching descriptors must fulfill both conditions, i.e. the
value must be present and the data status must be set. If you remove the check mark in the
first line of the query parameter, the whole condition will be ignored. Below this check box you
find by default the symbol , which means that "logical AND". If you specify several query
parameter controls, which are all adjusted to , matching description must fulfill all entered
query conditions simultaneously. 

You may click on the symbol to change it to (see image below), which means "logical
OR". In this case the result list will include all descriptions that fulfill the first descriptor
condition and additionally all descriptions, which fulfill the second condition. I.e. each "AND"
condition will reduce the list of matching descriptions and each "OR" condition will add its
matching descriptions to the result list.   
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Notes

In the descriptive data you may enter free text notes to all text and sequence data.
Furthermore individual notes may be entered for every categorical state and statistical
measure. You may include additional query contitions for each of those notes, therefore the
symbol is included at the appropriate places. To enter a query condition, click the button
and a window as shown below will be opened. 

You may enter a Search text that shall be part of the notes text. Capitalization is not taken
into account. For option Contains the descriptor text must contain the search string (see
image below). The options Starts with and Ends with only check the descriptor text begin
rsp. end for a match. Finally option Exact match requires identical texts. Check the option
invert to invert the search criteria. When you click OK the additional query condition will be
active and the icon changes to . If you want to remove the query condition, open the
notes form, uncheck the Enable notes filter option and click OK. 
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Continue with:

 Extended query parameter - Categorical states
 Extended query parameter - Statistical measures
 Extended query parameter - Descriptor text
 Extended query parameter - Molecular sequence
 Save and load extended query
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Extended query parameter - Categorical states
In this query control the categorical states are listed. If pictures of colours are assigned to
the categorical states, they can be viewed by clicking on the state name (see picture below).
You may switch off automatic loading of the resource view by clicking the button ("no
web"), which will be indicated by a yellow symbol background. If this "no web" option is
activated, only local resources, e.g. colours, will be shown. If during loading of remote
resources an error occurs, e.g. due to a timeout, the "no web" option will automatically be
activated.  

Categorical states that are not checked are not relevant for the filter. If you want to search
for a categorical state that is NOT present, check the option invert behind the categorical
state name (see picture below).  
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By default all categorical states of a descriptor that are selected must be present in the
matching descriptions. You may change this logical AND to a logical OR by clicking on the
symbol behind the Categorical state check box, which will change to symbol (see
picture below). Now all descriptions will match, which include one of the selected states.  
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Continue with:

 Extended query parameter - Statistical measures
 Extended query parameter - Descriptor text
 Extended query parameter - Molecular sequence
 Save and load extended query
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Extended query parameter - Statistical
measures
In this query control the recommended statistical measures are listed. You may enter a single
value for an exact match in the from: field or a value range in from: and to: (see picture
below). If you want to exclude the specified value range from the query, check the invert
option. If you do not enter a value, the statistical measure is checked for presence. 

Statistical measures that are not checked are not relevant for the filter. If you want to
search for a statistical measure that is NOT present, check the option invert and do not
enter any values (see picture below).  
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By default all statistical measure conditions of a descriptor that are selected must be fulfilled
in the matching descriptions. You may change this logical AND to a logical OR by clicking on
the symbol behind the Statistical measure check box, which will change to symbol 
(see picture below). Now all descriptions will match, which include one of the selected
measure conditions.  
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Continue with:

 Extended query parameter - Descriptor text
 Extended query parameter - Molecular sequence
 Save and load extended query
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Extended query parameter - Descriptor text
In this query control you may enter a Search text that shall be part of the text descriptor
data. Capitalization is not taken into account. For option Contains the descriptor text must
contain the search string (see image below). The options Starts with and Ends with only
check the descriptor text begin rsp. end for a match. Finally option Exact match requires
identical texts. 

Check the option invert to invert the search criteria (see picture below).  
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Continue with:

 Extended query parameter - Molecular sequence
 Save and load extended query
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Extended query parameter - Molecular
sequence
In this query control you may enter a Sequence that shall be part of the molecular sequence
data. Capitalization is not taken into account. For option Contains the sequence text must
contain the search string (see image below). The options Starts with and Ends with only
check the descriptor text begin rsp. end for a match. Finally option Exact match requires
identical texts. 

Check the option invert to invert the search criteria (see picture below).  
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Continue with:

 Save and load extended query
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Save and load extended query
The complete query schema may be saved into an XML file using the button , which opens
a dialog window to enter the file name and location. By default the schema file name is
generated as: 

     <working directory>\ExtendedQuery\DescriptionQuery_<Database
name>_<Project>.xml  

The XML schema file includes information concerning the database, the project and the query
parameter. By pressing the button in the Query parameter section, a query schema file
can be opened. If the schema does not meet the active database you will be informed by a
message box. In the query file all relevant parameter are identified by the database internal
numeric IDs. If no matching values are found, it is tried to get them by their names. Since the
names might be ambigious, the corresponding element are displayed with a yellow background
colour (see image below). 

 

If the parameter could not even be assigned by their names, this is indicated by a red
background color (see picture below).   
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Editing the data
The database of DiversityDescriptions consists of three major areas:  

 The descriptive data (descriptions) reference elements of the descriptive terminology
and add specific data, e.g. numeric values.

 The descriptive terminology, consisting of descriptors, categorical states, statistical
measures and modifiers. 

 The project data build the administrative frame for terminology and descriptions. Each
description belongs to exactly one project. By additional entities (descriptor tress) it is
possible to restrict the descriptors, statistical measures and modifier that shall be used
in a certain project.  

In almost all forms an Extended text editor can be opened for single text fields that provides
additional editing features.  

Corresponding with that three major sections of the data model, the DiversityDewscriptions
application provide three edit modes. The edit mode is diplayed at the bottom of the main
window (see picture below). After the first start the edit mode is preselected to "Edit
descriptions". You can switch the edit mode using the menu Edit-> Descriptions, Edit->
Descriptors or Edit-> Projects. Alternatively you may switch the edit mode by click the
mode button in the upper left corner of the header area (item 3 in picture below) or on the
tiny triangle besides the edit mode display in the status line at the bottom (see item 4 in
picture below). 

The main window of the DiversityDescriptions client contains two main areas. At the left you
find the query and the results of this query. In the right part the data of the dataset selected
in the result list is shown. 
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Basic operations

In each edit mode there are some common functions for storing and reloading data, to create
a new dataset or delete or copy the actual dataset. On top of the query results (item 1 in
image above) there is button to store the actual dataset, button to delete the actual
dataset and button to create a new dataset. By pressing button  the actual dataset is
reloaded, i.e. changes that have been made will be dropped. Finally, button copies the data
of the actual dataset to a new one. 

Some of those buttons can be found in the tool bar at the right side of the edit window (item
2), too.

Additionally to explicit saving by pressing the button, an automatic saving of the dataset is
done, if an entry in the query result list is selected or a new query is performed. If a dataset
has been modified without saving, a message window will appear and ask if changes shall be
saved for several actions, e.g. change of edit mode, connetion to a database or if the
application is closed. 

 

Translations

For many database tables the text columns may be translated into different languages. To
enter, modify or view the translated texts, use the translations editor. For an overview on
multilingualism in Diversity Descriptions see chapter translations.  

 

Description grid view

An alternate form for editing or viewing the data of several descriptions in a grid is provided by
the description grid view. It provides a simplified user interface for access to a subset of the
description data.  

 

Sample data grid view

An alternate form for editing or viewing the sample data of several descriptions in a grid is
provided by the sample data grid view.  

 

Table editors

For a selected set of database tables a direct data editing in a grid is provided by the table
editors. 
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Editing the description
After starting a database query and selecting an entry in the result list the dataset is diplayed
in the edit window. In the header area the dataset name, the default project language and
the URI of the current dataset are show (see picture below). Below the header area the
description name may be edited in a text box. Changes of the description data, e.g. the name,
will be visible in the header after saving the dataset. To check dataset changes, click on the 

button to open the history. 

The main description data may be accessed in the first Main attributes tab, which is
described below. Click on one of the other tabs in the picture below to go directly to the
appropriate manual chapter.

 

Main attributes tab

The main attributes tab provides in the upper area a field to enter additional description
details and a wording for natural language support. The optional filed AID may keep an
alpha-numeric alternate ID of the dataset. If used, it should be unambigious within the
project, but this is not checked by the program. Click on to get an overview of the used
keys. 

 

Scopes

The next section Description scopes allows specification of description scopes. This sections
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consists of the scope table with scope type and value and a edit section to modify a seleted
scope entry or to enter e new scope. The scope types Geographic ares, Reference,
Specimen, Observation and Taxon name allow input of a free-form text or reference to the
corresponding DiversityWorkbench module or a web service. The connection to to a module or
web service is done using the button . After selecting the entry in the referenced database
the text will be taken over and the backround colour of the scope value field changes to 
yellow. A further editing of the text will not be possible (see below). 

  

Additionally the edit section now shows the buttons to view the database link and  to
remove the database link. In the latter case editing of the scope value will be possible again.

If a scope entry has been selected in the scope table, it can be modified in the edit section.
If you want to enter a new scope value instead, press the button at the end of the edit
line. The scope entry in the scope table will be deselected and a selection box for the scope
type appears in the edit section (see below). 

You may insert mutiple scope values with links to a DiversityWorkbench module or a
webservice. Therfore enter a new scope value with scope type Geographic ares, Reference
, Specimen, Observation and Taxon name (or select one, which is not yet linked). Besides
the scope type dropdown box the button is shown, which allows insert of multiple scopes
(see image below). 

You may insert mutiple scope values with links to a DiversityWorkbench module or a
webservice. Therfore enter a new scope value with scope type Geographic ares, Reference
, Specimen, Observation and Taxon name (or select one, which is not yet linked). Besides
the scope type dropdown box the button is shown, which allows insert of multiple scopes
(see image below). 
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In the remote query panel you find the section Unit list, where you may add the currently
selected query result by clicking the button. When you select an entry in the Unit list, you
may remove it by clicking or view the data in a separate window by clicking . When you
have collected all query results click the OK button and the scopes are inserted for the
description (see below). 

 

Page 105



Project scopes

Besides the already mentioned scope types that allow input of a free text or reference to a
database entry, the scope types Sex, Stage, Part and Other scope provide pre-defined
scope values. The values can be administrated as described in the "Editing the Project"
chapter. For each project a different set of values can be selected as "recommended" values.
If for the current description project scope values are defined/assigned, they are shown in the
right part of the description scopes as Project scopes (see below). 

Selecting or deleting of a scope entry can be easily done by selecting clickin on the check box
before the scope value. You may select rsp. deselect all scope values of a certain scope type
(Sex, State, Part or Other scope) by clicking the check box of the category. If for a scope
value a detailled description text has been stored, you may view it as bubble help by moving
the mous cursor over the values. 

If for a description a scope value is selected, that is not assigned to its project, the value ist
show with yellow background (see below). Such a situation can occur, if the scope value has
been removed for the project or if a description has been moved to a different project.  

 

Project

The last section Project of the main attributes tab allows selection of the (local) project the
description is assigned to. This adjustment has influence of the available values of scope
types Sex, Stage and Other scope, the available descriptors and recommended
modifier/frequency values and statistical measures of the description. The access rights for a
certain user to the projects are contolled by the workbench project associated with the local
project (see chapter "Editing the Project") and the login settings (see chapter "Login
administration").
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If access to a certain project is restricted to "read only", it is displayed with grey colour and
symbol in the Project section (see picture above left). A "read only" project cannot be
selected for the actual description. If the selected description has already been assigned to a
"read only" project by another user with appropriate rights, this is indicated at the right
bottom corner of the application window (see above below right). 

 

Continue with:

 Edit descriptions - Descriptor view tab
 Edit descriptions - Molecular sequence symbols
 Edit descriptions - Import sequence data
 Edit descriptions - Export sequence data
 Edit descriptions - Continuous view tab
 Edit descriptions - Resource links tab
 Edit descriptions - Sample data tab
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Editing the description - Descriptor view tab

The left part of the descriptor view tab shows all descriptors available for the description's
project. The entries in column "!" indicate some additional information about the descriptor:

 Descriptor is referenced in the summary data (●)
 Descriptor is referenced in the status data (○)
 Descriptor is mandatory, values must be specified (!)
 Descriptor is inapplicable because of other specified descriptors/categorical states (x)
 Descriptor is exclusive, only one categorical states shall be selected (e) 

If resources are linked to a descriptor, the entry is marked by a square (□) behind its
sequency number and a tool tip appears when the mouse cursor is moved over the "No."
column (see below). By double-clicking the sequence number a "Media view" window can be
opened to view the resources.

 

If for the project descriptor trees are defined, the Descriptor tree: drop-down list and
Restricted check box are shown below the descriptor list (see image below left). If a
descriptor tree is selected, the names of the descriptor tree node hierarchy is included in the
descriptor names (see image below right). This feature is useful, if several descriptors with
ambigious names exist the can now be distinguished. E.g. two descriptors "colour", one at
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descriptor tree node "Leaf", the other at descriptor tree node "Blossom" will become "Leaf
colour" and "Blossom colour". If the descriptor name already includes the hierarchy, the
duplicate parts will be filtered. In the mentioned example the descriptor names "Leaf colour"
and "Blossom colour" will not be changed, if the descriptor tree is selected.

If additionally the Restricted option is set, only the descriptors included in the selected
descriptor tree are displayed (see image below right, missing descriptor number 14). So you
have the option to create several descriptor trees that include only special aspects of the
description's property (e.g. morphology, molecular biology and so on) to get a clearly arranged
descriptor list.  
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Editing summary data

The right part of the descriptor view tab shows at the bottom the Status data values of the
selected descriptor. It is possible to select several values for each descriptor. In the "Notes"
column additional information concerning the selected data status may be entered. By a
double click on the "Notes" entry a separate edit window can be opened. 

Depending on the descriptor type you can find at the top either Categorical states (see
large picture above), Statistical measures, Descriptive text or Molecular sequence (see
pictures below). In the "Notes" columns additional information concerning the specific
categorical state rsp. statistical measure may be entered. By a double click on the "Notes"
entry a separate edit window can be opened. 
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To enter a statistical measure value click in the "Value" field and enter the value, the check
mark in field "x" will be set automatically. If recommended modifier values are defined (see 
"Editing the Descriptor" and "Editing the Project"), a value may be selected from the drop
down list "Modifier". If no modifier values are available, the appropriate table column may be
hidden. In the "Notes" field an additional text may be added. By double-clicking the "Notes"
field the Extended text editor can be opened. 

The descriptive text may be edited diretly in the window, which shows the pure text without
any formatting. In the notes field an additional text may be entered. By double-clicking the
text fields the Extended text editor can be opened.  

The molecular sequence window displays in the status line below the edit area the
sequence type ("Nucleotide" or "Protein"), the symbol length ("Len:") in case of proteine
sequences, the gap symbol ("Gap:") if defined, the long text of the actual element and the
position ("Pos:") (see image below). In case of three-letter proteine symbols the position is
the number of the amino acid symbol, not the character position. By pressing the TAB key the
cursor jumps to the next symbol.  

When characters are entered in the edit area that are recognized as valid symbols, they will
automatically be formatted. One-letter symbols are converted to upper case characters,
three-letter symbols are converted according the "Xxx" schema, e.g. "Ala" for "Alanine". The
sybols for the nucleotide bases "Adenine", "Cytosine", "Guanine", "Thymine" and "Uracil"
are dispayed with different colors. Ambiguity symbols and gap symbols are shown in grey
color. If the ambiguity symbols have not been enabled in the descriptor data, they will be
displayed with yellow background. Symbols that have not been recognized are displayed with
red background.  

The molecular sequence window offers some additional functions available in the sequence
menu. It may be opened by moving the mouse cursor over the control header ("Molecular
sequence", see window below left) or from the context menu (right-click on the sequence edit
area, see windows below right). With menu item Import you may read the seqeunce data
from a file and insert them to the description. With menu item Export you may export the
actual sequence data to a file.  
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By double-clicking the molecular sequence area or from sequence menu Open -> 
Sequence a separate edit window may be opened (see image below). On the top of the
window there is the drop-down menu Insert symbol: where a value may be selected from a
list. After selecting the value press the [ENTER] key or click on to insert the selected
symbol at the cursor position.  

To select a categorical state set a check mark in field "x" with a mouse click. If
recommended modifier or frequency values are defined (see Editing the Descriptor and Editing
the Project), values may be selected from the drop down lists "Modifier" rsp. "Frequency". If
no modifier or frequency values are available, the appropriate table column may be hidden. In
the "Notes" field an additional text may be added. By double-clicking the "Notes" field the 
Extended text editor can be opened.  

If a "Modifier" or "Frequency" value is selected, the multiple specification of a dedicated
categorical state is possible. A tool tip offers to add a row by doouble-click, if mouse cursor is
moved over the "State" field (left picture below, picture in the midddle after double click).
Multiple specifications of one categorical state are only allowed if they have been assigned
different modifier and frequency values. Inputs offending these restrictions will be ignored an a
cell error will indicate the problem (right picture below). 
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If resources are linked to a categorical state a tool tip appears when the mouse cursor is
moved over the ID (left picture below). By double-clicking the ID a "Media view" window can
be opened to view the resources (right picture below).
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If more than one resources have been assigned to one entry, a slider will be visible at the
bottom of the "Media view" window. To switch through the available resources the slider can
be moved using the mouse or the right and left arrow keys (see below).

  

 

Continue with:

 Edit descriptions - Main attributes tab
 Edit descriptions - Molecular sequence symbols
 Edit descriptions - Import sequence data
 Edit descriptions - Export sequence data
 Edit descriptions - Continuous view tab
 Edit descriptions - Resource links tab
 Edit descriptions - Sample data tab
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Editing the description - Molecular sequence
symbols
The editor for sequence data recognizes predefined symbols for nucleotide and protein
sequences according the IUPAC definitions.

 

Nucleic acid symbols
Symbol
 Name 

A Adenine 

C Cytosine 

G Guanine 
T Thymine 

U Uracile 

W Weak (A or T)  

S Strong (G or C) 

M aMino (A or C) 

K Keto (G or T) 

R puRine (G or A) 

Y pYrimidine (C or T)  

B not A (B comes after A)  

D not C (D comes after C) 

H not G (H comes after G) 

V not T (V comes after T and U) 

N No idea (not a gap) 

The symbols with grey background are ambiguity symbols. The difference between "N" and a
gap symbol (usually "-", but any other symbol may be defined in the descriptor) is that a gap
symbol represents an unspecified number of unknown symbols but "N" stands for exatly one
nucleic acid.  

 

Amino acid symbols
Name 1-letter sybmol 3-letter sybmol 

Alanine A Ala 

Arginine R Arg 

Asparagine N Asn 

Aspartic acid S Asp 

Cysteine C Cys 

Glutamic acid E Glu 

Glutamine Q Gln 

Glycine G Gly 

Histidine H His 

Isoleucine I Ile 
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Leucine L  Leu 

Lysine K Lys 

Methionine M Met 

Phenylalanine F Phe 

Proline P Pro 

Serine S Ser 

Threonine T Thr 

Tryptophan W Trp 

Tyrosine Y Tyr 

Valine V Val 

Selenocysteine U Sec 

Pyrrolysine O Pyl 

Asparagine or aspartic acid B Asx 

Glutamine or glutamic acid Z Glx 

Leucine or Isoleucine J Xle 

Unspecified or unknown amino acid X Xaa 

The symbols with grey background are ambiguity symbols. The difference between "X" rsp.
"Xaa" and a gap symbol (e.g. "---", but any other symbol may be defined in the descriptor) is
that a gap symbol represents an unspecified number of unknown symbols but "X" rsp. "Xaa"
stand for exatly one nucleic acid. The amino acids "Selenocysteine" and Pyrrolysine" are
non-standard amino acids that only occur in certain species.  

 

Continue with:

 Edit descriptions - Main attributes tab
 Edit descriptions - Descriptor view tab
 Edit descriptions - Import sequence data
 Edit descriptions - Export sequence data
 Edit descriptions - Continuous view tab
 Edit descriptions - Resource links tab
 Edit descriptions - Sample data tab
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Editing the description - Import sequence data
With this form you can import sequence data from a file into the database. Choose Import
from the sequence menu to open the window for the import. Format specifies the file format,
currently FASTA and FASTQ are supported. Click on the button to select the file with the
data you want to import.  

 

The Contents of the file will be shown in the upper part of the window. For each seqeunce of
the file a separate data row is visible. Select the row you want to import and the selected
sequence will be visible in the Sequence preview section. Since in FASTA always a
one-letter coding is used, the sequence will be converted to the three-letter coding if the
descriptor requires this format (see image above). In the Sequence settings you may specify
if an already existing sequence of the descriptor shall be replaced or if the imported data shall
be inserted before or after the sequence. The Header settings determine the handling of the
FASTA header and comment lines. You have the choice to replace the notes by the header
and command lines, to insert them at the beginning or the end or ignore them. If option 
Ignore comments is checked, only the header line will be inserted into the notes. In the
Notes preview section you can see the resulting notes.

The FASTQ format contains a quality string, which specifies each symbol's reliablility. Unless
you select one of the Ignore options of the Header settings section the quality string is
inserted int the notes. There the title "QUALITY STRING" marks the start of the quality string
to allow a later data export to FASTQ (see image below).  
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Finally click button OK to perform the import of Cancel to abort.

 

Continue with:

 Edit descriptions - Main attributes tab
 Edit descriptions - Descriptor view tab
 Edit descriptions - Molecular sequence symbols
 Edit descriptions - Export sequence data
 Edit descriptions - Continuous view tab
 Edit descriptions - Resource links tab
 Edit descriptions - Sample data tab
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Editing the description - Export sequence data
With this form you can export data from the database to a file. Choose Export from the
sequence menu to open the window for the export. Format specifies the file format,
currently FASTA and FASTQ are supported. 

 

In the Header settings you may specify if a new header shall be generated or if the notes
shall be searched for a FASTA rsp. FASTQ header. In case of FASTA export you may specify
in the Comments settings section if FASTA comment lines from the notes (starting with ";")
shall be inserted after the header, the whole notes shall be inserted as FASTA comments or if
the notes shall be ignored. If Insert description comments is checked, two comment linsed
wit the description and descriptor title will be generated. 

In the Header preview section you may check and edit the resulting header, in the
Sequence preview section the converted sequence in one-letter notation is displayed. 

In case of FASTQ export the Comments settings are irrelevant. If the notes include a
QUALITY STRING sections, it is inserted in the FASTQ output (see image below). If no quality
string can be found or the Find FASTQ quality from notes has been unchecked, the lowest
quaality value "!" is inserted. 
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Click on the button to select the file where the data shall be exported. By default the data
are appended at the end of the selected file, check the Overwrite existing file option to
overwrite it. Finally click the Save file button to write the data.

 

Continue with:

 Edit descriptions - Main attributes tab
 Edit descriptions - Descriptor view tab
 Edit descriptions - Molecular sequence symbols
 Edit descriptions - Import sequence data
 Edit descriptions - Continuous view tab
 Edit descriptions - Resource links tab
 Edit descriptions - Sample data tab
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Editing the description - Continuous view tab

The continuous view tab provides an alternate view on the descriptive data. In the Summary
data only the descriptors are included where data have been entered. At the right side there
is a tool strip. The displayed buttons will change depending on the selected entry. The
descriptor types categorical, quantitive, text and sequence are indicated by
different colours and icons as shown in the example at the bottom. By pressing the button
on the tool strip this example may be hidden. Descriptors that are marked as mandatory are
displayed with light red text, descriptors that are inapplicable are greyed out. Additionally
coloured background indicated possible problems, e.g. if an inapplicability rule has been
ignored or a not allowed descriptor has been used. A tool tip text shows the error or
warning reason when the mouse curser is moved over the element. 

By pressing the button the tree view may be expanded to display the contained categorical
states, quantitative measures or texts. By pressing the button the tree will be collapsed to
descriptor level.

To insert a descriptor press , to delete a descriptor select the entry and press . If only a
single value shall be removed, select the entry and use the button. All these functions can
alternatively be accessed by the context menu by a right-click on the tree node.
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If for a descriptor resources, e.g. pictures, are avaialble, this is indicated by the background
color of the descriptor icon. Categorical states with resources are marked with icon (see
first entries in picture above). The resources may be accessed by a right-click on the tree
node and selecting context menu item View resources (see picture above). 

 

Structured descriptor view

If for the project a structured descriptor tree is defined, i.e. a descriptor tree that contains at
least one descriptor tree node, the Descriptor tree: drop-down list is shown below the
descriptor tree (see image below left). If a descriptor tree is selected, the descriptor tree
node hierarchy will be included in the output and the descriptors will be arranged accordingly.
The names of the descriptor tree nodes and the descriptors will be reduced by parts
contained in the supriour hierarchy nodes (see image below right).   
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If for a descriptor tree node resources are available, this is indicated by the grey background
color of the descriptor tree icon. The resources may be accessed by a right-click on the tree
node and selecting context menu item View resources. Additional descriptor tree node
information, e.g. an optional abbreviation or details text can be viewed as bubble help by
placing the mouse cursor over the item.   

 

Editing summary data

A click on opens an edit window at the right part of the tab. This window provides the
same functions as available in the descriptor view tab. The picture below shows the resource
linked to a categorical state that can be opened by doule-clicking the state ID in the 
Categorical states section. 
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Continue with:

 Edit descriptions - Main attributes tab
 Edit descriptions - Descriptor view tab
 Edit descriptions - Molecular sequence symbols
 Edit descriptions - Import sequence data
 Edit descriptions - Export sequence data
 Edit descriptions - Resource links tab
 Edit descriptions - Sample data tab
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Editing the description - Resource links tab

The resouce links tab allows assigment and inspection of resource links for the description. In
the lower Resources part of the tab there are two tables. Ar the left the "Resource" table
specifies the single resources, at the right the "Resource variant" table contains the
associated URLs to images, video or sound resources. 

To enter a new resource select the empty line at the end of the "Resource" table and click on
the "Resource name" field. After entering the "Resource name" (leave the cell by pressing the 
TAB key) automatically a new value for the sequence number ("No.") is initialized. The
sequence number determines the display order in tables and may be changed manually. You
may order the resource entries by clicking on the column header or by using the arrow buttons
in the left tool strip (  and for up and down, and to shift the selected entry to top or
bottom). After ordering the resources click button to renumber the entries starting with "1"
and make the changes effective. In field "Ranking" you may enter a numeric value in range 0
... 10 expressing the suitability of the resource. In field "Role" you may select one of the
offered values. 

If you want to delete a resource, you have three choices:

1. Select the resource and press the button in the left tool strip. 
2. Select the resource and press the Delete key on the keyboard. 
3. Enter the sequence number column ("No.") and remove the value. After leaving the cell

the entry will be deleted.

In any case you will be asked if you want to delete the data row, if resource links are
present.  
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To view or edit the additional resource data and copyright information press on the button 
besides the resource table. In field License: and a link to the license text in the web may be
entered, in field Rights: you may enter a copyright text. By pressing the button a browser
window can be opened to navigate to the license page in the web. Furthermore you may
enter a detailled text (field Details:), the resource language (field Language:) and set the
Display embedded flag (see picture below). If any additional resource data have been
entered, this will be indicated by a square (□) behind the resource name's sequence number
(see picture above). 

 

To enter a resource link, first select the entry in the "Resource" table, then select the empty
line at the end of the "Resource variant table". By clicking on the "URL" field a web address
may be entered. By double-clicking the "URL" field a browser window opens to navigate to the
resource. For each resource several URLs to resource variants with different quality levels,
e.g. different resolution, may be inserted. For each entry in the URL table a different value of
"Variant" must be selected. 

As an alternative to a resource URL a colour may be spcified in the format "color://#rrggbb"
where "rrggbb" specifies a hexadecimal colour code. The colour can simply be seleced by
clicking the button besides the resource variant table.

To remove a resource variant, select the entry and press the button in the right tool strip
or the Delete key on the keyboard. Alternatively you may delete the "URL" entry in the
resource variant table. 

The upper part of the resource links tab consists of a preview window on the left side and the
complete list of resource links. By selecting one of the links the preview is shown on the

preview window. If you press button in the preview window, the resource is opened in a
separate viewer window.

At the bottom of the resource links tab the media data of a selected URL are displayed. These
data can be edited by double-clicking the "Type" entry in the resource variant table, by
clicking at one of the media data value fields or the button. The edit dialog provides the
possibility to access the URL to get available data. Additionally the values may be edited
manually.   
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Continue with::

 Edit descriptions - Main attributes tab
 Edit descriptions - Descriptor view tab
 Edit descriptions - Molecular sequence symbols
 Edit descriptions - Import sequence data
 Edit descriptions - Export sequence data
 Edit descriptions - Continuous view tab
 Edit descriptions - Sample data tab
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Editing the description - Sample data tab

The sample data tab allows assigment and inspection of sampling events and associated
sampling units for the description. In the upper left Sampling events part of the tab there is
a list of the sampling events stored for the description. By selecting a sampling event entry
the Event data are shown in the upper right part of the tab. Here you may edit the event
name, a detailled description, the date and time rsp. a date and time span and geographic
data. To insert a new sampling event click on the button in the Sampling events section,
to delete the selected sampling event and all stored sampling unit data press the button
(see image above).  

The geographic area may be linked to an entry of a DiversityGazetteers database (see
section Module related entry). If latitiude and longituede have not yet been entered, the
coordinates of the selected DiversityGazetteers entry will be inserted. By pressing the 
button a window to select the coordinates by Google maps will be opened. Field Geo. datum
allows entering short text concerning the geodetic datum. If coordinates are entered using
Google maps a remark that WGS84 coordinates are used will be inserted. 

 

Editing sampling unit data

For each sampling events one or several Sampling units may be entered. A sampling unit
represents a tuple of values that belong together, e.g. because they represent a single
specimen. For each descriptor, which is represented by the table column, a value may be
entered in a sampling unit, which builds a single table line. The background colour of each
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table column indicates the type of sample data: categorical, quantitative, text or sequence .
If the number of sampling units is displayed in field Units of the Sampling units section in the
lower part of the tab. If sampling units are present, the number is displayed with yellow
background (see image below). 

To view the unit data, select a Descriptor tree and choose the descriptor sequence range (
From descriptor ... to descriptor) to restrict the number of columns displayed in the unit
table. Finally press button and the sampling untis will be displayed (see image below). If
you prefer to display the present sampling units automatically whenever you select a sampling
event, click on the number behind Units. The background changes from yellow to red to
indicate this mode. When you select a cell and resources are available for the selected
descriptor column, the button will be shown. You may click it to view the descriptor
resources.  

To insert a new sampling unit press button . By clicking on the free space at the beginning
of a table line you mark the whole sampling unit (see picture below). Now you have the
additional options to delete the unit by pressing button or to copy the data to a new
sampling unit by pressing the button. Keep in mind that all unit data will be copied, even if
you do not see all descriptor columns due to the display restrictions. 

 

When you select the Sampling unit ID cell you may enter a collection specimen in the Unit
specimen control below the units table. By clicking the button (see section Module related
entry) you can link it to an entry in a DiversityCollection database. If the sampling unit is
linked to a database entry in DiversityCollection, the text of the Unit specimen: control is
shown with light yellow background. You may view the linked data by clicking the button or
double clicking the Sampling unit ID cell. 

To modify categorical sampling data enter the table cell and press the button within the
cell. A control will be opened where you can select the categorical states and enter notes or
modifier values (if defined) for each single state (see image below). 
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For all other sampling data the value can be entered directly in the table cell. Notes for the
selected table cell are entered in the Notes: text box directly below the units table. For
categorical, text and molecular sequence sample data a separate edit window can be opened
by double-clicking the table cell. For molecular sequence data the tool strip buttons 
(import) and  (export) allow import and export from rsp. to dedicated file formats as
described in sections Import sequence data and Export sequence data.

 

Continue with:

 Edit descriptions - Main attributes tab
 Edit descriptions - Descriptor view tab
 Edit descriptions - Molecular sequence symbols
 Edit descriptions - Import sequence data
 Edit descriptions - Export sequence data
 Edit descriptions - Continuous view tab
 Edit descriptions - Resource links tab
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Editing the descriptor
After starting a database query and selecting an entry in the result list the dataset is diplayed
in the edit window. In the header area the dataset name is shown (see picture below). Below
the header area the descriptor name may be edited in a text box and the sequence number
(No.) can be set, which determines the display order in descriptor lists. Changes of the
descriptor name will be visible in the header after saving the dataset. To check dataset
changes, click on the button to open the history. 

The main descriptor data may be accessed in the first Main attributes tab, which is
described below. Click on one of the other tabs in the picture below to go directly to the
appropriate manual chapter. 

 

Main attributes tab

The main attributes tab provides access to an abbreviation, a detailled descriptor text, notes
and wording information for natural laguage descriptions. In the bottom area the Descriptor
type, Descriptor settings, Measurement data (only for quantitative descriptors) and 
Molecular sequence data (only for sequence descriptors) can be adjusted. The descriptor
type can only be modified, if the descriptor is not referenced by any description. If the
descriptor type "Categorical" is changed, already entered categorical states will be deleted. 

The check box Exclusive (only for categorical descriptors) indicates that only one state shall
be specified in a description. Check box Mandatory indicates that for this descriptor always
data shall be specified. Statistical measurement scale specifies for categorical descriptors,
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if the states are unordered (e.g. red/green/blue) of ordered (e.g. bad/medium/good). For
quantitative descriptors it specifies if intervals or ratios are measured. Repeatability and
Availability specify how reliable (different measurements or scorings by different observers)
and accessible the descriptor is, e.g. for identification.

For quantitative descriptors the Unit of the measurement values my be specified either by
directly entering the string or alternatively by selecting a Prefix (e.g. "k" for "kilo" = 1000) and
the Base unit (e.g. "g" for "gramm"). Unit is prefix indicates that the measurement unit
preceeds the measurement value. Minimum and Maximum specify the absolute range limits
expected for the measurement values. If in a description specific values, e.g. "Mean", exceed
these limits, a warning will be shown. Values are integer indicates that dedicated values,
e.g. "Min" or "Max", are expected to be integer values. Take care that statisical measures like
"Mean" certainly may be real numbers. If this condition is violated in the description data, a
warning will be displayed.

For sequence descriptors the sequence type Nucleodide sequence or Proteine sequence
must be selected. Enable ambiguity symbols determines if in the sequence data ambiguity
symbols like "S" for "C or G" in nucleotide sequences, are allowed. In case of protein
sequences the Symbol length may be chosen from one letter sybols (e.g. "A" for "Alanine")
and three letter symbols (e.g. "Ala" for "Alanine). The Gap symbol is a symbol that indicates
gaps of unspecified length and must meet the selected symbol length.

Descriptors are not directly assigned to a project, instead descriptor trees are used. One
descriptor may be included in several descriptor trees and therefore belong to several projects
or it might be unassigned. You can easily find descriptors that are not included in any
descriptor tree by setting "Descriptor tree" -> "Assignment" to "Ø" in the search criteria. By
opening the Descriptor tree tab these descriptors may be easily inserted into a tree by
selecting the tree (node) and clicking .  

If the actually selected descriptor is referenced by more than ony project and not all of the
projects can be modified by the actual user, the descriptor data cannot be changed, which
will be indicated at the lower right corner of the application window (see above). 

 

Continue with:

 Edit descriptors - Categorical states tab
 Edit descriptors - Descriptor tree tab
 Edit descriptors - Modifier/Frequency tab
 Edit descriptors - Resource links tab
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Editing the descriptor - Categorical states tab

The Categorical states tab is only enabled, if the descriptor type has been set to
"Categorical". The upper part of the state tab shows the table of categorical states. To enter
a new state select the empty line at the end of the table and click on the "Categorical state"
field. After entering the "Categorical state" name (leave the cell by pressing the TAB key)
automatically a new value for the sequence number ("No.") is initialized. The sequence number
determines the display order in tables and may be changed manually. You may order the state
entries by clicking on the column header or by using the arrow buttons in the tool strip right
besides the states (  and for up and down, and to shift the selected entry to top or
bottom). After ordering the states click button to renumber the entries starting with "1"
and make the changes effective. 

If you want to delete a categorical state, you have three choices:

1. Select the state and press the button in the tool strip right besides the states. 
2. Select the state and press the Delete key on the keyboard. 
3. Enter the sequence number column ("No.") and remove the value. After leaving the cell

the entry will be deleted.

In any case you will be asked if you want to delete the data row. If the categorical state is
already used in any description items, the number of affected entries will be shown and you
have the option to abort the action.  

If for a state at least one assigned resource is present, the state is marked by a square (□)
behind its sequence number (see image above). After selecting the categorical state its
assigned resources ar displayed in the lower part of the state tab, the State resource links.
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It allows management of resources linked to a categorical state marked in the upper table. For
a detailled description take a look at the Resource links tab section.

 

Continue with:

 Edit descriptors - Main attributes tab
 Edit descriptors - Descriptor tree tab
 Edit descriptors - Modifier/Frequency tab
 Edit descriptors - Resource links tab
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Editing the descriptor - Descriptor tree tab

The Descriptor tree tab provides the possibility for a structured assignment of the
descriptors to the projects. The Descriptor tree consists of three node types, which show
the administered projects, descriptor trees, descriptor tree nodes and descriptors. The
tree parts' colours are shown in the example at the bottom. By pressing the button on the
tool stipe at the right side the example may be hidden. The buttons displayed on the too strip
will change depending on the selected entry.

Descriptor trees are the root of a tree and may only be appended at a project. To insert a
new descriptor tree select a project and press . Descriptor tree nodes may be appended
at a descriptor tree or another descriptor tree node. To insert a new descriptor tree node,
select the parent and press . Descriptors may be appended to a descriptor tree or a
descriptor tree node. To append a descriptor select the parent and press , to remove it
select the descriptor and press . All these functions can alternatively be accessed by the
context menu by a right click on the entry. The descriptor type is indicated by different icons.
Categorical descriptors are marked as , quantitative descriptors as , text descriptors as

and sequence descriptors as .

You may change the name of a Descriptor tree or a Descriptor tree node in three different
ways: 

1. Select the tree element (single click) and then click once on it. 
2. Select the tree element (single click) and click on button in the tool bar on the

right. 
3. Right-click the tree element and select item Edit name from the context menu. 
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You may edit the name of the selected node within the tree. The Descriptor tree must be
globally unique. The Descriptor tree node names must be unique with respect to their tree
position, i.e. all nodes with the same parent within a descriptor tree must have distinguished
names. 

If a Descriptor tree or a Descriptor tree node does not contain any other element, it may
be deleted by pressing  (delete descriptor tree) rsp. (delete descriptor tree node).
Please be aware that in edit mode "Descriptor" the descriptor tree shows only the descriptor
that as actually selected in the query panel! To get a complete overview of all descriptors
assigned to a certain descriptor tree and to delete trees or nodes with all included objects,
select edit mode "Project" (see Edit projects).

If projects and their associated descriptor trees cannot be changed, because the project has
been set to "read-only" state, these parts are displayed with grey text color (see project
"Schmetterlinge" in picture above).

Descriptor trees can be marked as "tree complete", to indicate that they should contain all
descriptors of the project. In this case the symbol of the descriptor tree changes from to

. Setting and resetting the "tree complete" flag is described in the Edit projects section,
where additional edit options are availabe.

When a new descriptor tree or descriptor tree node is inserted it gets a numeric name, which
may be changed by clicking on the node or selecting from the context menu. Take care
that the names of the discriptor trees must be unambiguous within the whole database! The
names of the descriptor tree nodes must only be unambiguous within one parent. 

The descriptor trees support three main functions:

 Assignment of descriptors to a certain project
 Selection of recommended Frequency/Modifier values and Statistical measures for

a certain descriptor
 Structured arragement of the descriptors, e.g. for hierarchical selection lists and

definition of descriptor subsets for description editing and export 

If no descriptor tree is installed for a certain project, all descriptors, modifier/frequency values
and statistical measures will be usable in the project's descriptions. If a project contains
several descriptor trees, the available descriptors are the superset of the descriptors assigned
to all contained trees. 

 

Sorting of descriptor tree elements 

By pressing the button you can expand the tree view to display all elements, by pressing
the tree will be collapsed to descriptor tree level. With the arrow buttons (  rsp. )

you can move descriptor tree nodes up or down rsp. to the top or the bottom. An additional
ordering option is to select the descriptor tree node you want to move and click the 
button. The button's back color changes to red and you may now select the new position in
the tree. 

In operation mode Edit projects you may take over the descriptor order from a descriptor tree
to the descriptor sequence numbers of all project's descriptors. This will affect the descriptor
presentation for description data editing or document generation.   

 

Descriptor tree node details  etails  

For Descriptor tree nodes you may enter an abbreviation a details text and assign resource
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data. Select the Descriptor tree node (single click) and click on button in the tool bar on
the right. Alternatively you may right-click the Descriptor tree node and select Edit
details from the context menu. An edit window as shown below will be opened.

If resources are assigned to a Descriptor tree node, its symbol is shown with grey
background in the descriptor tree. You may view the resources by right-clicking it and
selecting View resources from the context menu.   

 

Recommended statistical measures, modifiers and frequency values 

Click on in the tool bar to close the edit window in the right part of the tab or on  to
reopen it. In the edit window you can select recommended modifier/frequency values and
statistical measures. The recommended values can be administered for a selected descriptor
or for a selected descriptor tree node. In the latter case selected values are inherited by all
subordinate nodes, which will be indicated by the background colour if a subordinate node is
selected in the descriptor tree. 

Page 139



The picture below shows an example for a descriptor where the recommended statistical
measures Minimum value, Maximum value and Mean are inherited by the superior node.  

For the contained descriptor only additional values may be selected, but the inherited values
cannot be de-selected.

Page 140



 

Continue with:

 Edit descriptors - Main attributes tab
 Edit descriptors - Categorical states tab
 Edit descriptors - Modifier/Frequency tab
 Edit descriptors - Resource links tab
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Editing the descriptor - Modifier/Frequency
tab

The Modifier/Frequency tab allows definition of modifier and frequency values. The
sequence number column ("No.") determines the display sequence in selection lists. You may
order the entries by clicking on a column header. With the arrow buttons (  ) you can
move the selected entries up or down within the table, clicking button or shifts the
selected entries to the top respective bottom of the table. After ordering the entries click
button to renumber the table entries (starting with "1" for the first table entry) and make
the changes effective. After pressing button column "Use" shows the number of references
in the database for each modifier rsp. frequency value.

To enter a new modifier or frequency value, select the empty line on the end of the table and
click on the "Modifier" rsp. "Frequency" field to enter the new values. After entering the new
entry name automatically a new value for "No." is initialized. To delete an entry, select the
entry and press the tool strip button, the Delete key or remove the value in the sequence
number column ("No."). 

There is a number of predefined modifier and frequency values commonly used. These values
can be accessed by pressing the  button, which opens one of the windows shown below. 
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 By checking of uncecking the values, they can easily be inserted or deleted from the modifier
rsp. frequency list. Values that are already used in the database are marked by a grey text
colour. When these values are marked to be removed from the list, you will be asked for each
single value if it really shall be deleted after pressing OK. New values are inserted at the end
of the list (see below).
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You may order the modifier and frequency values according the sequence of the predefined
values by pressing the  button, which opens one of the windows shown below. Values that
are not in the predefined lists will be shifted to the end of the list. 
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Continue with:

 Edit descriptors - Main attributes tab
 Edit descriptors - Categorical states tab
 Edit descriptors - Descriptor tree tab
 Edit descriptors - Resource links tab
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Editing the descriptor - Resource links tab

The resouce links tab allows assigment and inspection of resource links for the descriptor. In
the lower Resources part of the tab there are two tables. Ar the left the "Resource" table
specifies the single resources, at the right the "Resource variant" table contains the
associated URLs to images, video or sound resources. 

To enter a new resource select the empty line at the end of the "Resource" table and click on
the "Resource name" field. After entering the "Resource name" (leave the cell by pressing the 
TAB key) automatically a new value for the sequence number ("No.") is initialized. The
sequence number determines the display order in tables and may be changed manually. You
may order the resource entries by clicking on the column header or by using the arrow buttons
in the left tool strip (  and for up and down, and to shift the selected entry to top or
bottom). After ordering the resources click button to renumber the entries starting with "1"
and make the changes effective. In field "Ranking" you may enter a numeric value in range 0
... 10 expressing the suitability of the resource. In field "Role" you may select one of the
offered values. 

If you want to delete a resource, you have three choices:

1. Select the resource and press the button in the left tool strip. 
2. Select the resource and press the Delete key on the keyboard. 
3. Enter the sequence number column ("No.") and remove the value. After leaving the cell

the entry will be deleted.

In any case you will be asked if you want to delete the data row, if resource links are
present.  
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To view or edit the additional resource data and copyright information press on the button 
besides the resource table. In field License: and a link to the license text in the web may be
entered, in field Rights: you may enter a copyright text. By pressing the button a browser
window can be opened to navigate to the license page in the web. Furthermore you may
enter a detailled text (field Details:), the resource language (field Language:) and set the
Display embedded flag (see picture below). If any additional resource data have been
entered, this will be indicated by a square (□) behind the resource name's sequence number. 

 

To enter a resource link, first select the entry in the "Resource" table, then select the empty
line at the end of the "Resource variant table". By clicking on the "URL" field a web address
may be entered. By double-clicking the "URL" field a browser window opens to navigate to the
resource. For each resource several URLs to resource variants with different quality levels,
e.g. different resolution, may be inserted. For each entry in the URL table a different value of
"Variant" must be selected. 

As an alternative to a resource URL a colour may be spcified in the format "color://#rrggbb"
where "rrggbb" specifies a hexadecimal colour code. The colour can simply be seleced by
clicking the button besides the resource variant table.

To remove a resource variant, select the entry and press the button in the right tool strip
or the Delete key on the keyboard. Alternatively you may delete the "URL" entry in the
resource variant table. 

The upper part of the resource links tab consists of a preview window on the left side and the
complete list of resource links. By selecting one of the links the preview is shown on the

preview window. If you press button in the preview window, the resource is opened in a
separate viewer window.

At the bottom of the resource links tab the media data of a selected URL are displayed. These
data can be edited by double-clicking the "Type" entry in the resource variant table, by
clicking at one of the media data value fields or the button. The edit dialog provides the
possibility to access the URL to get available data. Alternatively the values may be edited
manually.   
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Continue with:

 Edit descriptors - Main attributes tab
 Edit descriptors - Categorical states tab
 Edit descriptors - Descriptor tree tab
 Edit descriptors - Modifier/Frequency tab
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Editing the project
After starting a database query and selecting an entry in the result list the dataset is diplayed
in the edit window. In the header area the dataset name and the project language are shown
(see picture below). Below the header area the project name may be edited in a text box.
Changes of the project name or the project language will be visible in the header after saving
the dataset. To check dataset changes, click on the button to open the history. 

The main project data may be accessed in the first Main attributes tab, which is described
below. Click on one of the other tabs in the picture below to go directly to the appropriate
manual chapter.  

 

Main attributes tab

The main attributes tab provides access to a license URI, a short rights text and a detailled
project text. The project language can be selected from a list. In field Rights you may enter a
copyright text, in field License and a link to the license text in the web may be entered. By
pressing the button a browser window can be opened to navigate in the web. 

With combo box Language you can select the project's default language. You man change
the display and sorting of the entries in the Language combo box from "<code> -
<description>" to "<description> - <code>" (and back) by clicking the button . If you need
language codes that are not included in the list, click the button. For more details see Edit
language codes. 
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In the bottom area at the left side the Parent project and Workbench project can be
adjusted. If the project has no parent, select "Root" (symbol ). The Parent project
adjustment has an influence on the available descriptors, recommended modifier and
frequency values and recommended statistical measures, because these adjustments are
inherited by the subordinate project. If for a project in the Parent project tree no write
access is possible, this is indicated by grey text colour and symbol . The missing write
rights for a parent project has no influence on accessability of the actually selected project,
except that the parent project adjustment cannot be changed.  

The Workbench project (except the dummy value "DiversityDescriptions") references a
project entry administered in DiversityProjects. It determins visibility and accessability of the
local DiversityDescriptions projects for the database user. Each local project is assigned to
exactly one Workbench project. When you mark the entry you may view the database link
by clicking on URI or view the data stored in DiversityProjects by clicking on symbol at the
right (see image balow). For details about access rights administration see section "Data
access".

            

Fully accessible workbench projects are marked with the symbol . If only read access is
allowed, the workbench project is shown with grey text and symbol (see picture above). If
the actually selected project has been assigned to a "read only" workbench project, e.g. by
another user with appropriate rights, this is indicated at the right bottom corner of tha
application window (see picture below right). 

In the Scope values section at the right the values for scope types "Sex", "Stage" and
"Other scope" may defined. When you mark one of the entries, a tool strip with the available
operations is shown at the right border of the control. To insert a new value, select the scope
type and press button . In case of "Sex" one of the predefined "sex status" values derived
from the SDD standard has to be selected. In all other cases a new value with a numeric key
is appended, that can be renamed by pressing the button and selecting Edit scope
name or by clicking at the name.  

In case of "Sex" scope the "Edit" menu offers the additional menu items Reset scope name
, which appears if the name differs from the original "sex status". Further the "sex status"
value may be changed with menu item Set sex status. For the other scope types you may
enter a details text by pressing the button and selecting Edit scope details. 

To remove a scope value, select it and press the button. To make a value available for the
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project, the check box must be checked. If the selected project has a parent and a value has
already been checked in the parent project, this is indicated by the background colour (see
image below). 

 

Continue with:

 Edit projects - Descriptor applicability tab
 Edit projects - Descriptor tree tab
 Edit projects - Move/Copy descriptor trees
 Edit projects - Modifier/Frequency tab
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Editing the project - Descriptor applicability
tab

The Descriptor applicability tab serves the administration of dependencies between
categorical states and dependent descriptors. First a descriptor has to be selected either by
its name in the alphabetically ordered drop down list or its sequence number ("No.") in the first
line of the descriptor dependencies tab. If for the selected project a descriptor tree is
present, the  button allows selecting the descriptor form the descriptor tree (see picture
below).  
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The table Controlling states in the upper left part of the tab shows the categorical states if
a categorical descriptor has been selected. When you have adusted the restrichted descriptor
view, visible by the button in the toolbar of the Dependent descriptor section, only the
actually set dependent descriptors are displayed here. You can switch to an alternate Full
descriptor view as described below. For each categorical state Dependent descriptors can
be inserted by pressing the button. A dialog window opens to select the descriptor either
by its name, sequence number or using the descriptor tree (see picture below).
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In column "Rule" the symbol indicates that the dependent descriptor is inapplicable if the
controlling state is present in a description. The symbol indicates that the controlling state
must be present in a description if the controlled descriptor shall be applicable. The rule can
be toggled by clicking the symbol in the table or by pressing the corresponding button (
rsp. ) at the right. To remove a dependent descriptor select it and press the button. 

In the lower part of the tab you find the States controlling this descriptor. You may
double-click on the item to select navigate to it for editing. Alternatively you may edit the
controlling descriptor states using the control buttons of the tool strip at the right. By
double-clicking an entry in Dependent descriptors or in States controlling this descriptor
you may navigate forwards and backwards in the chain of dependent descriptors. 

If you want to get an overview of all the project's descriptor dependencies or want to delete
all dependencies, take a look at the Applicability tree section below. 

 

 

Calculation of the descriptor applicability

To decide if a descriptor is applicable in a description, the following conditions are evaluated:

 Inapplicable-if rule: If only controlling states are present in a description, these make
the controlled descriptor inapplicable. The character remains applicable if either no
state at all, or any non-controlling states are present.

 Applicable-if rule: If any controlling state is present in a description, these make the
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controlled descriptor applicable. It is inapplicable if only non-controlling states are
present. 

 Special condition 1: If the controlling descriptor is inapplicable (through another
applicability rule, or through an explicit "Not applicable" data status value), the
controlled descriptor is always inapplicable as well.

 Special condition 2: If no data for the controlling character are present in a
description (data completely missing or only status is "Missing data" or "Not to be
recorded"), the controlled character always remains applicable.

 

 

Full descriptor view

By clicking the button in the toolbar of the Dependent descriptor section, you can
chenge to the full descriptor view (see image below). In section Dependent descriptors all
available project descriptors are shown. You may set a dependency by selecting the
descriptor and clicking the button rsp. . To remove the dependency, click on button .
Alternatively you may click on they symbol in the table column "Rule" to change the values in
the sequence -> -> . 

If you select a values for the Descriptor tree, the descriptor list is restricted to the values
included in that descriptor tree. Please be aware that existing dependencies might be hidden
by such a selection!  

You can return to the restricted descriptor view by clicking on button . 
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Applicability tree

Instead of the States controlling this descriptor you may display a complete overview of
the descriptor applicability rules by pressing the button in the Dependent descriptors
section (see image below). By double-clicking an item in the Applicability tree you can open
it for editing.

By pressing the button in the Applicability tree section you can delete all dependencies
shown in the tree.

 

Continue with::

 Edit projects - Main attributes tab
 Edit projects - Descriptor tree tab
 Edit projects - Move/Copy descriptor trees
 Edit projects - Modifier/Frequency tab
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Editing the project - Descriptor tree tab

The Descriptor tree tab provides the possibility for a structured assignment of the
descriptors to the projects. The Descriptor tree consists of three node types, which show
the administered projects, descriptor trees, descriptor tree nodes and descriptors. The
tree parts' colours are shown in the example at the bottom. By pressing the button on the
tool stip at the right side the example may be hidden. The buttons displayed on the too strip
will change depending on the selected entry. 

By default only the selected project. its subordinated projects and their descriptor trees are
displayed. You may select the "Show all projects" option by clicking the button in the tool
strip to show alle projects. To indicate that this option is active, the icon background will be
changed to red color (see images below). Be aware that this option might slow down data
loading.

Descriptor trees are the root of a tree and may only be appended at a project. To insert a
new descriptor tree select a project and press , to delete it select the descriptor tree and
press . Descriptor tree nodes may be appended at a descriptor tree or another descriptor
tree node. To insert a new descriptor tree node, select the parent and press , to remove it
select the descriptor tree node and press . Descriptors may be appended to a descriptor
tree or a descriptor tree node. To append a descriptor select the parent and press , to
remove it select the descriptor and press . All these functions can alternatively be
accessed by the context menu by a right click on the entry. The descriptor type is indicated
by different icons. Categorical descriptors are marked as , quantitative descriptors as ,
text descriptors as and sequence descriptors as .
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You may change the name of a Descriptor tree or a Descriptor tree node in three different
ways: 

1. Select the tree element (single click) and then click once on it. 
2. Select the tree element (single click) and click on button in the tool bar on the

right. 
3. Right-click the tree element and select item Edit name from the context menu. 

You may edit the name of the selected node within the tree. The Descriptor tree must be
globally unique. The Descriptor tree node names must be unique with respect to their tree
position, i.e. all nodes with the same parent within a descriptor tree must have distinguished
names. 

If projects and their associated descriptor trees cannot be changed, because the project has
been set to "read-only" state, these parts are displayed with grey text color (see project
"Schmetterlinge" in picture above).

When a new descriptor tree or descriptor tree node is inserted it gets numeric name, which
may be changed by clicking on the node or selecting from the context menu. Take care
that the names of the discriptor trees must be unambiguous within the whole database! The
names of the descriptor tree nodes must only be unambiguous within one parent. 

The descriptor trees support three main functions:

 Assignment of descriptors to a certain project
 Selection of recommended Frequency/Modifier values and Statistical measures for

a certain descriptor
 Structured arragement of the descriptors, e.g. for hierarchical selection lists and

definition of descriptor subsets for description editing and export 

If no descriptor tree is installed for a certain project, all descriptors, modifier/frequency values
and statistical measures will be usable in the project's descriptions. If a project contains
several descriptor trees, the available descriptors are the superset of the descriptors assigned
to all contained trees. 

 

Editing the project descriptor assignemnts for a tree node 

When you use button to append a descriptor to a tree node, you will be offered all
accessible descriptors in the database. In many cases, when you have already assigned all
required descriptors to the project, you may wish to build some additional structured
descriptor trees. If you select a descriptor tree or a descriptor tree node, the button is
shown (see image below left). After clicking this button you will get a selection list with all
descriptors assigned to the project. Descriptors that are included in the tree node are
selected in the list (see image below right). You may easily change the selection and click
"OK" to make the changes effective. 
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Sorting of descriptor tree elements 

By pressing the button you can expand the tree view to display all elements, by pressing
the tree will be collapsed to descriptor tree level. With the arrow buttons (  rsp. )

you can move descriptors or descriptor tree nodes up or down rsp. to the top or the bottom.
An additional ordering option is to select the descriptor tree node you want to move and click
the button. The button's back color changes to red and you may now select the new
position in the tree. If you select a descriptor tree or a descriptor tree node, you may arrange
the contained descriptors in alphabedical order by clicking the buttons (ascending) or 
(descending). 

A descriptor tree may be marked as "tree complete" to indicate that this tree shall contain all
descriptors for the project. This is done by selecting the descriptor tree node and clicking the
button . To indicate that the tree is marked as complete the tree icon changes to (see
picture below).  
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The "tree complete" flag may be removed by clicking the button and the tree icon will be
changed back to (see picture below). 
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If a descriptor tree is marked as "tree complete", it can be used to take over the sorting of
the descriptor nodes to the sequence number of the descriptors. But you must be aware that
the descriptor's sequence number (field "No." in "Edit descriptor" main panel) is not project or
tree dependent, i.e. that this operations will have influence on the dispolay sequence of all
descriptions using these descriptors. Click on button (see picture above) to open the
descriptor sorting window below. 
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The first column shows the descriptor names as sorted in the descriptor tree, the second
column shows the current sequence number int the database and the last column shows the
new sequence number. If the sequence number stays unchanged, the new sequence number
is displayed with green background, otherewise with yellow background. You may click on a
new sequence number and change its value manually. By clicking on the table headers, you
may sort the table display according descriptor names, old or new sequence numbers. If a
descriptor may not be changed, because it is assigned to a project where the user has no
write access, the whole line is displayed with grey backgound and cannot be changed. Finally
click on OK to accept or Cancel to reject the changes. 

An additional option available for complete trees is to copy missing descriptors with button .
The descriptors available for a certain project include all descriptors assigned to all descriptor
trees of the project and its sub-projects. In our example a new descriptor tree has been
assigned to the upmost project (see image below left). After clicking the button all valid
descriptors are inserted to the descriptor tree (see image below right).  

Page 165



 

Page 166



 

Descriptor tree node details  

For Descriptor tree nodes you may enter an abbreviation a details text and assign resource
data. Select the Descriptor tree node (single click) and click on button in the tool bar on
the right. Alternatively you may right-click the Descriptor tree node and select Edit
details from the context menu. An edit window as shown below will be opened.
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If resources are assigned to a Descriptor tree node, its symbol is shown with grey
background in the descriptor tree. You may view the resources by right-clicking it and
selecting View resources from the context menu.   

 

Recommended statistical measures, modifiers and frequency values 

Click on in the tool bar to close the edit window in the right part of the tab or on  to
reopen it. In the edit window you can select recommended modifier/frequency values and
statistical measures. The recommended values can be administered for a selected descriptor
or for a selected descriptor tree node. In the latter case selected values are inherited by all
subordinate nodes, which will be indicated by the background colour if a subordinate node is
selected in the descriptor tree. 

Page 168



The picture below shows an example for a descriptor where the recommended statistical
measures Minimum value, Maximum value and Mean are inherited by the superior node. 

For the contained descriptor only additional values may be selected, but the inherited values
cannot be de-selected.
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Continue with:

 Edit projects - Main attributes tab
 Edit projects - Descriptor applicability tab
 Edit projects - Move/Copy descriptor trees
 Edit projects - Modifier/Frequency tab

Page 170



Editing the project - Move or copy descriptor
trees
Using the context menue, you may move or copy parts of a descriptor tree to other branches.
Please note that for the move and copy operations the selected project, marked by its 
background colour in the descriptor tree, is assumed as the target project. You may copy
descriptor trees or parts of projects with read-only access to your selected project. The
move operation is certainly not possible in those cases. Note that by the copy operations only
the tree structures will be copied, associated recommended statistical measures, modifiers
and frequencies will not be copied! The move operations preserve those adjustments. 

Remark: If you want to move or copy element from an other than the selected project,
activate the "Show all projects" option by clicking the button in the tool strip. The icon
background will be changed to red color to indicate that this option is active.

1. Move or copy a descriptor tree

Right click on the descriptor tree you want to move/copy. A context menu opens, that offers
the options Copy '<tree name>' to '<project name>' rsp. Move '<tree name>' to
'project name' (see picture below left). If you selected "Move", the descriptor tree is
removed from the original project and appended to your selected project. If you selected
"Copy", a copy of the tree will be appended to the selected project. In this case numeric IDs
are appended to generate unique tree and tree node names (see picture below right). The
copy function can be used to generate a clone of a descriptor tree in the selected project.
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Additionally you may copy the contents of a descriptor tree to a descriptor tree node by
clicking selecting the option Copy descriptor tree to descriptor tree node ... rsp. 
Move descriptor tree to descriptor tree node ... (see picture above left). A separate
window opens to select the target node (see picture below left). Find the move result in the
right picture below. Since the tree has been moved, the tree node names have not been
changed. One duplicate descriptor has not been moved to the target node. 
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2. Move or copy a descriptor tree node

Right click on the descriptor tree node you want to move/copy. A context menu opens, that
offers the options Copy descriptor tree node ... rsp. Move descriptor tree node ...
(see picture below left). After selecting one of there items a dialog windows opens where you
may select the target descriptor tree or descriptor tree node (see picture below right).
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If you selected "Move", the descriptor tree node is removed from the original position and
appended to the selected tree position. If you selected "Copy", a copy of the tree node will
be appended to the selected tree position. In this case numeric IDs are appended to generate
unique tree node names (see picture below). The copy function can also be used to generate
a clone of a descriptor tree node in the selected project.

3. Move or copy a descriptor

Right click on the descriptor you want to move/copy. A context menu opens, that offers the
options Copy descriptor ... rsp. Move descriptor ... (see picture below left). After
selecting one of there items a dialog windows opens where you may select the target
descriptor tree or descriptor tree node (see picture below right).
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If you selected "Move", the descriptor is removed from the original position and appended to
the selected tree position. If you selected "Copy", a new descriptor node will be appended to
the selected tree position (see picture below). 
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Continue with:

 Edit projects - Main attributes tab
 Edit projects - Descriptor applicability tab
 Edit projects - Descriptor tree tab
 Edit projects - Modifier/Frequency tab
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Editing the project - Modifier/Frequency tab

The Modifier/Frequency tab allows definition of modifier and frequency values. The
sequence number column ("No.") determines the display sequence in selection lists. You may
order the entries by clicking on a column header. With the arrow buttons (  ) you can
move the selected entries up or down within the table, clicking button or shifts the
selected entries to the top respective bottom of the table. After ordering the entries click
button to renumber the table entries (starting with "1" for the first table entry) and make
the changes effective. After pressing button column "Use" shows the number of references
in the database for each modifier rsp. frequency value.

To enter a new modifier or frequency value, select the empty line on the end of the table and
click on the "Modifier" rsp. "Frequency" field to enter the new values. After entering the new
entry name automatically a new value for "No." is initialized. To delete an entry, select the
entry and press the tool strip button, the Delete key or remove the value in the sequence
number column ("No."). 

There is a number of predefined modifier and frequency values commonly used. These values
can be accessed by pressing the  button, which opens one of the windows shown below. 
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 By checking of uncecking the values, they can easily be inserted or deleted from the modifier
rsp. frequency list. Values that are already used in the database are marked by a grey text
colour. When these values are marked to be removed from the list, you will be asked for each
single value if it really shall be deleted after pressing OK. New values are inserted at the end
of the list (see below).
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You may order the modifier and frequency values according the sequence of the predefined
values by pressing the  button, which opens one of the windows shown below. Values that
are not in the predefined lists will be shifted to the end of the list. 
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Continue with:

 Edit projects - Main attributes tab
 Edit projects - Descriptor applicability tab
 Edit projects - Descriptor tree tab
 Edit projects - Move/Copy descriptor trees
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Description grid view
After starting a database query for descriptions select Grid -> Description grid view ...
from the menu. The query result list is passed to the description grid view form and a window
as shown below opens (click the button Display description table to build the table
output). In the first line the database name is displayed. If you move the mouse cursor over
the database name, a tooltip shows the actual connection paramter.  

The table in the lower part of the window shows the description titles in the first column and
the summary data in the other columns. Each summary column holds the data of a certain
descriptor. If a cell with summary data is selected, the summary details and the descriptor
status data are displayed in the upper right part of the window. The upper left part of the
window shows the selection parameters that are used for building the description table. You
may change the table colors by clicking the button . A form as shown below will be
opened.  

Click on buttons categorical, quanitative, text or sequence to select the corresponding
table colors. By clicking the Reset button below the color, the corresponding default value
will be selected. After changing the table colors by a click on the OK button, you must
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re-draw the table. 

 

Selection parameters

In the upper left part of the parameters for the description table can be adjusted. If in the
query list passed to the form descriptions of different projects are present, the displayed
project can be selected with the Project: drop-down box. The entries in the drow-down list
include the project name, followed by the number of descriptions for that project in brackets
and an asterisk (*) if the user has only read access for that project. 

The Descriptor tree drop-down box restricts the descriptor columns to the descriptors
contained in the selected tree. Furthermore the tree hierarchy is included in the descriptor
names if a structured descriptor tree is selected (see images below). 
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The values From descriptor and to descriptor limit the range of descriptor sequence
numbers that is included in the discription tabe. Be aware that this restiction is additionally
effective to a selected desriptor tree! If you want to de-activate this restriction, select "from"
value 0 "to" value 999999 by a double-click on the labels From descriptor rsp. to descriptor
. The limitation of the number of descriptor columns makes speeds up the description table
generation, especally if many descriptor (e.g. some hundrets) are present.

If you select option Separate statistical measures, separate columns will be insterted in
the data grid for each quantitative descriptor and its recommended statistical measures. This
option may be useful for editing quantitative summary data that use other statistical measures
than Min, UMethLower, Mean, UMethUpper and Max (see section Data editing for details.

Finally click the button Display description table to build a new description table
according to your settings. During output of the description table the icon of the button
changes to  and you may abort processing by clicking the button.  

 

Continue with:

 Description grid view - Data editing
 Description grid view - Copy or create descriptions
 Description grid view - Save or discard changes
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Description grid view - Data editing
The first column of the description table shows the description titles, which are fixed. I.e. if
you scroll the summary data to the right, the titles are still visible at the left. The other
columns show the summary data, where the descriptor type is indicated by the background
colour: categorical, quantitative, text or sequence. The column titles include the descriptor
name, the mesurement unit in square bracket for quantitative descriptors and the descriptor's
sequence number (see image below).

When a summary cell in the description table is selected, the field Description: shows the
description title and field Descriptor: shows the symbols according the descriptor type (
for categorical, for quantitative, for text and for sequence) and the descriptor title. If
for a descriptor resources are available, this fact is indicated by a coloured symbol
background. You may view them by a double-click on the descriptor title. If for a description
resources are available, the symbol is displayed before the title. Double click in that symbol
to view the resources.  

For the selected cell the summary data and the descriptor status data are displayed in the
upper right area of the window (see image above). You may edit the data within these
controls as described in section Editing the description - Descriptor view tab of this manual.
For modified summary cells the text colour changes to blue and the description titles will be
shown with yellow background in the table. 

 

Changing the description title

To change the description title, double-click on it in field Description: to open a separate edit
window. After comitting the changes with "OK" the description will be marked as modified (see
images below). 
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Changing the summary data in the table

Categorical summary data

Categorical, states are specified by their sequence number. Multiples are separated by a
forward slash ("/", see image below). Existing "notes" will be removed, if the corresponding
categorical state is not specified in the input. 
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Quantitative summary data

If you did not check the option Separate quantitative measures, for quantitative summary
data only the five quantitative measures   

Min Minimum value 
UMethLower Lower range limit (legacy data stat. meth. unknown) 
Mean Mean (= average) 
UMethUpper Upper range limit (legacy data stat. meth. unknown) 
Max Maximum value 

can be specified within the summary table. The values must be specified in theis given order
and separated by a forward slash ("/"). E.g. 1////100 means "Min=1, Max = 100". If only one
value without any slashes is entered, it is assumed than only the "Mean" value is specified. To
indicate that values for other than the five mentioned statistical measures are present in the
data, an asterisk ("*") is appended in the summary table (see image below, cell value 1////100
*). 
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If you checked the option Separate quantitative measures, for each statistical measure in
the quantitative summary data a separate column will be allocated in the data grid view. I.e.
you can direcly enter your values into the table (see image below). 

Page 189



   

 

Text descriptor and Molecular sequence data

For Text and sequence data the texts may be edited directly within the table. The
corresponding "notes" will not be affected. 

 

Changing values in a table column

It is possible to modify several values of a single table column. Therefore select the table
entries that shall be edited - by selecting an entry and clicking the button in section
Column action you may select the whole table column (see image below). Then select the
required operation: "Insert", "Append", "Replace" or "Clear" and enter the new rsp. new and old
value. After clicking the action button - depending on the selected Column action this is 
(Insert), (Append), (Replace) or (Clear). Be aware that this feature performs a pure
text operation in the table columns. Especially for quantitative and categorical data columns
the resulting data will be interpreted according to the rules described above an might lead to
unsexpected results, if not designed ver carefully.  
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Continue with:

 Description grid view - Selection parameters
 Description grid view - Copy or create descriptions
 Description grid view - Save or discard changes
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Description grid view - Copy or create
descriptions
To copy one or more descriptions select the whole data rows by clicking in the area left from
the "Description title" column. In the tool strip the copy button appears (see image below). 

After clicking the button you may be asked if you want to copy description resources, too.
Be aware that the copy operation is directly performed within the database. I.e. that local
changes that have been done in the sources desrcriptions will not be included in the targets
unless you save your data before copy (see image below, second and last line in descriptors
28 and 29).  
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New description

To enter a new description, click on button and a new row will be appended (see image
below). Same as for copy the new description is created directly within the database. 
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Continue with:

 Description grid view - Selection parameters
 Description grid view - Data editing
 Description grid view - Save or discard changes
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Description grid view - Save or discard
changes
When you click in button "OK" the description grid view is closed and all changes are
automatically saved in the database. If you did some changes and want to save them without
leaving the form, simply click on (see image below). If you close the window, e.g. by
clicking the "Cancel" button, and still have unsaved changes, you will be asked to save or
discard the changes. 

 

Undo all changes

You may discard all unsaved changes without leaving the form by clicking the button and
the data will be reloaded form the database (see image below). 
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Sample data grid view
After starting a database query for descriptions select Grid -> Sample data grid view
... from the menu. The query result list is passed to the description grid view form and a
window as shown below opens. In the first line the database name is displayed. If you move
the mouse cursor over the database name, a tooltip shows the actual connection paramter. 

The table in the lower parThe table in the lower part of the window shows the sampling unit
IDs in the first column and the sample data in the other columns. Each sample column holds
the data of a certain descriptor. The upper part of the window shows the selection
parameters that are used for building the sampling unit table. You may change the table colors
by clicking the button . A form as shown below will be opened.  

Click on buttons categorical, quanitative, text or sequence to select the corresponding
table colors. By clicking the Reset button below the color, the corresponding default value
will be selected. After changing the table colors by a click on the OK button, you must
re-draw the table. 
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Selection parameters 

In the upper left part of the parameters for the samping unit table can be adjusted. If in the
query list passed to the form descriptions of different projects are present, the displayed
project can be selected with the Project drop-down box. The entries in the drow-down list
include the project name, followed by the number of descriptions for that project in brackets
and an asterisk (*) if the user has only read access for that project. 

After selecing a project in section Descriptions and sampling events (right upper part of
the window) the descriptions and their sampling events are listed. Here you may select the
descriptions and sampling events that shall be used for building the sampling unit table. The
buttons all, none and swap can be used to change the selection of all tree
elements. By pressing the button the tree view may be expanded to display the contained
sampling events, by pressing the button only the descriptions will be shown. In the bottom
of the section the currently selected number of sampling events and sampling units is
displayed. 

When you click on a single sampling event and more than one description is in the list, the
button appears in the tool strip. By clicking this button you can open a description
selection window and thus shift the sampling event to a different parent description.  

The Descriptor tree drop-down box restricts the descriptor columns to the descriptors
contained in the selected tree. Furthermore the tree hierarchy is included in the descriptor
names if a structured descriptor tree is selected (see images below). 
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The values From descriptor and to descriptor limit the range of descriptor sequence
numbers that is included in the discription tabe. Be aware that this restiction is additionally
effective to a selected desriptor tree! If you want to de-activate this restriction, select "from"
value 0 "to" value 999999 by a double-click on the labels From descriptor rsp. to descriptor
. The limitation of the number of descriptor columns makes speeds up the description table
generation, especally if many descriptor (e.g. some hundrets) are present.

Finally click the button Display sampling units table to build a new sampling unit table
according to your settings. During output of the sampling unit table the icon of the button
changes to  and you may abort processing by clicking the button. 

 

Continue with:

 Sample data grid view - Data editing
 Sample data grid view - Save or discard changes
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Sample data grid view - Data editing
The first column of the sampling unit table shows the sampling unit IDs titles, which are fixed.
I.e. if you scroll the sample data to the right, the IDs are still visible at the left. The other
columns show the sample data, where the descriptor type is indicated by the background
colour: categorical, quantitative, text or sequence. The column titles include the descriptor
name, the mesurement unit in square bracket for quantitative descriptors and the descriptor's
sequence number (see image below).

When a sample cell in the sampling unit table is selected, the field Sampl. event: shows the
sampling event titles, field Description: shows the description title and field Descriptor:
shows the symbols according the descriptor type (  for categorical, for quantitative, 
for text and for sequence) and the descriptor title. If for a descriptor resources are
available, this fact is indicated by a coloured symbol background. You may view them by a
double-click on the descriptor title. If for a description resources are available, the symbol 
is displayed before the title. Double click in that symbol to view the resources. 

For the selected cell the sample data may be edited as described in section Editing the
description - Sample data tab of this manual. For modified sample cells the text colour
changes to blue and the sample unit IDs will be shown with yellow background in the table. 

 

Changing the sampling event

To shift samling units to a different sampling event, select the whole data rows by clicking in
the area left from the "Sampling unit ID" column. In the tool strip the set event button 
appears. After clicking the button a window for selecting the new parent sampling event will
be opened (see image below). 
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Copy sampling units

To copy one or more sampling units select the whole data rows by clicking in the area left
from the "Sampling unit ID" column. In the tool strip the copy button appears (see image
below). 

   

After clicking the button the copied line are inserte at the end of the tabel (see image
below).  
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Delete sampling units

To delete one or more sampling units select the whole data rows by clicking in the area left
from the "Sampling unit ID" column. In the tool strip the copy button appears. 

 

New sampling unit

To enter a new sampling, click on button and a new row will be appended. After clicking the
button a window for selecting the sampling event will be opened. 

   

 

Continue with:

 Sample data grid view - Selection parameters
 Sample data grid view - Save or discard changes
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Sample data grid view - Save or discard
changes
When you click in button "OK" the sample data grig view is closed and all changes are
automatically saved in the database. If you did some changes and want to save them without
leaving the form, simply click on (see image below). If you close the window, e.g. by
clicking the "Cancel" button, and still have unsaved changes, you will be asked to save or
discard the changes. 

 

Undo all changes

You may discard all unsaved changes without leaving the form by clicking the button and
the data will be reloaded form the database (see image below).  
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Extended text editor
In the most text fields you can open an extended text editor by double-clicking the text field,
whic proviedes the following features: 

 Text formatting
 RTF-like text formatting 
 Inserting text links 

 

Text formatting

In the text fields you may use some HTML mark-ups <b>bold</b> <i>italic</i> and
<u>underline</u> for text formatting (see image below left). Additionally the tags <br>, <br/>
or <br /> may be inserted to indicate a new text line, but the most common way is to press
the ENTER key instead. The format tags will have an effect if documents are generated from
the database. 
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By double-clicking the text field you can open a separate edit window that shows the text
formatting (see image above right). You can easily change the formatting by selecting a text
and clicking the buttons B, I or U. 

To reload the original text into the edit window click the button. By clicking OK the changes
are taken over to the text field, to ignore the changes, click the cancel button. 

 

RTF-like text formatting

In some projects RTF-like mark-ups are used to indicate text formatting, e.g. \i{}italics\i0{}
for italics. If you double-click on the text field you can open the separate edit window and
button indicates that RTF-like format mark-ups have been detected (see image below). 
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By clicking the button the edit window will show you the formatted text (see image below
left). After clicking OK the text will be stored using the HTML mark-ups, which is the standard
for DiversityDescriptions (see image below right). 
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Inserting links into text

You may open an internet browser by klicking the button . After navigating to your target
page, click OK to insert the link at the current cursor position. By klicking the drop-down
button you can select a Diversity Workbench database and search for a certain database
entry (see image below). 

After selecting a found entry and clicking OK the database link is inserted at the current
cursor position (see image below).  
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When the link is clicked either the web browser opens (for regular HTML links) or the Diversity
Workbench application to display the databease entry (see image below). 
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Table editors
For the data selected in the main window the table editors offer a direct access to the tables
of the database. Underneath the menu Grid  select one of the Table editors. A window
with the content of the table will open. Columns with a gray background can not be edited
here. Columns with a light gray background are linked to the contents of lookup tables where
you can change according to the contents of these tables. The following tables are included
for direct access: 

 Project 
 SamplingEvent 
 Description 
 Descriptor 
 CategoricalState 
 Resource 
 ResourceVariant 
 Translation 

Depending on the edit mode the following options are available in the Table editors menue: 

 Edit descriptions 
o Sampling events to edit the sampling events of the descriptions in the

query result list
o Descriptions to edit the descriptions in the query result list
o Description resources to edit the resource entries for the descriptions in

the query result list
o Resource variants to edit the resource variant entries for the descriptions

in the query result list
o Translations to edit the translation entries for the descriptions in the query

result list
 Edit descriptors: 

o Descriptors to edit the descriptors in the query result list
o Descriptor resources to edit the resource entries for the descriptors in the

query result list
o Categorical states to edit the categorical states of the descriptors in the

query result list
o Categorical state resources to edit the resource entries for the categorical

states of the descriptors in the query result list
o Resource variants to edit the resource variant entries for the descriptors

and categorical states in the query result list
o Translations to edit the translation entries for the descriptors and

categorical states in the query result list
 Edit projects 

o Project to edit the projects in the query result list
o Descriptor tree node resources to edit the resource entries for the

descriptor tree nodes of the projects in the query result list
o Resource variants to edit the resource variant entries for the descriptor

tree nodes of the projects in the query result list
o Translations to edit the translation entries for the projects in the query

result list

 

Page 210



As an example see below the table editor window for projects. 

 

Read-only

If for parts of the query result no write access exists, the table editor will be opened in
read-only mode. Especially for descriptors you should keep in mind that they may belong to
more than one project. Therefore the table editors for descriptors, categorical states and
their resources or resource variants may be opened for read-only, if you have not write
permissions for all projects in the database.  

 

Editing

You can either edit the contents of the table directly or perform changes to any number of
marked fields. To mark a whole column use the  button. Once you have selected the
contents to change, select one of the modes of change that appear in the upper left corner.
The modes of change are: 

 Insert: Insert the given value at the beginning of the content 
 Append: Append the given value at the end of the content 
 Replace: Replace a string in the content with the given value 
 Clear: Remove the content 

After selecting the change mode, enter the text in the field where necessary and click on the
corresponding button to perform the changes. 
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If you want to delete a line in the database, select it by clicking in the space before the line
and press the button. Take care that an undo of that action is not possible. 

 

Filtering

To filter the content of the table, click in the column that should be used for filtering. Then
choose the mode of comparision:

 = : The content must be exactly like the given value 
 ~ : The content must contain the given value 
 ≠ : The content must be different to the given value 

If you want the filtering to be case sensitive, choose the a<>A option. After all parameters
are set, click on the button. To undo the filtering, click on the button. This will reset the
data to the last saved version. If you want your changes to be saved, click the button
before you reset the filtering. If you close the window all changes so far will be saved
automatically. If you do not want to save your changes, click on the button to close the
window without saving. 

 

Export

To export the data as a tab separated text file, click on the button. The file will be
automatically saved in the client-folder.  
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Translations
For each project a default language is selected in the Edit project panel. In Diversity
Descriptions for most database entries additionally translated expressions can be stored in
the Translation table. Even for the default language adjusted for the project alternate
expressions may be entered. In several export and document generation forms it is possible to
select an alternate output language, if translations are available. Translatable entities are
listed in the following table. 

Database table Database columns 

CategoricalState label, detail, abbreviation, wording 

DataStatus_Enum label, detail, abbreviation 

Description label, detail, wording 

Descriptor label, detail, abbreviation, wording_before, wording_after, wording 

DescriptorTree label 

DescriptorTreeNode label, detail, abbreviation 

Frequency label 

Modifier label 

OtherScope label, detail 

Project label, detail 

Resource label, detail 

ResourceVariant_Enum label, detail 

SamplingEvent label, detail 

SexStatus_Enum label, detail, abbreviation 

StatisticalMeasure_Enum label, abbreviation 

All mentioned entities may be edited using the translations editor. If for an output a
translation language is specified, a situation may occur that for a certain entity not
translation is stored in the database. In those cases automatically the original database
values will be used.  

As you can see in the table above, no translations are supported for the descriptive data, i.e.
summary or sampling data. Concerning categorical data, there is a tranlsation support,
because the terminology parts (Descriptor and CategoricalState) my be translated.
Quatitative data mainly include numeric values and their statistical measure, where the
measure texts themselves can be translated. The same is valid for descriptor status data.
Molecular sequence data naturally do not contain any translatable texts. Finally only the
contents of text descriptor data and notes, that can be included in any summary or sampling
data, are not supported for translation. 

 

Data export

The export format SDD is XML based and offers multilingual support. By default the document
language ist set to the project default language and the original database entries (labels,
detail texts and so on) are included without explicit language tag. If translations are stored in
the database, they are included in the SDD output with their specific language tag. As an
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option translations may be completely excluded from export or the SDD document language
may even be switched to one of the available translation languages. Please be aware, that
the enumerated values (DataStatus_Enum, StatisticalMeasures_Enum and SexStatus_Enum)
are identified by specific tags within SDD. Therefore the translations for these are not
included in the SDD file!  

The export format DELTA is text based and does not support multilinguality. By default the
original database entries are used in the DELTA output. If translations are stored in the
database, you may select one of the available languages for the DELTA output. 

In both cases the general rule applies that if for a certain term no translated value is present,
the original value will be used. For details concerning the data export see here. 

 

Data import

In the SDD import form the available languages are displayed. You have the options to omit
translations during import or select a different language as the project's default language.  

The DELTA import form offers the option to import translations for descriptors, categorical
states and description items from separate DELTA files with identical structure. In a first step
the complete data are imported form a main DELTA file. In subsequent steps the identifier for
additional languages may be imported from additional language specific DELTA files.  

 

Document generators

The is a number of document generators to generate HTML or Media Wiki output. In this form
an "Export language" field is shown if any translations are available in the database. In those
cases you have the choice to adjust the default language or one of the offered tranlsations
languages. Anyway, there may be some fixed expressions in the generated documents, where
currently no mutilingual support is available.   
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Editing translations
After connecting a database select Edit -> Translations ... from the menu (see image
below). You have to select the mandatory parameter Project and the Table. If you want to
enter a new translation text, the Column and the target Language must be selected. If you
omit one of those parameters, only existing tranlation texts from the database will be shown. 

You man change the display and sorting of the entries in the Language combo box from
"<code> - <description>" to "<description> - <code>" (and back) by clicking the button . If
you need language codes that are not included in the list, click the button. For more details
see Edit language codes. 

With the numeric control Items you may adjust how many database items shall be selected
for display. After clicking the button the query results are displayed. By clicking the
buttons and you can load the next rsp. previous matches.  

The table lists the internal ID of the data entry ("ID"), the table column ("Column"), the
project language ("PL"), the "Original text", the translation language ("TL") and the "Translated
text" (see image below).  In table column "x" lines without write access will be marked as  x .
If you have write access, you may enter the tranlated text directly in the table.  
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You may copy the original text of selected lines to the translated text by clicking the button 
or delete the translated text with button . To select all translated texts click on button
. In modified lines the background color of the first two columns will be change to yellow

(see image below). With button you can save the modified data, with button you can
reload the table, i.e. discard the changes.  
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If you selected any Translated text entries, it is possible to modify several values
simultaneously. Therefore select the table entries that shall be edited - by clicking the button 

you may select the whole table column. Then select the required operation in the Edit
section: "Insert", "Append" or "Replace" and enter the new rsp. new and old value. After
clicking the action button - depending on the selected operation this is (Insert), 
(Append) or (Replace). 

By double-clicking the table line or clicking the button you can open a separate edit window
(see image below). This form works almost in the same way as the Extended text editor. 
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Edit language codes
In the Diversity Descriptions database language codes are used for two purposes: The first
one is to indicate the project's default language. Furthermore for the most important parts of
the data translations may be entered, which carry a laguage code, too. 

By all means the language codes consists of an at most three-letter string. In the application
you may select the language code from a drop-down box, which shows the language code - in
most cases a two-letter ISO 639-1 code - and the corresponding long name. By clicking the 

button you may change the display sequence (see images below).       
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Most of the values are provided by the operating system. Anyway there might be the need to
include additional values, e.g. "eo" for Esperanto. For those cases as a second source
additional language codes may be stored in the application's settings. Finally, language codes
that are present in the database but neither included in the operating system's list nor the
application settings will be included at the end of the selection list with red background, if
neccessary.  

To edit the language codes, click the button and a new window will open (see image
below). The operating system's entries are shown with a light blue background and cannot be
modified. The language codes that are stored in the application settings are shown with white
background and may be edited. To enter a new value, use the empty line at the end of the
table. To delete an entry, mark the whole line by clicking on the row header and press the 
delete key on the keyboard.  
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By clicking OK the changes will be stored in the settings. 
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Summarize data 
Currently the following functions for summarizing data are available: 

Summarize descriptions : Summarize the data of selected descriptions and create a new
one or update an existing description. 

Summarize sample data : Summarize the sample data of selected descriptions and
update their summary data. 

  

Summarizing methods 

Depending on the selected summarizing function either the descriptor data of selected
descriptions or the sampling data of the selected descriptions build the data source.
Summarization of the data is done according their data type. 

  

Categorical summary data 

For building of categorical summary data the single categorical states of the data sources are
accumulated. In general for each states test notes can be entered. To summarize the text
notes, the different notes are accumulated (append in a new line), if they are not yet
included in the summary note. 

If modifier have to be processed, each combination of a categerical state and a modifier will
be treated as separate values. Summarization of notes text will be done separately for each
of these tuples. Only modifiers that are assigned to a descriptor as recommended modifier
(see Editing the descriptor - Descriptor tree tab ) are evaluated, otherwise the modifier values
are ignored. 

Categorical descriptors may be marked as "exclusive", which means that only on state may be
selected. If the approptiate option is set for the summarization, the categorical states that is
most often selected in the source data will be used in the target.  

  

Quantitative summary data 

For building of quantitative summary data from the numeric values of the data sources all
recommended statistical measures (see Editing the descriptor - Descriptor tree tab ) for the
processed descriptor are calculated. Text notes are accumulated for each statistical measure
the same way as described for categorical summary data. 

If modifier have to be processed, all the modifier are accumulated for eache statistical
measure. Since in the resulting quantitative summary data only one modifier value is allowed
for each statistical measure, the most often used modfier is inserted. 

  

Text descriptor data 

To summarize the text descriptor data, the different texts are accumulated (append in a new
line), if they are note yet included in the summary text. Text notes are accumulated in the
same way. 
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Molecular sequence data 

To summarize the moecular sequence data, the different sequences are accumulated (append
in a new line), if they are note yet included in the target sequence. Text notes are
accumulated in the same way. 

  

Statistical measures 

Name Abbr. Calculation 

Lower range limit (human estimate) - x1..xn sorted list: x1 

Upper range limit (human estimate) + x1..xn sorted list: xn 

Central or typical value (human estimate) centr. x1..xn sorted list: xn/2 

Lower range limit (legacy data stat. meth. unknown) -(?) x1..xn sorted list: x1 

Upper range limit (legacy data stat. meth. unknown) +(?) x1..xn sorted list: xn 

Central or typical value (legacy data stat. meth. unknown) centr.(?)
 

x1..xn sorted list: xn/2 

Minimum value Min Absolute smallest value 

Maximum value Max Absolute largest value 

Mean (= average) μ μ=(1/n)∑(n)xi 

Harmonic mean hμ 
hμ=n/(∑(n)(1/xi))
hμ=0 if any xi=0 

Geometric mean gμ gμ=n√∏(n)xi 

Mode mode Value that appears most
often (ambigious!) 

Median med. 

x1..xn sorted list
n odd: med=x(n+1)/2

n even: med=(xn/2+x
(n/2+1))/2 

Interquartile mean (= average) IQM 
x1..xn sorted list
IQM=μ(x0.25n+1..x0.75n+1) 

Variance (sample df = n-1) Var. Sn-1=(1/n-1)∑(n)(xi-μ)2 

Variance (population; df = n; rarely applicable!) Var.
(pop.) Sn=(1/n)∑(n)(xi-μ)2 

Standard deviation (sample) s.d. σn-1=√Sn-1 

Standard deviation (population; df = n; rarely applicable!) s.d.
(pop.) 

σn=√Sn 

Mean deviation m.d. md=(1/n)∑(n)|xi-μ| 

Mean deviation from median m.d.m. mdm=(1/n)∑(n)|xi-med| 

Coefficient of variation (sample) CV CV=σn/μ 

Corrected coefficient of variation (sample) CVC CVC=σn-1/μ 
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Total range TR 
x1..xn sorted list
TR=xn-x1 

Interquartile range IQR 
x1..xn sorted list
IQR=x0.75n+1-x0.25n+1 

Standard error of mean s.e. σx=σn-1/√n 

Standard error of variance (of multiple samples) s.e.(var.
) 

Sx=Sn-1/n 

Skewness Skw. ϒ1=(1/n)∑(n)((xi-μ)/σ)3 

Kurtosis Kurt. Kurt=(1/n)∑(n)((xi-μ)/σ)4 

Sample size n Number of values 
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Summarize description data
With this form you can summarize the information of selected descriptions and store the
summarized data in a new description or update an existing one. After connecting a database
select Edit -> Summarize descriptions ... from the menu.

 

Description selection

 In the first tab Description selection you search for the source descriptions that shall be
summarized into a new or an existing target description (see image below). 

You have to select at least the mandatory parameter Project and start a query with button

. From the result list superfluous entries may be removed with the button. For a
detailled description of the query control please refer to section Query. 

 

Descriptor selection

In tab Descriptor selection select the descriptors that shall be summarized in table column
OK (see image below). You can select rsp. deselect all descriptors with buttons and .
Button inverts all selections. To select all categorical, quantitative, text or sequence
descriptors the buttons , , and are avaiable. With button you may select a
descriptor tree rsp. descriptor tree node to select all descriptors assigned to the selected
element. 
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For quantitative descriptors a statistical measure must be specified where the values for
summarization are available. When the descriptor table is filled, for each quantitative
descriptor the available recommended measures are checked if one of the measures "Mean (=
average)", "Central or typical value (human estimate)", "Central or typical value (legacy data
stat. meth. unknown)", "Mode" or "Sample size" is available (priority in this sequence), it is
pre-selected in colum Measure. You may modify this adjustment for each single descriptor or
use button to change the setting for all selected descriptors.  

 

Generator options

In section Summarize options you may specify to Ignore notes and to Ignore modfier
values of the source descriptions. If you select Restrict exclusive descriptors, the most
often selected categorical state of a "exclusive" descriptor will be set instead of accumulating
all source values. Accumulate scopes will collect all scope values of the source descriptions
in the target. Write item count will enter notes containing information about the number of
collected items in the summary data. If you additionally select Write detailled notes, the
source description IDs will be listed in the notes. Finally, Write summary infomation inserts
a summary about summarized descriptions into the target description details (see image
below). 

In section Target description you may select the Target project (usually the same as the
source description's). You may either create a New description and enter the description
name or Update a description selected form a drop-down list.   

In section Status data you may control the summarization behaviour for every descriptor
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data status value:

 Ignore     
If in a summarized description the corresponding data status is present for a descriptor
value, it will be summarized but the descriptor data status will not be set in the target
description. 

 Summarize 
As for Ignore the descriptor values will be summarized. Additionally the descriptor data
status will be set in the target description.

 Omit data 
If in a summarized description the corresponding data status is present for a descriptor
value, it will not be summarized and the descriptor data status will not be set in the
target description. 

After checking the settings click in button Start generator . During processing the icon of
the button changes to  and you may abort by clicking the button. In the Preview area a
table with the generated rsp. updated target description (coloured background, may be
change with button ) and the summarized source descriptions (grey background) is shown.
If the target description has been modified, this is indicated ba a yellow background of the
description title (see image above). Updated values are shown as blue text. By double-clicking
on a field in the preview table you may view the contents in a separate browser window. To
save the updated values and close the window click the OK button. To exit without saving
click Abort. In this case you will be asked if you want to save modified data. 

Since building the preview table may take some time, especially if a lot of descriptors have
been selected, you may use the button Recalculate for restarting the summary process. In
this case the descriptor columns will not be re-built, only the summary data will be calculated
and actualized. This feature may be useful, if you change some settings an want to update
the data. If you use the Recalculate button with an empty preview table, only the
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description titles will be displayed. Anyway you can view the summarized data using the 
button (see below).

You may store all changed entries by clicking the button or omit all changes and reload the
data by clicking the button. To view the description details of the currently selected entry
click the button and a separate browser window opens (see image below).  
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Summarize sample data
With this form you can summarize the information of selected descriptions and store the
summarized data in a new description or update an existing one. After connecting a database
select Edit -> Summarize sample data ... from the menu.

 

Description selection

 In the first tab Description selection you search for the desriptions that shall be updated
by their summarized sample data (see image below). 

You have to select at least the mandatory parameter Project and start a query with button

. From the result list superfluous entries may be removed with the button. For a
detailled description of the query control please refer to section Query. 

 

Descriptor selection

In tab Descriptor selection select the descriptors that shall be summarized in table column
OK (see image below). You can select rsp. deselect all descriptors with buttons and .
Button inverts all selections. To select all categorical, quantitative, text or sequence
descriptors the buttons , , and are avaiable. With button you may select a
descriptor tree rsp. descriptor tree node to select all descriptors assigned to the selected
element. 
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Generator options

In section Summarize options you may specify to Ignore notes and to Ignore modfier
values of the description's sample data. If you select Restrict exclusive descriptors, the
most often selected categorical state of a "exclusive" descriptor will be set instead of
accumulating all source values. Accumulate scopes will collect all scope values of the
sampling events (geographic areas) and sampling units (specimen) in the description
summary. Write item count will enter notes containing information about the number of
collected items in the summary data. If you additionally select Write detailled notes, the
source description IDs will be listed in the notes. Finally, Write summary infomation inserts
a summary about summarized sampling events into the target description details (see image
below). 

In section Descriptions and sampling events you find the descriptions from the query result
list in tab Description selection and their sampling events. You may exclude single sampling
events or even the whole description form the summarization. In the latter case the
description data will not be changed.   
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After checking the settings click in button Start generator . During processing the icon of
the button changes to  and you may abort by clicking the button. In the Preview area a
table with the updated target descriptions (coloured background, may be change with button 

) and the summarized sampling units (grey background) is shown. If the target description
has been modified, this is indicated ba a yellow background of the description title (see image
above). Updated values are shown as blue text. By double-clicking on a field in the preview
table you may view the contents in a separate browser window. To save the updated values
and close the window click the OK button. To exit without saving click Abort. In this case
you will be asked if you want to save modified data. 

Since building the preview table may take some time, especially if a lot of descriptors have
been selected, you may use the button Recalculate for restarting the summary process. In
this case the descriptor columns will not be re-built, only the summary data will be calculated
and actualized. This feature may be useful, if you change some settings an want to update
the data. If you use the Recalculate button with an empty preview table, only the
description titles will be displayed. Anyway you can view the summarized data using the 
button (see below).

You may store all changed entries by clicking the button or omit all changes and reload the
data by clicking the button. To view the description details of the currently selected entry
click the button and a separate browser window opens (see image below).  
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Generate document
This tool is used to generate a structured documentation of database contents. To use this
tool, start a query and choose Data ->  Generate Document ... from the menu. The
entries of the query result will be passed to the form and depending on the query type
(description or descriptor) different output options will be provided. 

For details check the following pages: 

    Generate a description data document 

    Generate a descriptor data document 

    Generate a project data document 

 

Translations and wording

In most of the forms for document generation a control for adjusting the Export language as
shown below is included. The drop down box always offers an item "(default)" and language
codes for all translation languages available in the database. If you select the default value,
the original labels, details a.s.o. is used in the generated document. If you select a specific
language code, the corresponding tranlated values are exported. If no tranlation is stored in
the database for a specific value, the original value is used instead.  

   

If you select the option Use wording, for descriptions, descriptors and categorical states the
values of the fields "wording" are exported instead of the names. For summary data
additionally the values "wording before" and "wording after", which may be specified for each
descriptor, are inserted before and after the values. If no wording is specified, the original
name is used.     
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Generate a description data document
This tool is used to generate a structured documentation of description data stored in the
database. To use this tool, start a query for descriptions and choose Data ->  Generate
document ... from the menu. A window with will open as shown below.

You may select all entries by clicking the all button, deselect all entries by clicking the 
none button or toggle your selection by clicking the swap button. Choose among the
provided options and click on the button Create ... documentation to create a document in
one of the available formats. 

By default no descriptions will be exported that include any descriptor with data status "Data
withheld". This is indicated by the button in the upper right corner of the window. You may
click on this button to include those descriptions. The button will change to and only the
marked descriptor summary data will be excluded from the document.  

 

HTML

If you create a HTML documentation, a local file named <Database
name>_Description.htm is generated in the application directory, that might be copied and
edited for own purposes. If you select option Include descriptors, the used descriptors are
included at the end of the documents and links to that empedded descriptors are set in the
description section. Otherwise the links are set to the entries specified in the Descriptor file:
text box. By clicking button Select colors you may open a dialog window where you can
select the colors of different elements (see window below). 
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If all descriptions in the selection box belong to the same project and a descriptor tree is
defined, the Descriptor tree: drop-down list is shown in the options (see image below left). If
a descriptor tree is selected and the Structured output keeps activated, the description
data are arranged according the selected descriptor trees. Additionally leading descriptor
name parts are omitted, if they are contained in the descriptor tree hierachy. Therefore
"literature references" becomes to "references" contained in node "Literature" as shown below.
If the selected descriptor tree contains only a subset of descriptors, only this subset will be
displayed in the output. 

If the Structured output option is deactivated, all descriptors will be included in the output in
the standard sequence order. Leading name parts will be reduced if they are already
contained in the tree hierarchy as described in the Editing the description - Continuous view
tab section. With check box Include data titles the output of the titles "State", "Text" and
"Sequence" in the descriptor data can be controlled. If you select Resolve scopes, for each
scope that is linked to a database entry a table with the foreighn database values will be
inserted. To check and adjust the module connections click on button .  

If in the datasets RTF-like formatting tags like \i{} or \sub{} are included, use option
Accept RTF mark-ups as shown in the picture below.  
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MediaWiki

If you create a MediaWiki documentation, you may copy the generated text from the output
window and insert it in the MediaWiki page. With the Layout option you may determine if all
data shall be included in a large table or if several tables with additional header lines shall be
generated (see image below).  

If all descriptions in the selection box belong to the same project and a descriptor tree is
defined, the Descriptor tree: drop-down list is shown in the options (see image below left). If
a descriptor tree is selected and the Restricted option is activated, the description data are
restricted to the descriptors contained in the selected descriptor tree. 
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If the Restriced option is deactivated, all descriptor data will be included in the output in the
standard sequence order. Only name parts of the descriptor tree hierarchy will be included in
the descriptor names as described in the Editing the description - Descriptor view tab
section.  

 

Pensoft content

If you like to publish description data in some online media, e.g. the Pensoft "Biodiversity Data
Journal", the description data are expected in a dedicated Microsoft Excel format. A template
fille as shown below, that includes several tables, is available. DiversityDescriptions allows
generating tabulator separated files for tables "Taxa" and "SpeciesDescriptionMatrix" of that
template.  

If all descriptions in the selection box belong to the same project and a descriptor tree is
defined, the Descriptor tree: drop-down list is shown in the options (see image below). If a
descriptor tree is selected, the description data are arranged with heading according the
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selected descriptor trees. Additionally leading descriptor name parts are omitted, if they are
contained in the descriptor tree hierachy. 

When Ignore data status ist selected, it will not be included in the "CharacterValue" column.
Option Ignore RTF mark-ups will remove RTF-like formatting tags like \i{} or \sub{}. If
option Ignore notes is de-selected, notes will be inserted in the "Remarks" column of the
"SpeciesDescriptionMatrix". 

If you select Resolve scopes and a scope entry for a taxon name is linked to an entry in
DiversityTaxonNames, the corresponding fields of the "Taxa" table will be filled with that data.
To check and adjust the module connections click on button . If scope data for a
geographic area is available, it will be inserted in the "Distribution" column of the "Taxa" table.
  

The results are stored in local files named <Database name>_Taxa.txt and <Database
name>_SpeciesDescriptionMatrix.txt.  
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Generate a descriptor data document
This tool is used to generate a structured documentation of descriptors stored in the
database. To use this tool, start a query for descriptors and choose Data ->  Generate
Document ... from the menu. A window will open as shown below.

You may select all entries by clicking the all button, deselect all entries by clicking the 
none button or toggle your selection by clicking the swap button. Choose among the
provided options and click on the button Create ... documentation to create a document in
one of the available formats. 

 

HTML

If you create a HTML documentation, a local file named <Database name>_Descriptor.htm
is generated in the application directory, that might be copied and edited for own
purposes. By clicking button Select colors you may open a dialog window where you can
select the colors of different elements (see window below). 
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If in the datasets RTF-like formatting tags like \i{} or \sub{} are included, use option
Accept RTF mark-ups as shown in the picture below.  

 

MediaWiki

If you create a MediaWiki documentation, you may copy the generated text from the output
window and insert it in the MediaWiki page. With the Layout option you may determine if all
data shall be included in a large table or if several tables with additional header lines shall be
generated (see image below).  
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Generate a project data document
This tool is used to generate a structured documentation of project related data stored in the
database. To use this tool, start a query for projects and choose Data ->  Generate
Document ... from the menu. A window will open as shown below.

You may select all entries by clicking the all button, deselect all entries by clicking the 
none button or toggle your selection by clicking the swap button. Choose among the
provided options and click on the button Create ... documentation to create a document in
one of the available formats. 

 

HTML

If you create a HTML documentation, a local file named <Database name>_Project.htm is
generated in the application directory, that might be copied and edited for own purposes. By
clicking button Select colors you may open a dialog window where you can select the
colors of different elements (see window below). 
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You have the choice to output additional information besides the basic project data by
selection the options Include descriptor trees, Include descriptor data or Include
applicabilities (see window below). 

 

MediaWiki

If you create a MediaWiki documentation, you may copy the generated text from the output
window and insert it in the MediaWiki page. With the Layout option you may determine if all
data shall be included in a large table or if several tables with additional header lines shall be
generated (see image below).  
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If you specify values in text fields Replace: and by: you can perform text replacements for
Descriptor or Categorical state names in the generated output. By specifying a Prefix: for
a Semantic MediaWiki (see next section) you can generate lokal links to this kind of Wiki
pages. Additionally, you may insert the absolute link adresses by entering the base Wiki
address in the URI: filed.   

 

Semantic MediaWiki

If you create a Semantic MediaWiki documentation, the descriptors, categorical states,
descriptor trees and descriptor applicability information are generated in a format that fits to
terminology platforms as used e.g by TDWG. In this scheme the most important entities are
"Concept" and "Collection". Each "Concept" represents a single descriptor or categorical state
value, which is shown on an own page. Each "Collection" represents a single descriptor tree or
descriptor tree node, which is shown on an own page. The pages are named according the
schema <prefix>:<entity label> [(<number>)], where the <number> parts may be optional,
depending on the Naming: setting (see image below):

 If Opt. order (Optional order) is selected the <number> part is omitted if the name is
unambigious. Otherwise it starts with 1 for the first duplicate and is increased for each
subsequent one to avoid duplicate page names. 

 If Order is selected the <number> starts with 1 and is increased for each subsequent
duplicate to guarantee unambigious page names. 

 If Entity ID is selected the <number> contains the database internal ID of each entry
to guarantee unambigious page names. 
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The Cardinality option includes information about multiple occurance and the mandatory
property in the descriptor concepts. By selecting the Include trees option the descriptor
trees and the tree structure will be included as collections where subordinated tree nodes are
represented by concatenated node names, e.g. <prefix>:<Tree name>.<Node 1 name>.<Node
2 name>. If you specify values in text fields Replace: and by: you can perform text
replacements for Descriptor or Categorical state names in the generated output. 

If Generate: XML for Wiki import is selected, the output is generated in an XML format that
may be imported to a semantic media wiki. To show all generated data, the two templates
"dwb_Descriptor" and "dwb_CategoricalState" must be inserted in the wiki. 

If Generate: XSD/XML document is selected, an XML schema (XSD) is generated in the
main window. If schema generation was ended without problems, a selection list will be shown
where description items for the XML document may be selected. For the selected descriptions
an XML document structured according the XSD will be shown in a separate window. By
default no descriptions will be exported that include any descriptor with data status "Data
withheld". This is indicated by the button in the upper right corner of the window. You may
click on this button to include those descriptions. The button will change to and only the
marked descriptor summary data will be excluded from the document. 

 

Descriptor applicability

The descriptor applicability tree shows the selected projects and as subordinated nodes the
categorical descriptors that control the applicability of dependent descriptors. Contained in
the controlling descriptor are their categorical states and the dependent descriptors with
the applicability rule "applicable-if" or "inapplicable-if" . The descriptor names are prefixed
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with their sequence number in square brackets, the states with the descriptor's sequence
number and their own. 

If you create a applicability tree documentation, two local tabulator-separated text files are
generated. The first file named <Database name>_ApplicabilityNodes.txt contains the
node list with columns "Id", "Label" and "Modularity class" ("Project", "Descriptor" or "State").
The second file named <Database name>_ApplicabilityEdges.txt contains the edges list
with columns "Source", "Target" and "Label" ("Includes" for project-descriptor relations,
"Contains" for descriptor-state relations or "Applicable" rsp. "Inapplicable" for state-descriptor
relations). You may import those files to a graphic program like "Gephi"  to visualize the
descriptor applicabilities. 

By selecting the option Convert to applicable rule or Convert to inapplicable rule the
applicability settings stored in the database can be converted to the required complatible
format (see image below). 
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Import / Export
An overview of some options for the import, export and additional file based operations is
given in the image below. The import wizard provides a very flexible tool to import data from
tab-separated text files, e.g. generated from a foreighn tool or database. With the list export
you may generate tab-separated text files from the database. The export and re-import of
tab-separated list allows external editing of the data in e.g. spread sheet programs. For this
purpose especially the Matrix wizard is very suitable. As an alternative the questionnaires
allow editing of data in an HTML form, which can be done with any internet browser. The
modified data can be "downloaded" as text files and re-imported into the database. Even new
description data may be collected using the questionnaires without the need of a direct
database access. 

The CSV export provides a direct copy of selected database tables by means of the Microsoft
SQL Server. These copies might be used for archiving purposes or if a foreighn application
shall be supplied with data. 

The most popular genuine formats for storing and exchanging descriptive data are DELTA and
SDD, which are both supported for import and export. The structured export additionally
allows generation of EML files, that provide metadata as XML and descriptive data as text
table. A spin-off of the import and export functions for structured data is the file conversion,
which may even be used without any database access. Additionally the SDD and EML
structured XML files may be checked for conformance to their XML schemas.  

Finally the cache database is providing descriptive data to external partners, e.g. a
webportal.  
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Import
There are several import mechanisms: 

Matrix wizard: Import descriptors, descriptions and sample data from tabulator separated
text file(s) organized as a matrix. 

Import wizard: Import descriptive data from tabulator separated text file(s). 

SDD import: Import descriptive data from an XML file according to the SDD schema 1.1 rev
5. 

DELTA import: Import descriptive data from DELTA text file(s). 

Import questionaires: Import revised data received from HTML forms. 
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Matrix import wizard for tab separated lists
The table oriented import wizard works fine if you have separate lists for descriptor and
description data. Usually this type of tables is generated by an export of data from a
database. A typical example for that cases is described in the import wizard tutorial. If no
dedicated application for collecting description data is available, most commonly a
spreadsheet program like MS Excel or Open Office Calc is used to collect the description data.
Typically the table columns represent a single character (=descriptor) and the table rows
represent the items (=description or sample data). Importing data from such a "matrix" into
Diversity Descriptions with the table oriented import wizard usually requires a lot of manual
adaptions. Therefore the specialized "Matrix Wizard" was designed to import the most
important descriptor and description data in a single import step.  

As usual you should create a new project and install a descriptor tree to collect the dedicated
descriptors. Then choose Data -> Import -> Import wizard -> Matrix wizard ...
from the menu. As know from the import wizard, a window to create or select a import session
will be shown. 

 

After selecting or creating an import session a window as shown below will open that will lead
you through the import of the data.  
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With the selection box Target: you may select which data shall be imported: 

  Select Description to import summary data 
  Select Sampling event to import sample data

Remark: Example files and XML schemas to import summary or sample data using the matrix
wizard may be downloaded from the Diversity Descriptions example file repository. 

Page 251

https://github.com/SNSB/DWB-Contrib/tree/master/DiversityDescriptions/Import/Schemas/BEFCHINAhlpbiomass


Matrix import wizard for description data
After selecting Target: Description a window as shown below will be displayed. The window
is separated in three areas. On the left side you see the descriptor settings for the actual file
column (presently not visible). On the right side you see the list of available import steps. In
the middle part the details of the selected import steps are shown. 

 

Choosing the File 

As a first step, choose the File from where the data should be imported. The currently
supported format is tab-separated text. Then choose the Encoding of the file, e.g. Unicode. 
The Header lines specifies the number of header lines, usually at least the first line which
typically contains the descriptor names (see image below). The Start line and End line will
automatically be set according to your data. You may change these to restrict the data lines,
i.e. the descriptions/items that shall be imported. The not imported parts in the file are
indicated with a gray background. If your data contains e.g. date information or floating point
values where notations differ between countries (e.g. 3.14 - 3,13), choose the Language /
Country to ensure a correct interpretation of your data. Finally you can select a prepared
Schema (see sections Testing and Import below) for the import. 
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Choosing the descriptor types

In the first line of the file section the descriptor type of the file columns are displayed. The
value Ignore indicates that the column shall not be imported. To adjust the descriptor type,
select a cell in the file column and chose a Descriptor type in the left section of the panel
(see image below). Available descriptor types are Categorical, Quantitative, Text and
Sequence.

Page 253



For categorical descriptors you may specify State splitters, if one item has more than one
categorical state. To add a splitter click on the button, to remove it use the button. By
clicking the Test states button you get a list of categorical states found in the file
between start line and end line and the number of occurrences (field Count, see image
above). With this function you may test the effect of the state splitters. 

For quantitative descriptors you have to specify the Statistical measure that shall be
used for the imported values. By clicking the Test values button you get a list of values in
the file between start line and the line number in the file (see image above). 
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If a value cannot be interpreted as a number, it is marked with a light red background colour.
You may edit the erroneous values in the test result panel (see below).

For text and sequence descriptors no additional adjustments are possible. As long as no
descriptor columns have been defined, a reminder is visible on top of the left section:

 Please select a descriptor type   = At least for one file column a descriptor type is
needed.

In our example column 1 (date) will be adjusted as text descriptor and columns 2 (functional
group) and 3 (sublocation) as categorical descriptors.

 

Table data 

To set the source for the data columns, select the step of a table listed underneath the File
step. Be aware that for the Descriptor table not the file columns will be selected but the
file rows in the header lines. In the image below you see an example of the descriptor data
columns, where the values for id and label are taken from the first line in the file. Additionally
the descriptors will be assigned to the descriptor tree "Descriptor tree for matrix".  
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Remark: Although descriptortree_id is a numeric value in the database, the externally visible
descriptor tree name is expected here. Since this name is unambigious, the corresponding id
will be determined during import. 

The option Address index allows the selection of the column number (for descriptor) rsp. the
line number (for description) as value. See below an example for the Description table
data columns. For id the line number has been selected to get an unambigious address value.
The label has been composed of the line number, three data columns and some fixed text
parts. Finally all description data are assigned to the project "Matrix text". 

Remark: Although project_id is a numeric value in the database, the externally visible project
name is expected here. Since this name is unambigious, the corresponding id will be
determined during import. 

A reminder in the header line will show you what actions are still needed to import the data
into the table:

 Please select at least one decisive column   = If data will be imported depends on the
content of decisive colums, so at least one must be selected.

 Please select the position in the file   = The position in the file must be given if the
data for a column should be taken from the file. 

 From file or For all   = For every you have to decide whether the data are taken from
the file or a value is entered for all

 Please select a value from the list   = You have to select a value from the provided
list 

The handling of the columns is almost the same as described in the chapter columns of the
table oriented import wizard. 

 

Testing 

To test if all requirements for the import are met use the Testing step. You can navigate to
a certain data cell by using the Column: and Line: controls. As an alternative select the data
cell ent click on button . Finally click on the Test data button. If there are still unmet
requirements, these will be listed in a window as shown below. In the window below you can
see the following test actions:

1. Insert of a quantitative descriptor "biomass" 
2. Insert of a descriptor tree node (assignemnt to tree "Matrix test tree")
3. Insert of a recommended statistical measure (measure "Mean") for the descriptor tree

node
4. Insert of description "Biomass 3 [CSP01 woody NW_c]" for project "Matrix test"
5. Insert of a statistical measure for "Mean" with value 28.2020000...
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You may save the schema file by a click on button Save schema. If you click on button
Generate flat files according to your adjustments data and matching schema files for the
table oriented import wizards will be generated. This option may be used, if you want to
import additional data, e.g. a descriptor's measurement unit, that are not supported by the
matrix wizard. Since all mapping relevant data are stored in the selected import session, you
may import the basic descriptor and description data using the matrix wizard and append
additional data with the table oriented import wizards. In this case the generated flat data
and schema files might be useful to have a defined starting point.    

 

Import 

With the last step you can finally start to import the data into the database. If you want to
repeat the import with the same settings and data of the same structure, you can save a
schema of the current settings (see below). 
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Schedule for matrix import of tab-separated text files into
DiversityDescriptions 
Target within DiversityDescriptions: Description 

Schedule version: 1 Database version: 03.00.17 
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File cells that could not be imported will be marked with a red background while imported lines
are marked green. If you want to save lines that produce errors during the import in a
separate file, use the Save failed lines option. The protocol of the import will contain all
settings acording to the used schema and an overview containing the number of inserted,
updated, unchanged and failed lines (see below). 

Protocol
Responsible: Link (DB-User: Workshop) 

Date: Donnerstag, 20. April 2017, 15:53:24 
Server: training.diversityworkbench.de 

Database: DiversityDescriptions_Workshop 
Descriptor columns total: 5 

Descriptors imported: 5 
Import lines total: 756 

Descriptions imported: 756 
Cells imported: 3780 
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Matrix import wizard for sample data
After selecting Target: Sampling event a window as shown below will be displayed. The
window is separated in 3 areas. On the left side you see the descriptor settings for the actual
file column (presently not visible). On the right side you see the list of available import steps.
In the middle part the details of the selected import steps are shown. 

 

Choosing the File 

As a first step, choose the File from where the data should be imported. The currently
supported format is tab-separated text. Then choose the Encoding of the file, e.g. Unicode. 
The Header lines specifies the number of header lines, usually at least the first line which
typically contains the descriptor names (see image below). The Start line and End line will
automatically be set according to your data. You may change these to restrict the data lines,
i.e. the descriptions/items that shall be imported. The not imported parts in the file are
indicated with a gray background. If your data contains e.g. date information or floating point
values where notations differ between countries (e.g. 3.14 - 3,13), choose the Language /
Country to ensure a correct interpretation of your data. Finally you can select a prepared
Schema (see sections Testing and Import below) for the import. 
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Choosing the descriptor types

Choosing of the descriptor types is done in exactly the same way as described in section 
Matrix wizard for description data.

 

Table data 

To set the source for the data columns, select the step of a table listed underneath the File
step. Be aware that for the Descriptor table not the file columns will be selected but the
file rows in the header lines. In the image below you see an example of the descriptor data
columns, where the values for id and label are taken from the first line in the file. Additionally
the descriptors will be assigned to the descriptor tree "Descriptor tree for matrix".  

Remark: Although descriptortree_id is a numeric value in the database, the externally visible
descriptor tree name is expected here. Since this name is unambigious, the corresponding id
will be determined during import. 
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The option Address index allows the selection of the column number (for descriptor) rsp. the
line number (for description or sampling event) as value. See below an example for the 
Description table data columns. For id and label the For all:  alue "++ New description ++"
was selected to create a single description entry where all sample data are attached. Finally
the description is assigned to the project "Matrix text sample". 

Remark: Although project_id is a numeric value in the database, the externally visible project
name is expected here. Since this name is unambigious, the corresponding id will be
determined during import. 

Finally the source for the Sampling event table data columns must be selected. For id and
label the file column 0 has been selected (see image below). 

A reminder in the header line will show you what actions are still needed to import the data
into the table:

 Please select at least one decisive column   = If data will be imported depends on the
content of decisive colums, so at least one must be selected.

 Please select the position in the file   = The position in the file must be given if the
data for a column should be taken from the file. 

 From file or For all   = For every you have to decide whether the data are taken from
the file or a value is entered for all

 Please select a value from the list   = You have to select a value from the provided
list 

The handling of the columns is almost the same as described in the chapter columns of the
table oriented import wizard. 

 

Testing 

To test if all requirements for the import are met use the Testing step. You can navigate to
a certain data cell by using the Column: and Line: controls. As an alternative select the data
cell ent click on button . Finally click on the Test data button. If there are still unmet
requirements, these will be listed in a window as shown below. In the window below you can
see the following test actions:

1. Insert of a quantitative descriptor "Channel 2 VLT Us1G" 
2. Insert of a descriptor tree node (assignemnt to tree "Tree for matrix test sample")
3. Insert of a recommended statistical measure (measure "Mean") for the descriptor tree

node
4. Insert of description "++ New description ++" for project "Matrix test sample"
5. Insert of a sampling event "30.01.2014 22:00" for description "++ New description ++"
6. Insert of a sampling unit with id 199 for sampling event "30.01.2014 22:00"
7. Insert of a quantitative value -22.72 to sampling unit 199
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You may save the schema file by a click on button Save schema. If you click on button
Generate flat files according to your adjustments data and matching schema files for the
table oriented import wizards will be generated. This option may be used, if you want to
import additional data, e.g. a descriptor's measurement unit, that are not supported by the
matrix wizard. Since all mapping relevant data are stored in the selected import session, you
may import the basic descriptor and description data using the matrix wizard and append
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additional data with the table oriented import wizards. In this case the generated flat data
and schema files might be useful to have a defined starting point.    

 

Import 

With the last step you can finally start to import the data into the database. If you want to
repeat the import with the same settings and data of the same structure, you can save a
schema of the current settings (see below). 

Schedule for matrix import of tab-separated text files
into DiversityDescriptions 
Target within DiversityDescriptions: SamplingEvent 
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File cells that could not be imported will be marked with a red background while imported lines
are marked green. If you want to save lines that produce errors during the import in a
separate file, use the Save failed lines option. The protocol of the import will contain all
settings acording to the used schema and an overview containing the number of inserted,
updated, unchanged and failed lines (see below). 

Protocol
Responsible: Link (DB-User: Workshop) 

Date: Donnerstag, 20. April 2017, 16:17:42 
Server: training.diversityworkbench.de 

Database: DiversityDescriptions_Workshop 
Descriptor columns total: 44 

Descriptors imported: 44 
Import lines total: 147 

Descriptions imported: 1 
Samples imported: 147 

Cells imported: 6348 
Cells failed: 120 
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Import wizard for tab separated lists
With this import routines, you can import data from text files (as tab-separated lists) into the
database. For a comprehensive real-life example that shows many features of the import
wizard take a look at the import wizard tutorial.  

Choose Data -> Import ->  Import wizard and then the type of data that should be
imported, e.g. Import descriptors ... from the menu. If you did not use the import wizard
before, the following window is shown to create a new import session. 

 

In section Session project the projects with write access are listed for selection. In section
Session description you should enter a detailled text description. If already an import
session is present in the database, the window below will be shown where you may select the
session. You may select one of the offered sessions or create a new one by selecting Create
new import session.  
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After selecting or creating an import session a window as shown below will open that will lead
you through the import of the data. The window is separated in 3 areas. On the left side you
see a list of possible data related import steps according to the type of data you choosed for
the import. On the right side you see the list of currently selected import steps. In the middle
part the details of the selected import steps are shown. 
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Choosing the File 

As a first step, choose the File from where the data should be imported. The currently
supported format is tab-separated text. Then choose the Encoding of the file, e.g. Unicode.
The Start line and End line will automatically be set according to your data. You may change
these to restrict the data lines that should be imported. The not imported parts in the file are
indicated as shown below with a gray background. If the First line contains the column
definition this line will not be imported as well. If your data contains e.g. date information or
floating point values, where notations differ between countries (e.g. 3.14 - 3,14), choose the 
Language / Country to ensure a correct interpretation of your data. Finally you can select a
prepared Schema (see chapter Schema below) for the import. 
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Choosing the data ranges

In the selection list on the left side of the window (see below) all possible import steps for the
data are listed according to the type of data you want to import.

Certain tables can be imported in parallel. To add parallels click on the button (see below).
To remove parallels, use the button. Only selected ranges will appear in the list of the steps
on the right (see below).
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To import information of logging columns like who created and changed the data, click on 
button in the header line. This will include an additional substeps for every step containing the
logging columns (see below). If you do not import these data, they will be automatically filled
by default values like the current time and user.

 

Attaching data 

You can either import your data as new data or Attach them to data in the database.
Select the import step Attachment from the list. All tables that are selected and contain
columns at which you can attach data are listed (see below). Either choose the first option 
Import as new data or one of the columns the attachment columns offered like "id" in the
table "Descriptor" in the example below. 
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If you select a column for attachment, this column will be marked with a blue backgroud (see
below and chapter Table data).

 

Merging data 

You can either import your data as new data or Merge them wih data in the database.
Select the import step Merge from the list. For every table you can choose between 
Insert, Merge, Update and Attach (see below). 

The Insert option will import the data from the file independent of existing data in the
database. 

The Merge option will compare the data from the file with those in the database according
to the Key columns (see below). If no matching data are found in the database, the data
from the file will be imported, otherwise the data will be updated.. 

The Update option will compare the data from the file with those in the database according
to the Key columns. Only matching data found in the database will be updated. 

The Attach option will compare the data from the file with those in the database according
to the Key columns. The found data will not be changed, but used as a reference data in
depending tables.  

 

Table data 

To set the source for the columns in the file, select the step of a table listed underneath the
Merge step. Some columns may be grouped below the table name as shown for the 
Descriptor table. 

Click on one of the subordinated column groups and in the central part of the window the data
columns avaialble for importing will be listed in the central part of the window. In the example
shown below the column is used to attach the new data to data in the database. 
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All columns that have not been grouped beneath the table may be accessed by selecting the
table ste itself. In the example shown below table Descriptor was selected to supply the
"data_entry_note" column for import.

A reminder in the header line will show you what actions are still needed to import the data
into the table:

 Please select at least one column   = No column has been selected so far. 
 Please select at least one decisive column   = If data will be imported depends on the

content of decisive colums, so at least one must be selected.
 Please select the position in the file   = The position in the file must be given if the

data for a column should be taken from the file. 
 Please select at least one column for comparision   = For all merge types other than

insert columns for comparision with data in the database are needed.
 From file or For all   = For every you have to decide whether the data are taken from

the file or a value is entered for all
 Please select a value from the list   = You have to select a value from the provided

list 
 Please enter a value   = You have to enter a value used for all datasets 

The handling of the columns in described in the chapter columns. 

 

Testing 

To test if all requirements for the import are met use the Testing step. You can use a
certain line in the file for you test and than click on the Test data in line: button. If there are
still unmet requirements, these will be listed in a window as shown below. 
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If finally all requirements are met, the testing function will try to write the data into the
database and display you any errors that occurred as shown below. All datasets marked with
a red backgroud, produced some error.  

To see the list of all errors, double click in the error list window in the header line (see below).
 

If finally no errors are left, your data are ready for import. The colors in the table nodes in the
tree indicate the handling of the datasets: INSERT, MERGE, UPDATE, No difference. Attach,
No data. The colors of the table colums indicate whether a colums is decisive , a key column
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or an attachment column.  

If you suspect, that the import file contains data allready present in the database, you may
test this an extract only the missing lines in a new file. Choose the attachment column (see
chapter Attaching data) and click on the button Check for allready present data. The data
allready present in the database will be marked red (see below). Click on the button Save
missing data a text file to store the data not present in the database in a new file for the
import.  

If you happen to get a file with a content as shown below, you may have seleted the wrong
encoding or the encoding is incompatible. Please try to save the original file as UTF8 and
select this encoding for the import.  
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Import 

With the last step you can finally start to import the data into the database. If you want to
repeat the import with the same settings and data of the same structure, you can save a
schema of the current settings (see below). 

Schedule for import of tab-separated text files into
DiversityCollection 
Target within DiversityCollection: Specimen 

Schedule version: 1 Database version: 02.05.41 

Lines: 2 - 3215 First line contains
column definition: ? 

Encoding: Unicode Language: de 
 

Tables

CollectionSpecimen (CollectionSpecimen) 
Parent: CollectionEvent
Merge handling: Insert
Column in table 

? Ke
y 

Co
py 

Pr
e 

Po
st 

Fil
e
po
s. 

Tr
an
sfo
rm
ati
on
s 

Va
lue
 

So
urc
e 

Ta
ble
 

CollectionSpecimenID Dat
ab
as
e 

AccessionNumber ? ? 0 Fil
e 

IdentificationUnit_1 (IdentificationUnit) 
Parent: CollectionSpecimen
Merge handling: Merge
Column in table ? Ke

y 
Co
py 

Pr
e 

Po
st 

Fil
e
po
s. 

Transformations Value Source Table 

CollectionSpecimenID Database 
IdentificationUnitID Database 
LastIdentificationCach
e 

? 2 File 

+ 3 File 

+ 4 File 

+ 5 File 

TaxonomicGroup ? fish Interface 

IdentificationUnitAnalysis_1_1 (IdentificationUnitAnalysis) 
Parent: IdentificationUnit_1
Merge handling: Update
Column in table ? Ke

y 
Co
py 

Pr
e 

Po
st 

Fil
e
po
s. 

Transformations Value Source Table 

CollectionSpecimenID Database 
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IdentificationUnitID Database 
AnalysisID 94 Interface 
AnalysisNumber 1 Interface 
AnalysisResult ? ? 39 File 

 Lines that could not be imported will be marked with a red background while imported lines
are marked green (see below).

If you want to save lines that produce errors during the import in a separate file, use the 
Save failed lines option. The protocol of the import will contain all settings acording to the
used schema and an overview containing the number of inserted, updated, unchanged and
failed lines (see below).

 

Description 

A description of the schema may be included in the schema itself or with a click on the 
button generated as a separate file. This file will be located in a separate directory Description
to avoid confusion with import schemas. An example for a description file is shown below,
containing common settings, the treatment of the file columns and interface settings as
defined in the schema.

Schedule for import of tab-separated text files into DiversityCollection 
Target within DiversityCollection: Specimen 
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Schedule version: 1 

Databa
se

version
: 

02.05.
52 

Lines: 2 - 5 

First
line

contai
ns

colum
n

definiti
on: 

? 

Encoding: Unicode Langu
age: 

de 

Description: Import Schema fuer Literaturdaten (Bayernflora) aus Dörr &
Lippert mit MTB Daten und max. 4 Sammlern 

 

File columns

Merge
handling of

table 

Column
usage 

Ins
ert 

Me
rge
 

Up
dat
e 

Att
ac
h 

Dec
isiv
e 

Key
 

Pos. Nam
e 

Tabl
e 

Column Example Transformed 

0 ID 
CollectionS

pecimen. 
ExternalI
dentifier 

1 

1 originalname 
Identificatio

n_1_2. 
Taxonom
icName 

Ophioglossum vulgatum 

2 nameautor 
Identificatio

n_1_1. 
Taxonomi
cName 

Ophioglossum vulgatum L. 

3 taxnr 
Identificatio

n_1_1. 
NameURI
 

3949 

Prefix: http://tnt.diversityw orkbench.de/TaxonNames_Plants/ 

4 mtb 
CollectionE
ventLocalis

ation_6. 

Location
1 

8423 

5 qu 
CollectionE
ventLocalis

ation_6. 

Location
2 

2 

6 unschärfe 
CollectionE
ventLocalis

ation_6. 

Location
Accuracy
 

7 jahr_von 
CollectionE

vent. 
Collectio
nYear 

1902 

8 jahr_bis 
CollectionE

vent. 
Collectio
nDateSu
pplement
 

Prefix: bis? 
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9 status 
Identificatio

nUnitAnalys
is_1_1. 

Analysis
Result 

10 

verwa
ltung
seinh
eit 

not imported 

11 fundo
rt 

not imported 

12 finder
 

not imported 

13 ID_collector1 
CollectionA

gent_1. 
Collector
sAgentU
RI 

43708 

Prefix: http://snsb.diversityw orkbench.de/Agents_BayernFlora/ 

14 ID_collector2 
CollectionA

gent_2. 
Collector
sAgentU
RI 

Prefix: http://snsb.diversityw orkbench.de/Agents_BayernFlora/ 

15 ID_collector3 
CollectionA

gent_3. 
Collector
sAgentU
RI 

Prefix: http://snsb.diversityw orkbench.de/Agents_BayernFlora/ 

16 ID_collector4 
CollectionA

gent_4. 
Collector
sAgentU
RI 

Prefix: http://snsb.diversityw orkbench.de/Agents_BayernFlora/ 

17 
primä
rquell
e 

not imported 

18 ID_primärquelle 
Annotation_

1. 
Referenc
eURI 

Prefix: http://id.snsb.info/references/ 

19 

primä
rquell
e_sei
ten 

not imported 

20 bestand 
Identificatio

nUnitAnalys
is_1_2. 

Analysis
Result 

21 sonstiges 
CollectionS

pecimen. 
OriginalNo
tes 

22 höhe 
CollectionE
ventLocalis

ation_7. 

Location
1 

23 herba
r1 

not imported 

24 herba
r2 

not imported 
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25 herba
r3 

not imported 

26 ID_herbar1 
CollectionS
pecimenRel

ation_1. 

RelatedS
pecimen
Collectio
nID 

27 ID_he
rbar2 

not imported 

28 ID_he
rbar3 

not imported 

29 det not imported 

30 ID_de
t 

not imported 

31 rev not imported 

32 ID_re
v 

not imported 

33 
daten
quelle
 

not imported 

34 ID_datenquelle 
CollectionS

pecimen. 
Referenc
eURI 

135 

Prefix: http://id.snsb.info/references/ 

35 proje
ct1 

not imported 

36 project2 
CollectionS

pecimen. 
Additional
Notes 

O Beobachtung 

Transform
ations: 

Reglar express.: 

O ? Beobachtu
ng 

Reglar express.: 

H ? Herbaraus
w ertung 

Reglar express.: 

L ? Literaturau
sw ertung 

Interface settings
Table Table alias Column Value 

Annotation Annotation_1 AnnotationType Reference 

Annotation_1 Annotation Literaturauswertung: nach
Dörr & Lippert (2004) 

Annotation_1 ReferenceDisplayText Annotation 
CollectionAgent CollectionAgent_1 CollectorsName Collector1 

CollectionAgent_2 CollectorsName Collector2 
CollectionAgent_3 CollectorsName Collector3 
CollectionAgent_4 CollectorsName Collector4 

CollectionEvent CountryCache Germany 
CollectionProject CollectionProject_1 ProjectID 37 

CollectionProject_2 ProjectID 149 
CollectionSpecimen ReferenceTitle Reference 
CollectionSpecimenRelatio
n 

CollectionSpecimenRelatio
n_1 

RelatedSpecimenURI 

CollectionSpecimenRelatio
n_1 

RelatedSpecimenDisplayT
ext 

CollectionSpecimenRelatio
n_1 

Notes Herbarauswertung: nach
Dörr & Lippert (2004) 
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Identification Identification_1_1 IdentificationSequence 2 
Identification_1_2 IdentificationSequence 1 

Identification_1_2 Notes Originalname aus Dörr &
Lippert (2004) 

IdentificationUnit IdentificationUnit_1 LastIdentificationCache plant 
IdentificationUnit_1 TaxonomicGroup plant 

IdentificationUnitAnalysis IdentificationUnitAnalysis_
1_1 

AnalysisID 2 

IdentificationUnitAnalysis_
1_1 

AnalysisNumber 1 

IdentificationUnitAnalysis_
1_2 

AnalysisID 4 

IdentificationUnitAnalysis_
1_2 

AnalysisNumber 2 
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Import wizard - Columns 

If the content of a file should be imported into a certain column of a table, mark it with the 
checkbox. 

 

Decisive columns 

The import depends upon the data found in the file where certain columns can be choosed as
decisive, that means only those lines will be imported where data are found in any of these
columns. To mark a column as decisive, click on the icon at the beginning of the line (see
below).

In the example shown below, the file column Organims 2 was marked as decisive. Therefore
only the two lines containing content in this column will be imported. 

 

Key columns 

For the options Merge, Update and Attach the import compares the data from the
file with those already present in the database. This comparision is done via key columns.
To make a column a key column, click on the icon at the beginning of the line. You can
define as many key columns as you need to ensure a valid comparision of the data.

 

Source 

The data imported into the database can either be taken From file or the same value that
you enter into the window or select from a list can be used For all datasets. If you choose
the From file option, a window as shown below will pop up. Just click in the column where the
data for the column should be taken from and click OK (see below).
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If you choose the For all option, you can either enter text, select a value from a list or use
a checkbox for YES or NO.

 

Transformation 

The data imported may be transformed e.g. to adapt them to a format demanded by the
database. For further details please see the chapter Transformation. 

 

Copy 

If data in the source file are missing in subsequent lines as shown below, 

you can use the Copy line option to fill in missing data as shown below where the blue
values are copied into empty fields during the import. Click on the button to ensure that
missing values are filled in from previous lines. 
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Prefix and Postfix 

In addition to the transformation of the values from the file, you may add a pre- and a postfix.
These will be added after the transfromation of the text. Double-click in the field to see or
edit the content. The pre- and a postfix values will only be used, if the file contains data for
the current position. 

For the datatype geography the pre- and postfixes will be automatically set to enable the
import. The preset values by default are set for points as geographical units. You may change
this to predefined types like lines or areas. Click on the button at the end of the line to
open the information window. Here you can choose among the types mentioned above (see
below).  

 

Column selection 

If for any reason, a column that should take its content from the imported file misses the
position of the file or you want to change the position click on the button. In case a
position ist present, this button will show the number of the column. A window as shown
below will pop up where you can select resp. change the position in the file. 

 

Multi column 

The content of a column can be composed from the content of several columns in the file. To
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add additional file columns, click on the button. A window as shown below will pop up,
showing you the column selected so far, where the sequence is indicated in the header line.
The first colum is marked with a blue background while the added columns are marked with a
green background (see below). 

To remove a added column, use the button (see below). 

 

Information 

The button opens a window displaying the informations about the column. For certain
datatypes additional options are included (see Pre- and Postfix). 
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Import wizard - transformation 

The data imported may be transformed e.g. to adapt them to a format demanded by the
database. Click on the button to open a window as shown below. 

Here you can enter 4 types of transformation that should be applied to your data. Cut out
parts,  Translate contents from the file, RegEx apply regular expressions or Replace text
in the data from the file. All transformations will be applied in the sequence they had been
entered. Finally, if a prefix and/or a postfix are defined, these will be added after the
transformation. To remove a transformation, select it and click on the button. 

 

Cut 

With the cut transformation you can restrict the data taken from the file to a part of the
text in the file. This is done by splitters and the position after splitting. In the example below,
the month of a date should be extracted from the information. To achieve this, the splitter '.'
is added and than the position set to 2. You can change the direction of the sequence with
the button Seq starting at the first position and starting at the last position. Click on the
button Test the transformation to see the result of your transformation. 
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Translate 

The translate transformation translates values from the file into values entered by the user.
In the example above, the values of the month cut out from the date string should be
translated from roman into numeric notation. To do this click on the button to add a
translation transformation (see below). To list all different values present in the data, click on
the button. A list as shown below will be created. You may as well use the and 
buttons to add or remove values from the list or the button to clear the list. Than enter the
translations as shown below. Use the save button to save entries and the Test the
transformation button to see the result.  

Page 292



To load a predefined list for the transformation use the button. A window as shown below
will open. Choose the encoding of the data in you translation source, if the first line contains
the column definition and click on the  button to open a file. Click OK to use the values from
the file for the translation. 

 

Regular expression 

The transformation using regular expressions will transform the values according to the
entered Regular expression and Replace by vales. For more details please see
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documentations about regular expressions. 

 

Replacement 

The replacement transformation replaces any text in the data by a text specified by the user.
In the example shown below, the text "." is replaced by "-".  

 

Calculation  

The calculation transformation performs a calculation on numeric value, dependent on an
optional condition. In the example below, 2 calculations were applied to convert 2-digit values
into 4 digit years. 
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Filter  

The filter transformation compares the values from the file with a value entered by the user.
As a result you can either Import content of column in file or Import a fixed value.
To select another column that should be compared, click on the button and choose a
column from the file in the window that will open. If the column that should be compared is
not the column of the transformation, the number of the column will be shown instead of the 

symbol. To add further filter conditions use the button. For the combination of the
conditions you can choose among AND and OR.  
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Import sessions
Usually the information required for an import into DiversityDescriptions is spread over at least
two files, e.g. "terminology" (descriptors/categorical states) and "items" (descriptions data),
where the elements of the terminology are referenced to build the item descriptions. Between
these files references are usually built using e.g. a descriptor number and/or the categorical
state name. Within the DiversityDescriptions database relations are built using automatically
generated numbers ("id"). To allow a mapping between the internally generated keys and the
external keys, the "Import sessions" are used. 

When you start the import wizard you are asked to select rsp. create a new import session.
To ge an overview of the present import session or to create, edit and delete import sessiong
select Data -> Import ->  Wizard -> Organize sessions ... and a window as shown
below will be shown. 

Click buttoem New and a window as shown below will be shown. Select the project of the
import session and enter a description text. So save the new import session click Save ,to
ignore the changes click button Don't save. A similar window can be opened by selecting
an existing import session and clicking Edit.  
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To delete an import session, select it and click the Delete button. If import mapping data
are present for the import session, an additional window will be shown that informs you about
the number of mappings that will be implicitelx deleted and you have the chance to cancel the
delete process (see below). 
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Import mapping 

To view the mapping information that has been stored for an import session, select it and click
the Mapping button. If import mapping data are present for the import session, a table
with the database "Table name", an optional "Parent key", e.g. the descriptor id in case of
categorical states, the "External key" used for import and the database interal key, the
"Object ID", is displayed (see below). To go back to the session overview, click the 
Session button.  

Page 299



You may search for specific strings in the mapping table by entering the search string in the
upper right text box and clicking the  button. Menu item Clear mapping allows clearing
of mapping information for selected tables or all tables. With menu item Import mapping
an import wizard can be opened to read the mapping information from tab-separated files. A
detailled example for using the mapping import is shown in Import wizard - tutorial for
advanced functions.   

If you want to import list data that include the internal database keys, you can generate
mapping data that make these internal keys available for import by klicking menu item 
Generate mapping .... All mappings of the selected import session will be deleted and the
internal keys ("Object ID") of descriptors, categorical states, descriptions and their resources
will be inserted as external keys. By using this function you can re-import rsp. update data
that have been generated with the form Export resource data list and modified with an
external program.  
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Import wizard - tutorial
This tutorial demostrates the import of descriptors and descriptions from two tabulator
separated files into the database. The original data were stored in an MS-Excel sheet with
data from an agricultural survey. The first table contains a list of questions and data like
expected type of the answer, possible values and the measurement unit in case of numeric
values (see image below). 

The second table contains the answers of three individuals that are identified by a numeric
value (see image below). 

By using the option "Save as unicode text" the tables can easily be exported as tabulator
separated text files ("Survey_Questions.txt" and "Survey_Answers.txt"). The import is done in
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seven steps and demonstrates various features of the import wizard. The tabulator separated
text files and import schemas may be downloaded from the Diversity Descriptions example file
repository. 

 

Step 1 - Preparations: New local project and descriptor tree 

Step 2 - Import of descriptors 

Step 3 - Insert recommended values of descriptors 

Step 4 - Import of categorical states for boolean data 

Step 5 - Import of categorical states and update of descriptor 

Step 6 - Import of descriptions 

Step 7 - Import of description data 

Epilogue 

 

See the second part of the import wizard tutorial to learn more about some advanced
functions of the import wizard.  
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Step 1 - Preparations: New local project and
descriptor tree 
Choose Edit -> Projects from the menu and create a new local project by clicking the 
button. If you are asked for a workbench project, select an available one, e.g.
DiversityWorkbench and enter the local project name "Agricultural survey". After saving the
project by clicking on button the name in the query list will be updated (see below).

Change to tab "Descriptor tree", mark project "Agricultural survey" in section "Descriptor
tree" and press button to insert a new tree. Change the tree name to "Main tree for
Agricultural survey" and again press button to save all changes (see below).
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Next: Step 2 - Import of descriptors 
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Step 2 - Import of descriptors
Choose Data -> Import ->  Import wizard -> Import descriptors ... from the menu. A
window as shown below will open to create a new import session. Select project
"MycoPhylogenyNet" and enter a session description. 

After clicking [OK] the following window opens that will lead you through the import of the
descriptor data. The window is separated in three areas. On the left side, you see a list of
possible data related import steps according to the type of data you choosed for the import.
On the right side you see the list of currently selected import steps. In the center part the
details of the selected import step are shown. 
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Choosing the File 

As a first step, choose the File from where the data should be imported. Open file
"Survey_Questions.txt". The preselected encoding ANSI should be sufficient for our test file.
The file column "QuestionText" contains the descriptor names that shall be imported. In file
column "QuestionNumber" there is a unique number assigned to each descriptor that will be
used by other data tables to reference a certain descriptor. "Type" might give a hint for the
descriptor type (categorical, quantitative or text) and "DisplayOrder" may be used to
determine the sequence number of the descriptor. 
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Selecting the data ranges

In the selection list on the left side of the window all possible import steps for the data are
listed according to the type of data you want to import.

The step Descriptor is already selected and cannot be de-selected, additionally we select
Descriptor node, because we want to assign each imported descriptor to a descriptor tree

(see above). In the step table at the right side you find the import step Descriptor and
below the most important data groups of the import step. Click on Descriptor ID and in the
center window the assignemt data for the descriptor id ("id") are displayed. Click on to make
this the decisive column, further click on From file to select the column "QuestionNumber"
as data source. After that the column should look as shown below.   

Remark: The Descriptor ID is a number that is generated automatically from the database
when a new descriptor is created. Anyway in the data file there is a field "QuestionNumber"
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that is linked to a certein descriptor and used in other tables to reference a certain
descriptor. The mapping from the "QuestionNumber" values to the internally generated 
Descriptor ID values will be stored in a separate import mapping table for the actual import
session. In the later import steps this mapping table will allow to find the correct descriptor
assigned to a certain "QuestionNumber".

Now the descriptor name must be selected, therefore click on Descriptor name. The
center window shows three data columns: "label", "abbreviation" and "detail". Click on From
file in the "label" line to select file column "QuestionText" (see below).

Next click on Sequence number. In the center window select the data column
"display_order", click on From file and select file column "QuestionNumber". (see below).

As already mentioned before the file column "Type" contains information that can be used to
determine the descriptor type. Therefore click on Subclass, select the "subclass" line, click
on From file and select the file column "Type". Now click on button to open the
transformation window. As only transformation step select to insert a translation table and

to list the values contained in the file column. "Bool" shall be converted to "Categorical
descriptor", "Integer" and "Real" will become "Quantitative descriptor" and the rest "Text
descriptor" (see below).
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The file rows that contain entries in column "Values" seem to specify categorical descriptors
but are simply inserted as text characters. We will correct those values when we import the
categorical states in a later step. The "subclass" data column now looks as shown below.

The descriptor step at the right displays the most important data columns grouped in separate
steps. Anyway, there are several additional data columns available that can be accessed by
clicking on the Descriptor step itself. Here we select data column "measurement_unit",
choose file column "Unit" (see below).

To do the assignment of the imported descriptors to the descriptor tree that was created in
the preparation step, select Descriptor node ID from step Descriptor node and supply
it exactly the samy way as the Descriptor ID. (Don't forget to click on to make it the
decision column.) Furthermore supply the Sequence number in the same way as described
above.

Finally select import step Descriptor tree, select data column "descriptortree_id", choose
For all:  and select entry "Main tree for Agricultural survey" from the drop down (see

below). With this adjustment every imported descriptor will automatically be assigned to that
descriptor tree.

Remark: Although descriptortree_id is a numeric value in the database, the externally visible
descriptor tree name is expected here. Since this name is unambigious, the corresponding id
will be determined during import. 

 

Testing 

To test if all requirements for the import are met use the Testing step. You can use a
certain line in the file for your test and than click on the Test data in line: button. If there
are still unmet requirements, these will be listed in a window. In our example no error occured
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and the test for the first data line is shown below. 

You can see that in table "Descriptor" for data column "id" a new value 325050 is generated -
remember that from file column "ParamID" the value 1 was selected. The mapping of the
external value (1) to the internal value (325050) in table "Descriptor" will be stored in the
"ImportMapping" table of the actual import session. I.e. if in a subsequent import step for the
same session a "Descriptor.id=1" is specified in the import schema, it will automatically be
translated to the internal "Descriptor.id=325050". Anyway, usually you do not have to take
care about this automatic translation. This example shall only demonstrate the meaning of the
import sessions. 

Remark: Since testing works with transaction rollback, the "id" values shown in the test
window are different from the values resulting from a real import.

As a second example data line 4 with "DataType=Integer" was selected to demonstrate that
the descriptor subtype is correctly set to "quantitative" (see below).    
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Import 

With the last step you can start to import the data into the database. If you want to repeat
the import with the same settings and data of the same structure, you can save a schema of
the current settings (see below). 

Schedule for import of tab-separated text files into
DiversityDescriptions 
Target within DiversityDescriptions: Descriptor 

Schedule version: 1 Database version: 03.00.17 

Lines: 2 - 10 First line contains
column definition: ✔ 

Encoding: ANSI Language: US 
 

Tables

Descriptor (Descriptor) 
Merge handling: Insert
Column in table 

? Ke
y 

Co
py 

Pr
e 

Po
st 

Fil
e
po
s. 

Transformations 
Va
lue
 

So
urc
e 

Ta
ble
 

id ? 0 Fil
e 

label 1 Fil
e 

display_order 0 Fil
e 

subclass 2 
Translate Into 

Bool categorical 
Integer quantitative 
Real quantitative 

Fil
e 
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Text text 
measurement_unit 4 Fil

e 

DescriptorTreeNode (DescriptorTreeNode) 
Parent: Descriptor
Merge handling: Insert

Column in table ? Ke
y 

Co
py 

Pr
e 

Po
st 

Fil
e
po
s. 

Transformations Value Source Table 

id ? 0 File 
display_order 0 File 
descriptortree_id Main tree

for
Agricultur
al survey 

Interface 

descriptor_id ParentTable 

Lines that could not be imported will be marked with a red background while imported lines are
marked green.

If you want to save lines that produce errors during the import in a separate file, use the
"Save failed lines" option. The protocol of the import will contain all settings acording to the
used schema and an overview containing the number of inserted, updated, unchanged and
failed lines (see below).

 

Next: Step 3 - Insert recommended values of descriptors 
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Step 3 - Insert recommended values of
descriptors
Now we have imported the descriptors and assigned them to a descriptor tree. Since we have
several quantitative descriptors, we should at least assign one recommended statistical
measure to these descriptors. In this step we will additionally insert recommended modifier and
frequency vales. If your database does not yet include modifier and frequency values, you
might like to interrupt here and insert them according chapter  Edit projects -
Modifier/Frequency tab of this manual. 

Finally we want to set the "values_are_integer" flag for the descriptor, that is specified as
"Integer" in the file column "Type". We could have done this during the previous import step,
but here we can demonstrate the update existing data sets with the import wizard. 

In the selection list on the left side of the window select Rec. stat. measure 1,  Rec.
modifier 1 and Rec. frequency 1 (see below).

In this step we attach the recommended values to all descriptor nodes, therefore we will not
change anything in the descriptor or descriptor node but will attach data. In import step 
Attachment at the right side select id (see below).  

Select the import step Merge from the list. For Descriptor we select the Update
option because the "values_are_integer" column shall be updated. For Descriptor node we
select the Attach option because this tables shall not be changed. For all other steps 
Insert should already be selected, because new entries have to be inserted (see below). 

Deselect every column from import steps Descriptor and Descriptor node except "id".
Mark the "id" columns as Key column for comparison during attachment. The "id" column of
import step Descriptor now looks as shown below.
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The "id" column of import step Descriptor node now looks as shown below.

 

Selecting the values

In the step table at the right side click on the import step Rec. stat. measure 1 and in the
center window the assignemt data for the statistical measure ("measure_id") are displayed.
Click on to make this the decisive column, further click on For all: and select entry
"Central or typical value (human estimate)" from the drop down (see below).   

Select values for Rec. modifier 1 and Rec. frequency 1 in the same way, the actually
selected modifier and frequency values do not matter for this tutorial (see below).  

Remark: Although measure_id, modifier_id and frequency_id are numeric values in the
database, the externally visible names are expected here. Since this names are unambigious,
the corresponding ids will be determined during import. 

If you want to insert more than one recommended value of a type, click on button of the
import step at the left side of the window. Select the new inserted step and supply the
"measure_id", "modifier_id" or "frequency_id" as described above.

Now we will enter the update of the "values_are_integer" data column. Select the import step 
Descriptor and select the "values_are_integer" line. Click on From file and select the

file column "Type". Now click on button to open the transformation window. As only
transformation step select to insert a translation table and to insert the values contained
in the file column. For "Integer" the data column value shall be set to "yes" as shown below.
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The "values_are_integer" column of import step Descriptor now looks as show below.

 

Testing 

To test if all requirements for the import are met use the Testing step. You can use a
certain line in the file for your test and than click on the Test data in line: button. If there
are still unmet requirements, these will be listed in a window. In our example no error occured
and the test for the fifth data line is shown below.  
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Import 

With the last step you can start to import the data into the database. If you want to repeat
the import with the same settings and data of the same structure, you can save a schema of
the current settings. The imported data lines are marked green (see below). 

Page 316



 

Next: Step 4 - Import of categorical states for boolean data 
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Step 4 - Import of categorical states for
boolean data
Now we want to import categorical states for the descriptors specified as "Bool" in the
table. In the selection list on the left side of the window deselect Descriptor node, 
Rec. stat. measure 1,  Rec. modifier 1 and Rec. frequency 1. Select Categorical
state 1, click on the button to insert a second categorical state and select it, too (see
below).

In this step we attach two categorical states named "Yes" and "No" at those descriptors that
are marked as "Bool" in file column "Type". The state values are not present in the
"Survey_Questions.txt" file, but in the "Survey_answers.txt" files we can see the values. In
import step Attach at the right side we select id (see below). It indicates that we do
not want to insert new descriptors but attach data to an existing descriptor. 

Select the import step Merge from the list. For Descriptor we select the Attach
option because this table shall not be changed, for Categorical state 1 we select 
Insert, because a new entry shall be inserted (see below). 

Deselect every column from import step Descriptor except "id". Mark the "id" column as 
Key column for comparison during attachment (see below).

 

Inserting the categorical states

In the import step Categorical state 1 click on Categorical state ID and in the center
window the assignemt data for the categorical state id ("id") are displayed. Click on to make
this the decisive column, further click on From file to select the column "Type" as data
source. Now click on button to define a transformation. In the tranformation window click
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on to select a filter, then select Import fixed value and enter the value Yes. Now click
on the button choose column "Type" from the file and enter compare value Bool (see
below).

This filter has the following effect: If file column "Type" contains value "Bool", the value Yes
is provided for import, otherwise the file row will be ignored. The column now looks as shown
below.   

Remark: The Categorical state ID is a number that is generated automatically from the
database when a new categorical state is created. At first sight it seems confusing that we
select a string for this numeric key. The point is that in the file with the description data the
corresponding catogorical state is idenified by exactly this categorical state name. Since we
select this categorical state name for the Categorical state ID, the mapping between
these two values will be stored in a separate import mapping table for the actual import
session. In the later import steps this mapping table will allow to find the correct categorical
state.

In the import step Categorical state 1 click on Categorical state name and in the
center window the assignemt data for the categorical state name ("label"), its abbreviation
and detailled description ("abbreviation" and "details") are displayed. Select "label" and click
on For all: and enter the value Yes. The column now looks as shown below. 
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Finally we supply the Sequence number. Select For all: with 1 (see below). 

 

In the import step Categorical state 2 click on Categorical state ID and in the center
window the assignemt data for the categorical state id ("id") are displayed. Click on to make
this the decisive column, further click on From file to select the column "Type" as data
source. Now click on button to define a transformation. In the tranformation window click
on to select a filter, then select Import fixed value and enter the value No. Now click
on the button choose column "Type" from the file and enter compare value Bool (see
below).

This filter has the following effect: If file column "DataType" contains value "Bool", the value
No is provided for import, otherwise the file row will be ignored. The column now looks as
shown below.   

In the import step Categorical state 1 click on Categorical state name and in the
center window the assignemt data for the categorical state name ("label"), its abbreviation
and detailled description ("abbreviation" and "details") are displayed. Select "label" and click
on For all: and enter the value Yes. The column now looks as shown below. 

Page 320



Finally we supply the Sequence number. Select For all: with "2" (see below). 

 

Testing 

To test if all requirements for the import are met use the Testing step. First the test for
data line 2 is shown below, which is an example for a non "Bool" descriptor. 

No data shall be inserted. Below the test result for data line 8, a "Bool" descriptor, is shown.
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Import 

With the last step you can start to import the data into the database. If you want to repeat
the import with the same settings and data of the same structure, you can save a schema of
the current settings. The imported data lines are marked green, the ignored data lines grey
(see below). 
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Next: Step 5 - Import of categorical states and update of descriptor 
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Step 5 - Import of categorical states and
update of descriptor data
Now we want to import the categorical states that are specified in file column "Values" and
set the subclass for those descriptors from "text" to "categorical". In the selection list on the
left side of the window Descriptor, Categorical state 1 and Categorical state 2
are still selected and Descriptor node 1 is deselected (see below). Furthermore the
descriptor id is selected for attachment.

Since we want to change the descriptor data, we have to change the import step Merge
from the list. For Descriptor we select the Update option (see below). 

In the import step Descriptor click on Subclass, select file column "Values" and click on
button to open the transformations. By clicking the button the transformations of
previous steps are removed. In the tranformation window click on to select a filter, then
select Import a fixed value and enter the value categorical. Now click on the button
choose column "Values" from the file and select <not equal> blank (see below).

Page 324



This filter will provide the value "categorical" for database column "subclass" if file column
"Values" is not empty. If "Value" is empty, no value is provided and the "subclass" stays
unchanged. The column now looks as shown below.

 

Inserting the categorical states

A closer look on the "Values" file column shows that the states are provided as a list of values
separated by the pipe symbol and blanks (" | "). To get the single state values, we have to
split off a value at the string " | ". This value will then be used for the Categorical state
ID and the Categorical state name.

In the import step Categorical state 1 click on Categorical state ID and in the center
window the assignemt data for the categorical state id ("id") are displayed. Click on to make
this the decisive column, further click on From file to select the column "Values" as data
source. Now click on button to define a transformation. 

In the tranformation window click on the cut transformation, enter Position: 1, click on 
to enter splitter character  |  (blank, pipe, blank). By clicking on button [Test the
tranformation] you can check the transformation results (see below).
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The column now looks as shown below.   

Remark: The Categorical state ID is a number that is generated automatically from the
database when a new categorical state is created. At first sight it seems confusing that we
select a string - the catigorical state name - for this numeric key. The point is that in the file
with the description data the corresponding catogorical state is idenified by exactly this
categorical state name. Since we select this categorical state name for the Categorical
state ID, the mapping between these two values will be stored in a separate import mapping
table for the actual import session. In the later import steps this mapping table will allow to
find the correct categorical state.

Now supply exactly the same filter settings for Categorical state name but do not mark it
as decisive column (see below).

Finally we supply the Sequence number. Select For all: with 1 (see below).

And now there is some "fun": 

The longest entry in column "Values" contains four entries separated by pipes and blanks.
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Therefore click two more times on the button of step Categorical state 1 on the left
side and select the new steps Categorical state 3 and Categorical state 4. For each
of the remaining steps supply the columns in the same way as for Categorical state 1, but
increase the Position: value in the cut transformations and the For all: value in 
Sequence number.   

 

Testing 

To test if all requirements for the import are met use the Testing step. The test for data
line 9, where all eleven descriptor states are present, is shown below. 

 

Import 

With the last step you can start to import the data into the database. If you want to repeat
the import with the same settings and data of the same structure, you can save a schema of
the current settings. There were 4 lines that contained descriptors (see below).
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Next: Step 6 - Import of descriptions 

Page 328



Step 6 - Import of descriptions
Choose Data -> Import ->  Wizard -> Import descriptions ... from the menu. A
window as shown below will open to select an import session. Select session for project
"MycoPhylogenyNet". 

After clicking [OK] the following window opens that will lead you through the import of the
description data.
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Choosing the File 

Choose step File an open file "Survey_Answers.txt". The chosen encoding ANSI of the file
should be sufficiend. The file column "ClientNumber" contains the description names that shall
be imported. Since there are no other description specific data, the same column will be used
for the as unique ID to identify each description.  
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Selecting the data ranges

In the selection list on the left side of the window all possible import steps for the data are
listed according to the type of data you want to import.

Since each description name rsp. ID occurs in several lines of the file, subsequent tries to
import the same description would cause errors, if the standard merge handling Insert was
used.  We have to change the import step Merge from the list. For Description we
select the Merge option (see below). 

The step Description is already selected and cannot be de-selected (see above). In the
step table at the right side you find the import step Descriptor and below the data groups
of the import step. Click on Description ID and in the center window the assignemt data
for the description id ("id") are displayed. Click on to make this the decisive column and on
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to allow the merge comparison, further click on From file to select the column
"ClientNumber" as data source. After that the column should look as shown below.   

Now the description name must be selected, therefore click on Description name. The
center window shows two data columns: "label" and "detail". Click on From file in the
"label" line to select file column "ClientNumber". After that the columns should look as shown
below.

Finally select import step Project, select data column "project_id", choose For all:  and
select entry "Agricultural survey" from the drop down (see below). With this adjustment every
imported description will automatically be assigned to that project.

Remark: Although project_id is a numeric value in the database, the externally visible project
name is expected here. Since this name is unambigious, the corresponding id will be
determined during import. 

 

Testing 

To test if all requirements for the import are met use the Testing step. The test for the
first data line is shown below. 
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Import 

With the last step you can start to import the data into the database. If you want to repeat
the import with the same settings and data of the same structure, you can save a schema of
the current settings. There were three different descriptions (see below).

 

Next: Step 7 - Import of description data 
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Step 7 - Import of description data 
In this step we attach categorical, quantitative and text data to the descriptions. In import
step Attach at the right side we select id (see below). It indicates that we do not want
to attach data to an existing description. 

Select the import step Merging from the list. For Description we select the Attach
option because this table shall not be changed (see below). 

Deselect every column from import step Description except "id". The "id" column was
already marked as Key column for comparison in the previous step. Now the column looks
as shown below.

 

Inserting text descriptor data

We will now include the text, quantitative, categorical and status data step by step. First we
will attach the text descriptor data. Select the Text descriptor 1 step at the left (see
below).

At the right side you find the import step Text descriptor 1 and below the data groups of
the import step. Click on Descriptor ID and in the center window the assignemt data for
the referenced descriptor's id ("descriptor_id") are displayed. Click on From file to select
the file column "QuestionNumber" as data source. After that the column should look as shown
below.   

Now the description text must be selected, therefore click on Text. The center window
shows two data columns: "content" and "notes". In line "content" click on to make it the
decisive column, further on From file to select file column "Answer". In line "notes" click on

From file to select file column "Notes". After that the columns should look as shown below.

Page 334



 

Testing the text descriptor data import 

To test if all requirements for the import are met use the Testing step. The test for the
first data line is shown below. 

An additional test is done for the next data line. This line contains no text data but a
categorical state. You can see below that this line will not be imported as text descriptor
data, because the descriptor (given by Descriptor ID) is automatically checked for the
correct type. 
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Inserting quantitative summary data

We will now include the quantitative summary data. Select the Quantitative data 1 step
(see below).

At the right side you find the import step Quantitative data 1 and below the data groups
of the import step. Click on Descriptor ID and select the file column "QuestionNumber" as
data source. 

Now the value must be selected, therefore click on Value. The center window shows two
data columns: "value" and "notes". In line "value" click on to make it the decisive column,
further on From file to select file column "Answer". In line "notes" click on From file to
select file column "Notes". After that the columns should look as shown below.
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For quantitavie measures you must specify which statistical measure is given by the value.
We assume all imported values are mean values, therefore click on the import step 
Statistical measure and in the center window the assignemt data for the statistical measure
("measure_id") are displayed. Click on For all: and select entry "Central or typical value
(human estimate)" from the drop down (see below).   

 

Testing the quantitative summary data import 

To test if all requirements for the import are met use the Testing step. The test for data
line 25 with integer data is shown below. 

The test for data line 25, which contains real number fails (see below). 
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A closer look on the data in column "Answer" shows that the decimal separator is a comma,
because the table has been generated by a progam using the German localization. The
database expects a decimal point as separator. To interpret the localized file values correctly,
select the step File and choose Language / Country: de (see below).

With this settings the test now works fine (see below). 
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Inserting categorical summary data

Now we will include the categorical summary data. Select the Categorical data 1 step at
the left (see below).

At the right side you find the import step Categorical data 1 and below the data groups of
the import step. Click on Categorical state ID. The center window shows the data column
"state_id". Click on to make it the decisive column, further on From file to select file
column "Answer". If you perform a quick import test you will see that this setting works
perfectly for data file lines 3, 4 and 6, but fails for line 8 (see below).
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The reason is that we used the state name as external key for the categorical state. For the
descriptors 6 and 8, which both represent boolean values, the states names are ambigious
("Yes" and "No" for both descriptors), therefore the import wizard does not know which
descriptor shall be used. To overcome this ambiguity the Categorical state ID step allows
the additional specification of the descriptor id. Select import step Categorical state ID.
In the center click on the button at the end of line "state_id". Select file column
"QuestionNumber", which contains the reference to the descriptor and enter the separator
character | (pipe symbol) in field Pre.: of the new line. After that the column should look as
shown below.

If you repeat the quick import test for line 8, it will now work.

Now click on Notes. The center window shows the data column "notes". Click on From
file to select file column "Notes". After that the columns should look as shown below.

 

Testing the categorical summary data import 

To test if all requirements for the import are met use the Testing step. The test for data
line 15 with categorical data and notes is shown below. 
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Inserting the descriptor status dataata

There is an empty lines in the file. For this line we want to set the descriptor status "Data
unavailable" to indicate that the descriptor should be present in the description. Select the 
Descriptor status 1 step at the left (see below).

At the right side you find the import step Descriptor status 1 and below the data groups
of the import step. Click on Descriptor ID and select the file column "QuestionNumber" as
data source. Furthermore click on Notes and select the file column "Notes".  

Now click on Data status. The center window shows the data column "statusdata_id".
Click on to make it the decisive column, further on From file to select file column
"Answer". Now click on button to define a transformation. In the tranformation window click
on to select translation. In the translation window click the button to list the values
contained in the file column. For the empty entry in the first line select the translation value
"Data unavailable" (see below). All data entries will therefore be mapped to "empty", i.e. no
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data status will be set. Only if the data file line ist empty, the selected data status will be
inserted.

 

Testing the descriptor status data import 

To test if all requirements for the import are met use the Testing step. The test for data
line 16 is shown below. 
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Import 

With the last step you can start to import the data into the database. If you want to repeat
the import with the same settings and data of the same structure, you can save a schema of
the current settings. There were 26 lines imported and one failed line (see below). 

The erroneous lines may be stored into separate text files for a detailled analysis and a
separate import after error corrections. In out example the error is caused by the undefined
value "Cereals" in the "Answer" column of file line 24. 

 

Next: Epilogue 
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Epilogue 
When you close the import wizard and start a query for descriptions of project "Agricultural
survey" you will find the three datasets and the imported descriptor data (see image below).  

Finnally two more aspects of the imports wizard shall be discussed from a retrospective view.
The first one concerns the mapping of external and internal keys and the role of the import
session. The second one takes a closer look on the role of the "ID" columns during import.  

 

Mapping of external and internal keys

When opening the import wizard you have to select rsp. create an import session. Imports into
Diversity Descriptions usually require at least two import operations, e.g. for descriptors and
descriptions. The description data reference descriptors or categorical states. Within the
database those relations are built based on numeric values that are provided by the database
during creation of the corresponding objects. In the external data files the relations are
usually built by numbers coordinated by the user ("QuestionNumber") or by the entity names. 

The import session stores the external and internal key values in separate database tables
and therefore builds a bracket around the different import operations. Each import session is
assigned to one local project, but for each project several import sessions may be created.
The mapping data may be viewed by opening the menu item Data -> Import ->  Wizard
-> Organize sessions ..., selecting the session and clicking the button Mapping (see
image below). 
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Selecting import columns for the "ID" fields 

As an addition to the tutorial steps a closer look on the role of the "ID" fields shall be taken. In
principle the most important IDs during import concern the Descriptor ID and the 
Categorical state ID during descriptor import. To decide which file column shall be used for
that values during import, it is important to know how these elements are referenced in the
other files.    

For the descriptor import, you should take a look at the description data table (see above),
which is part of the tutorial example. The descriptor is referenced by column "QestionNumber",
which matches homonymous column of the descriptor data table (see below). Therefore the
natural approach is to use this column as input for the Descriptor ID during the descriptor
import. Since in most practical cases the descriptors will have a numbering column, which is
used in the referencing table. Surely more variety exists in the way the categorical states are
listed in the descriptor data file and the way they are referenced by the description data file.  
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In the tutorial the first complication is that the possible states are all concatenated,
separated by a semicolon, into a single column of the descriptor data file. This causes some
effort in the transformation, because the states have to be splitted into the single values.
The question is, what is the Categorical state ID? The answer can be found in the upper
table, because the state name is explicitely mentioned in the description data file as
reference. I.e. for the descriptor import the state name must be used for the Categorical
state ID, too.

In Diversity Descriptions the categorical state names must be unique in relation to their
descriptor. But different descriptors may have states with the same names. In our example
this situation occures with the two boolean descriptors (states "Yes" and "No") and the state
value "Others", wich is used by two descriptors. Therefore it is generally recommended to
specify the descriptor for the import of categorical summary data as demonstrated in the
tutorial.  
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Import wizard - tutorial for advanced
functions 
The second part of the import wizard tutorial is dedicated to some advanced functions of the
import wizard. When data are imported from the file formats DELTA or SDD, no import mapping
information is stored, because all logical references are completely satisfied within the data
files. The starting point of this tutorial, which was taken from a real life example, is a
database imported from a DELTA file. For the datasets a lot of pictures are available on a web
server. A web application reads the data from the original database (where the DELTA file was
generated) and gets the information about available pictures from a second database to
display both in a browser. From the original databases several tables were extracted and now
the pictures shall be appended to the imported data. 

 

Overview of the data tables and necessary import steps  

Step 1 - Preparations: Data import from DELTA file and new import session  

Step 2 - Import of categorical state mapping 

Step 3 - Import of descriptor mapping 

Step 4 - Import of description mapping 

Step 5 - Import of resouces for descriptors 

Step 6 - Import of resouces for categorical states 

Step 7 - Import of resouces for descriptions 

Step 8 - Import of resouce variant 
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Overview of the data tables and necessary
import steps
From the original database several tables have been extracted that contain the descriptor
names, categorical state names and description names, together with their internal IDs in the
foreign database. Additionally there is a table that assigns picture IDs to the IDs of
descriptors, categorical states and descriptions. The last table connects the picture IDs to file
names. In DiversityDescriptions resources are represented by the tablese "Resource", which
holds some general information and is linked to descriptors, categorical states or descriptions.
Table "Resource variant" holds the URL of the resources and each table row is assigned to one
entry in table "Resource". 

Find below a part of the table "Deemy_RSC.txt", which corresponds quite well to the table
"Resource" in DiversityDescriptions. It references either to a description ("ItemID"), a
descriptor ("CharID") or a categorical state ("StateID").  

The value in column "Resource" corresponds to column "PID" of the table "Deemy_IMG.txt"
(see below), where the picture file name is specified. Since all pictures are accessible over a
URL containing that file name, this table can be used for import to data table "Resource
variant" in DiversityDescriptions.  

To import the picture data, first the data in table "Deemy_RSC.txt" must be appended to the
existing descriptors, categorical states and descriptions. Then the data from table
"Deemy_IMG.txt" must be appended to the resource entries. Since the basic data are imported
from a DELTA file, no mapping information have been stored, which are needed to append the
resource data. Therefore at first the mapping information must be imported from three
additional tables.  

 

Mapping data

To allow appending of resource data to the existing database objects, we first must create
the mapping information of the external IDs of the foreign database to the actual IDs in
DiversityDescriptions. Find below the table "Deemy_Char.txt", which contains the descriptor
name ("CharName"), the internal "CharID" and an external "CID".  
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For the picture import each descriptor must be mapped to its "CharID", which can be done by
a special mapping import available in the Import session form. When we now take a look at
the "Deemy_CS.txt" (see below), which contains the categorical state data, we discover a
problem: The categorical states contain the required "StateID", but they are connected to
their descriptors by the value "CID", not "CharID". 

This problem can be solved by importing the descriptor mapping twice: First the descriptor
mapping is imported by using the "CID" and the categorical states are appended to the
descriptors. Then the descriptor mapping is cleared and imported again, this time using the
final value from column "CharID".

The last table is "Deemy_Item.txt", which contains the mapping information for the
descriptions. Here the data column "ItemID" must be mapped to the descriptions (see below). 
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Next: Step 1 - Preparations: Data import from DELTA file and new import session 
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Step 1 - Preparations: Data import from DELTA
file and new import session 
Choose Data -> Import -> Import DELTA ... (see Import DELTA file) from the menu
and import the DELTA file to project "Deemy" (see below). If the original database contains
special characters, e.g. the German letters "ä", "ö" or "ü", it is recommended to specify the
export character set "Unicode" or "UTF" if the application allows that. If the character set
"ANSI" or "ASCII" was used, you may try the corresponding encoding setting to get a
satifactory import result. The option "Accept comma as decimal separator" was checked,
because the export has been done on a German computer system, where a value like "3.14" is
exported as "3,14".

Close the window above and choose Data -> Import ->  Wizard -> Organize session
... from the menu. A window as shown below will open, click the New button to create a
new import session. Select project "Deemy" and enter a session description. Finally click
button Save to store the data (see below).
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When you now click on button Mapping you can see that no mapping data are available
(see below).
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Next: Step 2 - Import of categorical state mapping 
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Step 2 - Import categorical state mapping 
In the Import session form choose Import mapping -> Descriptor ... from the menu.
A window as shown below opens that will lead you through the import of the descriptor
mapping data.  

The only available import step Descriptor Mapping is already selected at the left side of
the window. Now choose the File from where the data should be imported. Open file
"Deemy_CHAR.txt". The chosen encoding ANSI of the file is sufficient. The file column
"CharName" contains the descriptor names and file column "CID" the external ID needed for the
import of the categorical state mapping import (see below). 
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In the step table at the right side you find the import step Descriptor Mapping. Click on it
and in the center window the assignemt data for the internal "object_id" and the
"external_key" are displayed. In column "object_id" click on to make this the decisive column,
further click on From file to select the column "CharName" as data source. Now click on
the  In column "external_key" click on From file to select the column "CID" as data source.
After that the columns should look as shown below.   

Remark: In the import wizards for the import mapping "object_id" allways represents the
internal ID of the database. The matching database entry is searched by comparing the label
of the database entry to the selected file column. If there are several descriptors (or
descriptions) with identical names, the import will generate errors. For categorical states a
special handling is available if the state names are not unique.

 

Testing 

To test if all requirements for the import are met use the Testing step. You can use a
certain line in the file for your test and than click on the Test data in line: button. If there
are still unmet requirements, these will be listed in a window. In our example no error occured
and the test for the first data line is shown below. 
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Import 

With the last step you can start to import the data into the database. If you want to repeat
the import with the same settings and data of the same structure, you can save a schema of
the current settings (see below). 
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Append categorical state mapping 

Close the import form for descriptors. In the Import session form choose Import
mapping -> Categorical state ... from the menu and open file "Deemy_CS.txt" (see
below).  
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The only available import step CategoricalState Mapping is already selected at the left
side of the window. In the step table at the right side you find the import step 
CategoricalState Mapping, too. Click on it and in the center window the assignemt data for
the internal "object_id", the "parent_key" and the "external_key" are displayed. In column
"object_id" click on to make this the decisive column, further click on From file to select
the column "CharStateName" as data source. In column "parent_key" you have to specify the
parent of the categorical state, i.e. the external descriptor ID. Therefore click on From file
to select the column "CID" as data source. In column "external_key" click on From file to
select the column "StateID" as data source. After that the columns should look as shown
below.   

In the source database of this example not only the categorical states as known in
DiversityDescriptions are present, but also some "pseudo states" that represent statistical
measures of quantitative descriptors or the data status value "not applicable". The real
categorical states can be recognized by a numeric value in file column "CS". In any case the
import wizard check if a categorical state with the label specified in file column
"CharStateName" exists in the database. Therefore let's do a first test for some selected file
lines.

 

Testing 

To test if all requirements for the import are met use the Testing step. You can use a
certain line in the file for your test and than click on the Test data in line: button. If there
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are still unmet requirements, these will be listed in a window. Perform the import test for file
lines 2, 13 and 12 (see below).

 

 

The file line 2 refers to parent "CID=1", which belongs to a text descriptor. The pseudo state
"(internal)" was not found as a categorical state in the database, therefore not import is
performend for the file line.

 

The file line 13 refers to parent "CID=3", which belongs to a categorical descriptor. The
categorical state "monopodial-pinnate" was found exactly once in the database, therefore the
import test was successful.
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The file line 12 refers to parent "CID=3", which belongs to a categorical descriptor. But the
categorical state "absent" was found 152 time in the database. Therefore it was not possible
to find the correct categorical state. But the error message already gives a hint how to solve
the problem: To get an unambigious match, additionally the (external) descriptor ID must be
specified. 

Select the import step CategoricalState Mapping and click on the button at the end of
line "object_id". Select file column "CID", which contains the reference to the descriptor and
enter the separator character | (pipe symbol) in field Pre.: of the new line. Additionally click
on button in the first line of "object_id". In the transformation window insert one
replacement (button ): Replace <br> by <br /> . This transformation is neccessary,
because the formatting tag "<br>" will be converted to the standardized format "<br /> during
export from the original database and import from DELTA. You can check that transformation
by the test functions for lines 1860 and 3555. After that the column should look as shown
below.

The import test with file line 12 now gives a positive result as shown below..
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Import 

With the last step you can start to import the data into the database. If you want to repeat
the import with the same settings and data of the same structure, you can save a schema of
the current settings. The imported data lines are marked green (see below). 
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Next: Step 3 - Import of descriptor mapping 
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Step 3 - Import of descriptor mapping
Close the import form for the categorical state mapping. In the Import session form choose

Clear mapping -> Descriptor from the menu (see below) and answer the followind
question with "Yes". This mapping is based on data column "CID" and was needed in the
previous step to append the categorical state mapping data. For the picture import the
descriptor mapping based on data column "CharID" is required. 

In the Import session form choose Import mapping -> Descriptor ... from the menu
and open file "Deemy_CHAR.txt". The file column "CharName" contains the descriptor names
and file column "CharID" the foreign ID (see below). 
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In the step table at the right side you find the import step Descriptor Mapping. Click on it
and in the center window the assignemt data for the internal "object_id" and the
"external_key" are displayed. In column "object_id" click on to make this the decisive column,
further click on From file to select the column "CharName" as data source. Now click on
the  In column "external_key" click on From file to select the column "CharID" as data
source. After that the columns should look as shown below.   

 

Testing 

To test if all requirements for the import are met use the Testing step. You can use a
certain line in the file for your test and than click on the Test data in line: button. If there
are still unmet requirements, these will be listed in a window. In our example no error occured
and the test for the first data line is shown below. 
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Import 

With the last step you can start to import the data into the database. If you want to repeat
the import with the same settings and data of the same structure, you can save a schema of
the current settings (see below). 
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Next: Step 4 - Import of description mapping 
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Step 4 - Import description mapping 
Close the import form for descriptors. In the Import session form choose Import
mapping -> Description ... from the menu and open file "Deemy_ITEM.txt" (see below).  

The only available import step Description Mapping is already selected at the left side of
the window. In the step table at the right side you find the import step Description
Mapping, too. Click on it and in the center window the assignemt data for the internal
"object_id" and the "external_key" are displayed. In column "object_id" click on to make this
the decisive column, further click on From file to select the column "ItemName" as data
source. In column "external_key" click on From file to select the column "ItemID" as data
source. After that the columns should look as shown below.   

 

Testing 

To test if all requirements for the import are met use the Testing step. You can use a
certain line in the file for your test and then click on the Test data in line: button. If there
are still unmet requirements, these will be listed in a window. In our example no error occured
and the test for the first data line is shown below. 
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Import 

With the last step you can start to import the data into the database. If you want to repeat
the import with the same settings and data of the same structure, you can save a schema of
the current settings. The imported data lines are marked green (see below). 
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The failed lines are in this example caused by duplicate item names twice in the database.
This problem can be fixed by renaming the ambigious entries in the database and the import
file, e.g. to "Alnirhiza cystidiobrunnea + Alnus 1" and "Alnirhiza cystidiobrunnea + Alnus 2" rsp.
"Lactarius omphaliformis Romagn. + Alnus 1" and "Lactarius omphaliformis Romagn. + Alnus 2".  

 

Next: Step 5 - Import of resources for descriptors 
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Step 5 - Import of resources for descriptors
Close the import wizard for the mapping data and the import session window. Now choose 
Data -> Import ->  Wizard -> Import resources -> Descriptor resources ... from
the menu. A window as shown below will open to select an import session. Select the session
for project "Deemy". 

After clicking [OK] the following window opens that will lead you through the import of the
descriptor resource data. Open file "Deemy_RSC.txt" (see below).
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Selecting the data ranges

In the selection list on the left side of the window all possible import steps for the data are
listed according to the type of data you want to import. The step Descriptor is already
selected, additionally check the step Descriptor resource (see below). 

We attach the descriptor resource values to the descriptors, therefore we will not change
anything in the descriptor but will attach data. In import step Attachment at the right side
select Descriptor id (see below).  

Select the import step Merge from the list. For Descriptor we select the Attach
option because this tables shall not be changed, for the other step Insert should already
be selected, because a new entry has to be inserted (see below). 
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In the step table at the right side you find the import steps Descriptor and Descriptor
resource and below them the data groups of the import steps. Deselect every column from
import step Descriptor except "id". Mark the "id" column as Key column for comparison
during attachment and click on From file to select the column "CharID" as data source.
The "id" column of import step Descriptor now looks as shown below.

In the import step Descriptor resource click on Resource ID and in the center window
the assignemt data for the resource id ("id") are displayed. Click on to make this the decisive
column, further click on From file to select the column "Resource" as data source. After
that the column should look as shown below.   

Click on Resource name. The center window shows the data column "label". Click on 
From file in the "label" line to select file column "Resource". After the resource number the
value in data column "Caption" shall be inserted, included in brackets, if it is present. Click on
the button at the end of line "label" and select column "Caption". Enter  ( (blank and
opening bracket) in field Pre.: and ) in field Post.: of the new line. After that the column
should look as shown below.

Finally click on Sequence number. In the center window select the data column
"display_order", click on From file and select file column "DisplayOrder" (see below).

 

Testing 

To test if all requirements for the import are met use the Testing step. The test for the
first data line is shown below. 
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Import 

With the last step you can start to import the data into the database. If you want to repeat
the import with the same settings and data of the same structure, you can save a schema of
the current settings. There are 86 lines that were not imported due to duplicate entries (see
below).

The failed lines are caused by duplicate entries, i.e. the resource was already imported for the
descriptor.

 

Next: Step 6 - Import of resources for categorical states 
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Step 6 - Import of resources for categorical
states
Close the import wizard for the descriptor resources. Now choose Data -> Import ->
Wizard -> Import resources -> State resources ... from the menu, select the session
for project "Deemy". The following window opens that will lead you through the import of the
categorical state resource data. Open file "Deemy_RSC.txt" (see below).

 

Selecting the data ranges

In the selection list on the left side of the window all possible import steps for the data are
listed according to the type of data you want to import. Deselect the step Descriptor, it is
not needed since the categorical states have been assigned unambiguous external IDs in step
3. Check the steps Categorical state and State resource (see below). 

We attach the state resource values to the categorical states, therefore we will not change
anything in the categorical state but will attach data. In import step Attachment at the
right side select Categorial state id (see below).  
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Select the import step Merge from the list. For Categorical state we select the 
Attach option because this tables shall not be changed, for the other step Insert should
already be selected, because a new entry has to be inserted (see below). 

In the step table at the right side you find the import steps Categorical state and 
State resource and below them the data groups of the import steps. Deselect every column
from import step Categorical state except "id". Mark the "id" column as Key column for
comparison during attachment and click on From file to select the column "StateID" as
data source. The "id" column of import step Categorical state now looks as shown below.

In the import step State resource click on Resource ID and in the center window the
assignemt data for the resource id ("id") are displayed. Click on to make this the decisive
column, further click on From file to select the column "Resource" as data source. After
that the column should look as shown below.   

Click on Resource name. The center window shows the data column "label". Click on 
From file in the "label" line to select file column "Resource". After the resource number the
value in data column "Caption" shall be inserted, included in brackets, if it is present. Click on
the button at the end of line "label" and select column "Caption". Enter  ( (blank and
opening bracket) in field Pre.: and ) in field Post.: of the new line. After that the column
should look as shown below.

Finally click on Sequence number. In the center window select the data column
"display_order", click on From file and select file column "DisplayOrder" (see below).

 

Testing 

To test if all requirements for the import are met use the Testing step. The test for the
second data line is shown below. 
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Import 

With the last step you can start to import the data into the database. If you want to repeat
the import with the same settings and data of the same structure, you can save a schema of
the current settings. There are 561 lines that were not imported due to duplicate entries (see
below).
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The failed lines are caused by duplicate entries, i.e. the resource was already imported for the
categorical state.

 

Next: Step 7 - Import of resources for descriptions 
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Step 7 - Import of resources for descriptions
Close the import wizard for the state resources. Now choose Data -> Import ->  Wizard
-> Import resources -> Description resources ... from the menu, select the session
for project "Deemy". The following window opens that will lead you through the import of the
categorical state resource data. Open file "Deemy_RSC.txt" (see below).

 

Selecting the data ranges

In the selection list on the left side of the window all possible import steps for the data are
listed according to the type of data you want to import. Step Description is already
selected. Aditionally check step  Description resource (see below). 

We attach the description resource values to the descriptions, therefore we will not change
anything in the description but will attach data. In import step Attachment at the right
side select Description id (see below).  
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Select the import step Merge from the list. For Description we select the Attach
option because this tables shall not be changed, for the other step Insert should already
be selected, because a new entry has to be inserted (see below). 

In the step table at the right side you find the import steps Description and 
Description resource and below them the data groups of the import steps. Deselect every
column from import step Description except "id". Mark the "id" column as Key column
for comparison during attachment and click on From file to select the column "ItemID" as
data source. The "id" column of import step Description now looks as shown below.

In the import step Description resource clickon Resource ID and in the center window
the assignment data for the resource id ("id") are displayed. Click on to make this the
decisive column, further click on From file to select the column "Resource" as data source.
After that the column should look as shown below.   

Click on Resource name. The center window shows the data column "label". Click on 
From file in the "label" line to select file column "Resource". After the resource number the
value in data column "Caption" shall be inserted, included in brackets, if it is present. Click on
the button at the end of line "label" and select column "Caption". Enter  ( (blank and
opening bracket) in field Pre.: and ) in field Post.: of the new line. After that the column
should look as shown below.

Finally click on Sequence number. In the center window select the data column
"display_order", click on From file and select file column "DisplayOrder" (see below).

 

Testing 

To test if all requirements for the import are met use the Testing step. The test for the
data line 717 is shown below. 
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Import 

With the last step you can start to import the data into the database. If you want to repeat
the import with the same settings and data of the same structure, you can save a schema of
the current settings. There are 177 lines that were not imported due to duplicate entries (see
below).
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The failed lines are caused by duplicate entries, i.e. the resource was already imported for the
description.

 

Next: Step 8 - Import of resource variants 
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Step 8 - Import of resource variants
The import wizards used in step 5 up to step 7 allow appending a resource variant to one
resource. Those wizards can be used most efficiently if the data that are needed for the
resource table and the resource variant are located at the same file. In our example there is
the complication that the direction of the resource reference is in the opposite direction than
in the original database. In DiversityDescription a resource references e.g. a descriptor and
one or more resource variants reference the resource. In the original database several
entities, e.g. descriptors or states, may reference the same picture. 

During the import of the resources we used the picture number as the external key of the
resources. Together with their parent key, e.g. a descriptor ID, this gives unambiguous entries
although the external resource ID alone is ambiguous. Now we want to create a resource
variant, containing the URL of the picture, for each resource entry with the same external
resource ID. 

Since this "multiple" import is no standard feature of the import wizard, the following
description shows a work-around: During the import the first resource entry with a matching
"Resource ID" that is not referenced by any Resource variant will be available for data update
and appending of a new resource variant. A repeated import with the same setting will find
the next resource entry and so on until all ambigious resource entries are processed.  

Close the import wizard for the description resources. Now choose Data -> Import ->
Wizard -> Import resources -> Resource variants ... from the menu, select the
session for project "Deemy". The following window opens that will lead you through the import
of the categorical state resource data. Open file "Deemy_IMG.txt" (see below).

 

Selecting the data ranges
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In the selection list on the left side of the window all possible import steps for the data are
listed according to the type of data you want to import. The available steps Update
resource and Resource variant are already selected. 

We want to update some fields of the resource table with values form the data file attach the
resource variant to the resource. In import step Attachment at the right side select 
Update resource id (see below). Note: With this import wizard only update of resources is
supported.  

Select the import step Merge from the list. For Update resource we keep the Merge
option because this table shall be updated, for the other step Insert should already be
selected, because a new entry has to be inserted (see below). 

In the import step Update resource click on Resource ID and in the center window the
assignment data for the resource id ("id") are displayed. Click on to make this the decisive
column. Mark the "id" column as Key column for comparison during attachment and click
on From file to select the column "PID" as data source. After that the column should look
as shown below. 

Click on Resource name. The center window shows the data column "label" and "detail".
Deselect the "label" entry and select "detail". Click on From file to select the column
"SourceTitle" as data source and enter Source:  in field Pre.: (double-click in the field to open
a separate edit window). Now click on the button at the end of line "detail", select file
column "Volume" and enter , vol.  in field Pre.:. Repeat the last step for file columns "Pages" (,
p. ) and "ReferenceNotes" (, notes: ). After that the column should look as shown below. 

Click on Resource rights and in the center window the assignment data for the resource
rights are displayed. Select "rights_text". Click on From file to select the column "Author"
as data source and enter ©  (Alt+0169 and a blank) in field Pre.:. Now click on the button
at the end of line "rights_text", select file column "DateYear" and enter ,  in field Pre.:. After
that the column should look as shown below. 
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In the import step Resource variant click on Resource link. The center window shows
the data column "url". Click on to make this the decisive column and on From file in the
"url" line to select file column "FileName". Double-click on the text box after Pre.: to open a
separate edit window. Here enter the web address of the picture server where the files are
located and confirm with "OK". After that the column should look as shown below.

Click on Variant type. In the center window select the data column "variant_id", click on
For all: and select the value "good quality" (see below).

Click on the import step Resource variant to find some ungrouped fields. In the center
window select the data column "pixel_width", click on From file and select the value
"WidthD". Now select the data column "pixel_height", click on From file and select the
value "HeightD". Finally select the data column "mime_type", click on From file and select
the value "FileName". Click on button to define a transformation. In the transformation
window click on the cut transformation, enter Position: 2, click on to enter splitter
character . (period) to extract the file extension. Now click on to insert a translation table
and to insert the values contained in the file column. "gif" shall be converted to image/gif,
"jpg"  will become image/jpeg (see below).

After that the columns should look as shown below.
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Testing 

To test if all requirements for the import are met use the Testing step. The test for the
first data line is shown below. 

 

Import 

With the last step you can start to import the data into the database. If you want to repeat
the import with the same settings and data of the same structure, you can save a schema of
the current settings. As mentioned in the introduction, the import step has to be repeated
until no more resource variant is imported. At the first run 789 lines were imported (see
below).
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At the second run, started by another click on Start import, 152 lines were imported (see
below).

Finally, at the seventh run no further line is imported (see below).
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Import SDD file
Remarks: 

 To import data from an SDD file at least TerminologyEditor rights are neccessary. 
 Currently SDD statements concerning natural laguage descriptions and identification

keys are not evaluated. 

With this form you can import data from an XML file according schema SDD 1.1 rev 5 into the
database. You may download an example SDD file with from the Diversity Descriptions example
file repository. Choose Data -> Import -> Import SDD ... from the menu to open the
window for the import. In the window click on the button to select the file with the data
you want to import. If during analysis or import any problems occur, you may click on the 
button to reload the file and re-initialize the window. 

 

The contents of the file will be shown in the upper part of the File tree tab page. In the
Analysis settings part you find the document's Default language. If additional laguages are
contained in the document, you may select one of them as the new default language of the
database. By checking Import translations you select all additional document languages for
the import. This option is automatically pre-selected if more than one language has been
found in the file. In the bottom part of the window you find the import database and the
actual processing state.

If the Check strings for illegal characters  option is checked, all string literals that shall be
exported from database are scanned for illegal non-printable characters and matches are
replaced by a double exclamation mark ("‼"). Activating this option may increase the analysis
processing time.
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In the file tree you may deselect entries that shall not be imported into the database. Use
that option very carefully, because if you deselect entries that are being referenced by other
parts of the input tree, e.g. descriptors referenced by descriptions, the analysis or import step
might become erronous! 

 

Analysis 

To analyse the data in the file click on the Analyse data button. During the analysis the
program checks the dependencies between the different parts of the data and builds up an
analysis tree in the lower part of the window. The analysis tree contains all data in a suitable
format for the final import step. During data analysis the icon of the button changes to 
 and you may abort processing by clicking the button.  

 

After analysis a message window informs you if any warnings or errors occured. You can find
detailled error and warning information at the file and/or analysis trees by entries with red text
(error) or yellow background (warning). When you move the mouse curser over the marked
entries, you get additional information as tool tip or the tree node text itself tells the problem
(see examples below). By clicking on the status text besides the progress bar, you can open
an analysis protocol (see below, right). 
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If an analysis error occured, you are not able to proceed. You will first have to correct the
problem, e.g. by excluding the erronous descriptor in the example above (after reloading the
file). If a warning occured, it might not cause problems during import, but you should take a
closer look if the imported data will be correct.

 

Import 

Before starting the import, you should take a look at the import options:

 New project - import data to a new project. 
The project name is specified in the text box right from this radio button. 
This option is only available if at least ProjectManager rights are available. 

 To project - import data to an existing project. 
The combo box at the right shows all projects where write access is possible. 
If only TerminologyEditor rights are availabe, no changes in the existing project (e.g.
detail or copyright) will be done.

 Worlbench project specifies the assigned workbench project if "New project" is
selected for import.

 Accept comma as decimal separator shall help to overcome problems with
localization of some programs that create SDD files. 
If this option is checked, a floating point value like "1,0" (e.g. used in german
localizations) instead of "1.0" will be accepted as "1".

 Create default descriptor tree creates a default descriptor tree and assigns all
imported descriptors to that tree. 
Additionally the statistical measures "Minimum", "Lower limit", "Mean", "Upper limit" and
"Maximum" are set as recommended for all quantitative descriptors.
This option is useful to avoid unassigned descriptors if the import file does not specify
any descriptor tree assignments. 

 Import trees for natural language descriptions - currently natural language
descriptions are ignored.

 Import trees without "role" - usually those trees only contain descriptor dependency
information.

To start the import click on the Start import button. Now the data from the analysis tree
are written into a local database cache and finally stored into the database. 
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After import a message window inform you if any warnings or errors occured. You can find
detailled error and warning information at the file and/or analysis trees by entries with red text
(error) or yellow background (warning). When you move the mouse curser over the marked
entries, you get additional information as bubble help or the tree node text itself tells the
problem. By clicking on the status text besides the progress bar, you can open an import
protocol (see below).  
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Import DELTA file
Remark: 

 To import data from a DELTA file at least TerminologyEditor rights are neccessary. 

With this form you can import data from a file in DELTA format into the database. Choose
Data -> Import -> Import DELTA ... from the menu to open the window for the import.
In the window click on the button to select the file with the data you want to import. If
the Multi-file option is selected before pressing the button, a folder selection window
opens to select the folder where the DELTA files are located. For muti-file processing currently
the files "chars", "items", "specs" and "extra" are evaluated. If during analysis or import any
problems occur, you may click on the button to reload the file and re-initialize the window. 

 

The contents of the file will be shown in the upper part of the File tree section. If special
characters are not displayed corretly, try a different Encoding setting, e.g. "ANSI", and
reload the document using the button. In the bottom part of the window you find the import
database and the actual processing state. 

In the file tree you may deselect entries that shall not be imported into the database. Use
that option very carefully, because if you deselect entries that are being referenced by other
parts of the input tree, e.g. descriptors referenced by descriptions, the analysis or import step
might become erronous! 

If during reading of the files expressions cannot be interpreted, suspicious entries are maked
with yellow background (warning) in the file tree. When you move the mouse curser over the
marked entries, you get additional information as tool tip or the tree node text itself tells the
problem (see example below).  
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Analysis 

To analyse the data in the file click on the Analyse data button. During the analysis the
program checks the dependencies between the different parts of the data and builds up an
analysis tree in the lower part of the window. The analysis tree contains all data in a suitable
format for the final import step. During data analysis the icon of the button changes to 
 and you may abort processing by clicking the button.  

In the Analysis settings section (see image below) you set the document's Language. You
man change the display and sorting of the entries in the Language combo box from "<code>
- <description>" to "<description> - <code>" (and back) by clicking the button . If you
need language codes that are not included in the list, click the button. For more details
see Edit language codes. 

The Insert "variable" state controls the handling of the DELTA state "V" for categorical
summary data. If possible, a categorical state "variable" is inserted to the descriptor data and
set in the summary data, when the state "V" is present in the description data. 

If the Check strings for illegal characters  option is checked, all string literals that shall be
exported from database are scanned for illegal non-printable characters and matches are
replaced by a double exclamation mark ("‼"). Activating this option may increase the analysis
processing time.

In DELTA text in angle bracket (<text>) usually denotes comments, which are by default
imported into the "Details" fields of the database. In the lower parts of the Analysis settings
you may adjust a different handling for description, descriptor and categorical state items.  

 For DELTA comments in descriptions you may Move comments to details (default)
or Keep comments in description titles. 

 For DELTA comments in descriptors you may Move comments to details
(default), Move comments to notes or Keep comments in descriptor titles.  

 For DELTA comments in categorical states you may Move comments to details
(default) or Keep comments in categorical state titles. 

After changing one of these settings click on the Analyse data button to make the
changes effective. 
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After analysis a message window informs you if any warnings or errors occured. You can find
detailled error and warning information at the file and/or analysis trees by entries with red text
(error) or yellow background (warning). When you move the mouse curser over the marked
entries, you get additional information as bubble help or the tree node text itself tells the
problem (see example below). By clicking on the status text besides the progress bar, you can
open an analysis protocol (see below, right). 

 

If an analysis error occured, you are not able to proceed. You will first have to correct the
problem, e.g. by excluding the erronous descriptor in the example above (after reloading the
file). If a warning occured, it might not cause problems during import, but you should take a
closer look if the imported data will be correct.
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Import 

If you want to import new data to a project you have two import options: 

 New import - import new data and save mapping information to an import session. 
For descriptors, categorical states and descriptions the mapping information from the
DELTA import will be storen in an import session. Therefore by a subsequent import run
updated information, e.g. a modified label or detail information can be done (see
section "Update" below). 

 No update - import new data without saving of mapping information. 
This option might be faster, but you will not be able to update the titles or to import
additional translations from a DELTA file.

Before starting the import, you should take a look at the import settings:

 New project - import data to a new project. 
The project name is specified in the text box right from this radio button. 
This option is only available if at least ProjectManager rights are available. 

 To project - import data to an existing project. 
The combo box at the right shows all projects where write access is possible. 
If only TerminologyEditor rights are availabe, no changes in the existing project (e.g.
detail or copyright) will be done.

 Worlbench project specifies the assigned workbench project if "New project" is
selected for import.

 Accept comma as decimal separator shall help to overcome problems with
localization of some programs that create DELTA files. 
If this option is checked, a floating point value like "1,0" (e.g. used in german
localizations) instead of "1.0" will be accepted as "1".

 Create default descriptor tree creates a default descriptor tree and assigns all
imported descriptors to that tree. 
Additionally the statistical measures "Minimum", "Lower limit", "Mean", "Upper limit" and
"Maximum" are set as recommended for all quantitative descriptors.
This option is useful to avoid unassigned descriptors if the import file does not specify
any descriptor tree assignments. 

To start the import click on the Start import button. Now the data from the analysis tree
are written into a local database cache and finally stored into the database. 
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After import a message window inform you if any warnings or errors occured. You can find
detailled error and warning information at the file and/or analysis trees by entries with red text
(error) or yellow background (warning). When you move the mouse curser over the marked
entries, you get additional information as bubble help or the tree node text itself tells the
problem. By clicking on the status text besides the progress bar, you can open an import
protocol (see below). 

 

 

Handling of special DELTA states 

In the DELTA format the special states "-" (not applicable), "U" (unknown) and "V" (variable)
are available for categorical and quantitative characters. These states are treated in the
folloging manner during import:

 "-" (not applicable) 
The data status "Not applicable" is set. 

 "U" (unknown)
The data status "Data unavailable" is set. 

 "V" (variable) 
The data status "Not interpreterable" is set. 
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Update 

If you imported new data using option New import, a new import session with the following
data will be created: 

 Descriptor keys - the "character number" that is used in DELTA to identify a
dedicated character. 

 Categorical state keys - the "state number" that is used in DELTA, together with the
"character number", to identify a dedicated chategorical state. 

 Description keys - the item position in the item list. Since in DELTA there are no
explicit item numbers, the position within the item list is taken for this key. If you want
to update the items using the DELTA import, you must be sure that the item list has 
exactly the same sequence as for the first import! 

For those entities you may update the columns "label", "detail" and "data_entry_notes" (only
for descriptors). To achive this, you must specify the same Language in the Analysis
settings as adjusted as project language. If you specify a different Default language, the
data will be imported as translations for the columns "label" rsp. "detail" (see image below). For
descriptor column "data_entry_notes" translations are not supported. 

 

Preparation 

By changing the Analysis settings and a clicking the Analyse data button you may
modify the handling of DELTA comments. E.g. if you used the default settings during a past
import, a DELTA character "data record <type>" was imported as descriptor "data record" and
"type" was written into the columns "detail". In the Analysis settings you may now select
option Keep comments in descriptor titles to update the descriptor title to "data record
<type>".  

Page 396



 

Import settings 

Before starting the import, you should take a look at the import options:

 Update - perform an update import. 
 Import session - click on button  Select to select the correct import session. 

In the text box below that option the automatically generated descriptive text of the
import session is displayed.

 Remove optional columns - clear optional columns if no contents is present.
If during update import for an optional column ("detail" rsp. "data_entry_note") no data
are present, by default an existing entry in the database will not be removed. Check
this option to clear the data. 

Start the import click on the Start import button. Now the data from the analysis tree are
written into a local database cache and finally stored into the database. 
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Import questionnaire data
With this form you can import response data generated by an HTML questionnaire (see Export
questionnaires). Choose Data -> Import -> Import questionnaire data ... from the
menu to open the window for the import. In the window click on the button to select the
text file with the data you want to import. If during analysis or import any problem occurs,
you may click on the button to reload the file and re-initialize the window. 

 

The contents of the file will be shown in the upper part of the Import contents section. You
may edit the contents or even enter the whole data by copy - paste. In the Import data
part you find the basic dataset parameters Export server, Export database, Import
project and Import description (see image below). If there is a mismatch, e.g. because the
questionnaire was generated from a different database than your import database, an
appropriate error will be reported. 
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Analysis 

To analyse the data in the file click on the Analyse data button. During the analysis the
program compares the reported data to the entries in the database and presents the planned
database operations in the lower part of the window (see image below). By checking Accept
comma as decimal separator in the Import options section you can overcome problems
with localization of the computer where the questionnaire was filled in. If this option is
checked, a floating point value like "1,0" (e.g. used in german localizations) instead of "1.0"
will be accepted as "1". 
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After analysis a message window informs you about errors or ignored input lines. By clicking on
the status text besides the progress bar, you can open an analysis protocol (see below). 

   

If an analysis error occured, you are not able to proceed. If ignored lines are reported, this
fact is usually uncritical. Most of them concern "modifier" or "frequency" values (prefix CM, CF
or QM) where the questionnaire reports the actual values, not only the differences. 

 

Import 

Before starting the import, you should take a look at the remaining Import options:
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 Update description after backup 
Create a backup of the original description data and then update the original
description in the database. If this option is chosen, you may enter a Postfix that will
be appended at the backup description name. Additionally you may select the option 
Include data and time to append these data at the backup name, too (see image
below).

 Create a new description (only option for new descritpions)
Make a copy of the original description data and then updatde the copy in the
database.

 Update description in database 
The original description in the database will be updated.

If the description entries in your database are referenced by other applications, you should
update the original database entry, i.e. use the first or third option. The reason is that
references from other databases usually use the description id, which will be different for the
copied description. To ensure that the questionnaire data are correct, you can import them
useing the option Create a new description, verify the imported data and finally import them
to the original description using option Update description in database. 

Before performing the import you may include or exclude single database operations by setting
or removing the check mark in column "OK". You may select or deselect all operations by
clicking the buttons Select all rsp. Select none. Please be aware that deselecting single
operation might lead to unexpected results. 

To start the import click on the Start import button (see image below).  
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After import a message window inform you if any occured. Sucessful database operations are
shown with green background, unsuccessful operations with red background. When you move
the mouse curser over the red entries, you get additional information as bubble help. By
clicking on the status text besides the progress bar, you can open an import protocol (see
below).  

   

 

Batch import 

If you want to import several qustionaire result files, there is the comfortable option to do a
batch import. When you select the option Multi-file, the window changes as shown below.
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Click on the button and select all text files you want to import. In the lower part of the
window the selected files will belisted (see image below).  
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After checking the Import options click on the Start import button to start the import. In
the lower part of the window you find the processing result for each selected file (see image
below).  
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Export
There are several export mechanisms: 

Matrix wizard: Export descriptor and description data as tabulator separated text file
generate an import schema for the matrix import wizard. 

List export: Export data as tabulator-separated text file. 

Structured export: Export data as structued data file, e.g. XML according to the SDD
schema 1.1 rev 5 or DELTA text file. 

Export questionaires: Export description data of a project or from a quey list as HTML
forms. 

CSV export: Export data in a tab separated format for external analysis. 
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Matrix export wizard for tab separated lists
With this form you can export the descriptor and description data from the database to a
tabulator separated text file. The output includes the database keys. Furthermore you have
the option to create rsp. update import mapping data and generate an matrix import schema.
Therefore you may correct the data, e.g. by using a spreadsheet program and re-import the
changes by using the matrix import wizard. Choose Data -> Export -> Matrix wizard ...
from the menu to open the window for the export. 

 

In the Export project section all projects of the database are shown as a tree. Select here
the project that shall be exported. In case of hierarchically organized projects the
subordinated projects will be included for export, if the Include child projects option is
checked. You may pass a description list to the form by starting a query in mode "Edit
descriptions". Now you have the option to select single descriptions for export. In this case
the Export project section shows the button  to switch to the list view (see below). 
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In the Export descriptions section you find all description titles that have been passed to
the export form (see below). You may select all entries by clicking the all button, deselect
all entries by clicking the none button or toggle your selection by clicking the swap
button. By clicking the button you will return to the Export project view.

The Withheld data section allows control over export of datasets that contain entries with
data status "Data withheld". Option Supress whole description (default) excludes all
descriptions form export where at least on descriptor is marked with "Data withheld". Option 
Hide withheld descriptor excludes only the corresponding descriptor data from the
description. Option Export withheld data does not exclude any data from export.

The Options section allows the selection of the Descriptor tree: and descriptor sequence
number bounds (From descriptor: and to descriptor:) for restriction of output table
columns. 

If you select option Use sequence, the descriptor state sequence numbers will be inserted
into the output table instead of the state names. These sequence numbers will be inserted
into the selected import session (see below) for a later re-import of the data. If you export
the descriptive data to edit them with a spreadsheet tool, e.g. Microsoft Excel, you have to
identify the active categorical states by their sequence number.  

To include all export data in quotes, check option "quotes". By specifying the State
separator: (default , ) you determine how multiple categorical state values will be
concatenated in the table cells. By changing the selected Lang. settings: you may adapt the
output of floating point numbers or date and time fields to your needs. 
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Import session 

The section Import session: is relevant if you want to edit the description data in a separate
spreadsheet programme and re-import the edited data using the Matrix Import Wizard. To
select an import session cick on button Select and a window as shown below will be
opened. You may either select an existing import session, which will be updated with the
exported data, or create a new one.   

 

During generation of the matrix data file the relevant data for re-import will be stored in the
selected import session. Additionally an xml import schema file will be generated as  
<resources directory>\Export\Matrix_<Database name>_<Project>_Schema.xml. If
you do not require the data for re-import, simply do not select an import session or click on
button to cancel an existing selection.  

 

Export 

Before starting the export, the export file name should be checked. The file name is generated
as <resources directory>\Export\Matrix_<Database name>_<Project>.txt. This
default setting may be changed by editing the File name or by navigating at the target
location by pressing the button besides the file name. 
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To check the export, click on the Test export button. In the Output preview data grid
the first few lines will be displayed (see picture above). To generate the table file press the 
Start export button. During test and export the icon of the button changes to  and you
may abort processing by clicking the button. 
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List export
There are several exports for tabulator-separated text files: 

Export descriptors list: Export descriptor data as tabulator separated text file. 

Export descriptions list: Export description data as tabulator separated text file. 

Export sample data list: Export sample data as tabulator separated text file. 

Export resource data list: Export resource data as tabulator separated text file for data
review and possible re-import of modified data. 
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Export Descriptors List
With this form you can export descriptor data from the database to an tabulator separated
text file. Choose Data -> Export -> Export lists -> Descriptors list ... from the
menu to open the window for the export. 

 

In the Export project section all projects of the database are shown as a tree. Select here
the project that shall be exported. In case of hierarchically organized projects the
subordinated projects will be included for export, if the Include child projects option is
checked. 

The Export settings allows the inclusion of a header line in the output by checking the
option Generate headers in output. Additionally the lines displayed in the Test output
section may be selected by specifying the first and last line number in Test lines [start] to
[end]. For the generated output you may adjust the lines that shall be exported in Exp. lines
[start] to [end]. For the end line a maximum value of 99999 may be entered, which means
export of the whole data beginning from the start line. 

 

Columns 
To generate a list output, you have to determine the data columns that shall be present in
the descriptors list. To include a new column press the Add button in the tool strip of the
Columns section. A control representing a single output column will be added at the end of
the column list (see picture below).  
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The Columns control shows the column number, a text box for the column header (title) and
the source selector (see below). 

As source you may select one of the following values:

Line number  Number of the data line in the output file

Descriptor   Descriptor data, e.g. name of the descriptor 

Descriptor tree  Assigned descriptor tree(s) 

Categorical state   Categorical state(s) of a certain descriptor  

Depending on the selected data source one or more additional selection boxes will appear in
the descriptor column control. The target (see picture below) selects the filed from the
database that shall be inserted.  
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As long as you did not enter a value for the column header, a reasonable suggestion
depending on the selected values will be inserted. You may enter a different column header,
then the background color changes to light yellow to indicate that it will not be updated
automatically anymore (see picture below, column 4). Double-click on the header to open a
separate edit window. 

Output formatting is controlled with check box "quotes" that includes the whole output text
in quotes and text boxes Pre: and Post:, which allow inclusion of the values in prefix and
postfix strings. By selecting the check box Skip empty a blank output will be inserted  instead
of the specified prefix and postfix strings or quotes, if no value is present. If for a column
multiple values may be present, e.g. in case of categorical descriptors where several
categorical states might be present, there is the choice of inserting additional lines for multiple
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values (Separate line), selecting a single value (Select) or merging the values to a single
output string (Merge). For option Select you have specify if the first, second or other values
shall be selected. For option Merge you may specify a separator string that shall be inserted
between two values (default is ; ). To open a separate edit window for the Pre, Post or
Merge values strings, e.g. because a longer value shall be entered, double-click on the
correspondent text box. 

Any selected column may be shifted to another position using the Up and Down buttons
or deleted with the Remove button of the tool strip. With button you may delete all
columns. The complete export schema may be saved into an XML file using the button ,
which opens a dialog window to enter the file name and location. By default the schema file
name is generated as: 

     <resources directory>\ExportSchema\DescriptiorList_<Database
name>_<Project>.xml  

The XML schema file includes information concerning the database, the project and the output
columns. By pressing the button in the Columns section, a schema file can be opened. 

 

Export 

Before starting the export, the export file name should be checked. The file name is generated
as <resources directory>\Export\DescriptorList_<Database name>_<Project>.txt.
This default setting may be changed by editing the File name or by navigating at the target
location by pressing the button besides the file name. 

To check the export, click on the Test export button. By changing the selected Language
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settings: you may adapt the output of floating point numbers or date and time fields to your
needs. In the Output preview grid view the lines specified in the Export settings (Test
lines [start] to [end]) will be displayed (see picture above). To generate the table file press
the Start export button. During test and export the icon of the button changes to  and
you may abort processing by clicking the button. 
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Export Descriptions List
With this form you can export description data from the database to a tabulator separated
text file. Choose Data -> Export -> Export lists -> Descriptions list ... from the
menu to open the window for the export. 

 

In the Export project section all projects of the database are shown as a tree. Select here
the project that shall be exported. In case of hierarchically organized projects the
subordinated projects will be included for export, if the Include child projects option is
checked. You may pass a description list to the form by starting a query in mode "Edit
descriptions". If all descriptions in the list belong to the same project, you have the option to
select single descriptions for export. In this case the Export project section shows the
button  to switch to the list view (see below). 
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In the Export descriptions section you find all description titles that have been passed to
the export form (see below). You may select all entries by clicking the all button, deselect
all entries by clicking the none button or toggle your selection by clicking the swap
button. By clicking the button you will return to the Export project view.

The Withheld data section allows control over export of datasets that contain entries with
data status "Data withheld". Option Supress whole description (default) excludes all
descriptions form export where at least on descriptor is marked with "Data withheld". Option 
Hide withheld descriptor excludes only the corresponding descriptor data from the
description. Option Export withheld data does not exclude any data from export.

The Export settings allows the inclusion of a header line in the output by checking the
option Generate headers in output. Additionally the lines displayed in the Test output
section may be selected by specifying the first and last line number in Test lines [start] to
[end]. For the generated output you may adjust the lines that shall be exported in Exp. lines
[start] to [end]. For the end line a maximum value of 99999 may be entered, which means
export of the whole data beginning from the start line. 

 

Columns 
To generate a list output, you have to determine the data columns that shall be present in
the descriptions list. To include a new column press the Add button in the tool strip of the
Columns section. A control representing a single output column will be added at the end of
the column list (see picture below).  
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The Columns control shows the column number, a text box for the column header (title) and
the source selector (see below). 

As source you may select one of the following values:

Line number  Number of the data line in the output file

Description   Description data, e.g. name of the description entry 

Description scope  Description scope data, e.g. taxon, specimen or sex  

Descriptor value  Value(s) of a certain descriptor 

Descriptor status   Data status of a certain descriptor  

Depending on the selected data source one or more additional selection boxes will appear in
the description column control. The target (see picture below left) selects the field from the
database that shall be inserted. If you select "Description scope" as data source, a selection
box for filtering will be inserted to determine the scope category (see picture below right).  
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If you select "Descriptor value" or "Descriptor status" as data source, a selection box for the
descriptor will be inserted (see picture below). The descriptor can be selected from an
alphabetical list or from the descriptor tree by clicking . In case of "Descriptor value" the
target selection box entries depend on the descriptor type. For categorical descriptors you
may select name, abbreviation, detail, wording, ID or notes of the categorical states. For
quantitative descriptors you may select the value or notes of a specific statistical measure
(separate selection box). For text and sequence descriptors you may select the text or
notes. 

As long as you did not enter a value for the column header, a reasonable suggestion
depending on the selected values will be inserted. You may enter a different column header,
then the background color changes to light yellow to indicate that it will not be updated
automatically anymore (see picture below, columns 4 and 5). Double-click on the header to
open a separate edit window. 
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Output formatting is controlled with check box "quotes" that includes the whole output text
in quotes and text boxes Pre: and Post:, which allow inclusion of the values in prefix and
postfix strings (default is "). By selecting the check box Skip empty a blank output will be
inserted  instead of the specified prefix and postfix strings, if no value is present. If for a
column multiple values may be present, e.g. in case of categorical descriptors several
categorical states might be present, there is the choice of insterting additional lines for
multiple values (Separate line), selecting a single value (Select) or merging the values to a
single output string (Merge). For option Select you have specify if the first, second or other
values shall be selected. For option Merge you may specify a separator string that shall be
inserted between two values (default is ; ). To open a separate edit window for the Pre:,
Post: or Merge strings, e.g. because a longer value shall be entered, double-click on the
correspondent text box. 

Any selected column may be shifted to another position using the Up and Down buttons
or deleted with the Remove button of the tool strip. With button you may delete all
columns. The complete export schema may be saved into an XML file using the button ,
which opens a dialog window to enter the file name and location. By default the schema file
name is generated as: 

     <resources directory>\ExportSchema\DescriptionList_<Database
name>_<Project>.xml  

The XML schema file includes information concerning the database, the project, handling of
withheld data and the output columns. By pressing the button in the Columns section, a
schema file can be opened. If the schema does not meet the active database, especially
descriptor dependent columns might be erroneous because of unknown values. This is
indicated by a red background color (see picture below).   
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Export 

Before starting the export, the export file name should be checked. The file name is generated
as <resources directory>\Export\DescriptionList_<Database name>_<Project>.txt.
This default setting may be changed by editing the File name or by navigating at the target
location by pressing the button besides the file name. 

To check the export, click on the Test export button. By changing the selected Language
settings: you may adapt the output of floating point numbers or date and time fields to your
needs. In the Output preview grid view the lines specified in the Export settings (Test

Page 422



lines [start] to [end]) will be displayed (see picture above). To generate the table file press
the Start export button. During test and export the icon of the button changes to  and
you may abort processing by clicking the button.  
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Export Sample Data List
With this form you can export sample data from the database to a tabulator separated text
file. Choose Data -> Export -> Export lists -> Sample data list ... from the menu
to open the window for the export. 

 

In the Export project section all projects of the database are shown as a tree. Select here
the project that shall be exported. In case of hierarchically organized projects the
subordinated projects will be included for export, if the Include child projects option is
checked. 

The Export settings allows the inclusion of a header line in the output by checking the
option Generate headers in output. Additionally the lines displayed in the Test output
section may be selected by specifying the first and last line number in Test lines [start] to
[end]. For the generated output you may adjust the lines that shall be exported in Exp. lines
[start] to [end]. For the end line a maximum value of 99999 may be entered, which means
export of the whole data beginning from the start line. 

 

Columns 
To generate a list output, you have to determine the data columns that shall be present in
the descriptions list. To include a new column press the Add button in the tool strip of the
Columns section. A control representing a single output column will be added at the end of
the column list (see picture below).  
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The Columns control shows the column number, a text box for the column header (title) and
the source selector (see below). 

As source you may select one of the following values:

Line number  Number of the data line in the output file

Description   Description data, e.g. name of the description entry 

Sampling event  Sampling event data, e.g. name, detail or start date  

Sampling unit  Sampling unit data, e.g. ID, specimen or specimen URI  

Descriptor value  Sample value(s) of a certain descriptor 

Depending on the selected data source one or more additional selection boxes will appear in
the description column control. The target (see pictures below) selects the field from the
database that shall be inserted..  
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If you select "Descriptor value" as data source, a selection box for the descriptor will be
inserted (see picture below). The descriptor can be selected from an alphabetical list or from
the descriptor tree by clicking . The target selection box entries depend on the descriptor
type. For categroica descriptors you may select name, abbreviation, detail or ID of the
categorical states, for quantitative descriptors you may select the value or notes, for text
and sequence descriptors you may select the text or notes.   

As long as you did not enter a value for the column header, a reasonable suggestion
depending on the selected values will be inserted. You may enter a different column header,
then the background color changes to light yellow to indicate that it will not be updated
automatically anymore (see picture below, column 3). Double-click on the header to open a
separate edit window. 
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Output formatting is controlled with check box "quotes" that includes the whole output text
in quotes and text boxes Pre: and Post:, which allow inclusion of the values in prefix and
postfix strings (default is "). By selecting the check box Skip empty a blank output will be
inserted  instead of the specified prefix and postfix strings, if no value is present. If for a
column multiple values may be present, e.g. in case of categorical descriptors several
categorical states might be present, there is the choice of inserting additional lines for multiple
values (Separate line), selecting a single value (Select) or merging the values to a single
output string (Merge). For option Select you have specify if the first, second or other values
shall be selected. For option Merge you may specify a separator string that shall be inserted
between two values (default is ; ). To open a separate edit window for the Pre:, Post: or
Merge strings, e.g. because a longer value shall be entered, double-click on the
correspondent text box. 

Any selected column may be shifted to another position using the Up and Down buttons
or deleted with the Remove button of the tool strip. With button you may delete all
columns. The complete export schema may be saved into an XML file using the button and
a dialog window will be opened. By default the schema file name is generated as: 

     <resources directory>\ExportSchema\SampleDataList_<Database
name>_<Project>.xml  

The XML schema file includes information concerning the database, the project, handling of
withheld data and the output columns. By pressing the button in the Columns section, a
schema file can be opened. If the schema does not meet the active database, especially
descriptor dependent columns might be erroneous because of unknown values. This is
indicated by a red background color (see picture below).   
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Export 

Before starting the export, the export file name should be checked. The file name is generated
as <resources directory>\Export\SampleDataList_<Database name>_<Project>.txt.
This default setting may be changed by editing the File name or by navigating at the target
location by pressing the button besides the file name. 

To check the export, click on the Test export button. By changing the selected Language
settings: you may adapt the output of floating point numbers or date and time fields to your
needs. In the Output preview grid view the lines specified in the Export settings (Test
lines [start] to [end]) will be displayed (see picture above). To generate the table file press
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the Start export button. During test and export the icon of the button changes to  and
you may abort processing by clicking the button. 
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Export resource data list
With this form you can export the resource data (see tables Resource and ResourceVariant)
from the database to a tabulator separated text file. Since the output includes the database
keys, you may correct the data, e.g. by using a spreadsheet program and re-import the
changes by using the import wizard. Choose Data -> Export -> Export lists -> 
Resource list ... from the menu to open the window for the export. 

 

In the Export project section all projects of the database are shown as a tree. Select here
the project that shall be exported. In case of hierarchically organized projects the
subordinated projects will be included for export, if the Include child projects option is
checked. 

The Withheld data section allows control over export of datasets that contain entries with
data status "Data withheld". Option Supress whole description (default) excludes all
descriptions form export where at least on descriptor is marked with "Data withheld". Option 
Hide withheld descriptor excludes only the corresponding descriptor data from the
description. Option Export withheld data does not exclude any data from export.

The Options section allows the selection of the Resource types for output ("Description",
"Descriptor", "Categorical state" and "Descriptor tree node"). To include all export data in
quotes, check option "quotes". If option Fill all columns is checked, resource variant data
that are inherited from the row above will be explicitely repeated in the actual row. To include
all data rows that do not have resources select option Show empty entities. If you select
Show descriptors, the descriptor titles will be inserted for categorical states. By checking
option Show duplicates only you may list resource links that are referenced by more than
one entity of the same type. 
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You may restrict the resource data list to resource links that include a specified substring by
selecting the URL filter option and entering the required string in the text field below.  

 

Export 

Before starting the export, the export file name should be checked. The file name is generated
as <resources directory>\Export\ResourceDataList_<Database name>_<Project>.txt
. This default setting may be changed by editing the File name or by navigating at the target
location by pressing the button besides the file name. 

To check the export, click on the Test export button. In the Output preview data grid
the first few lines will be displayed (see picture above). To generate the table file press the 
Start export button. During test and export the icon of the button changes to  and you
may abort processing by clicking the button. 

 

Re-import 

The review output includes all database keys that can be sufficiently used to identify the
affected data row. When the modified data shall be re-imported, the internal keys must be
available to the import wizard. This can easily be done by creating a new import session and
using the option  Generate mapping ... in form Import sessions. 
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Export data as SDD, DELTA or EML
With this form you can export data from the database to an DELTA file. Choose Data -> 
Export -> Export SDD/DELTA ... from the menu to open the window for the export. 

 

In the Export project section all projects of the database are shown as a tree. Select here
the project that shall be exportes. In case of hierarchically organized projects the
subordinated projects will be included for export, if the Include child projects option is
checked. You may pass a description list to the form by starting a query in mode "Edit
descriptions". Now you have the option to select single descriptions for export. In this case
the Export project section shows the button  to switch to the list view (see below). 
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In the Export descriptions section you find all description titles that have been passed to
the export form (see below). You may select all entries by clicking the all button, deselect
all entries by clicking the none button or toggle your selection by clicking the swap
button. By clicking the button you will return to the Export project view.

The Withheld data section allows control over export of datasets that contain entries with
data status "Data withheld". Option Supress whole description (default) excludes all
descriptions form export where at least on descriptor is marked with "Data withheld". Option 
Hide withheld descriptor excludes only the corresponding descriptor data from the
description. Option Export withheld data does not exclude any data from export. Check
option Export sample data to include sampling events and units in the analysis output.

In the Options section you find the items Read external data. By selecting this item you
enable access to external databases linked by description scopes or the related workbench
project. The foreign data are included in the analysis tree and may be exported, e.g. to a SDD
file. You may check the external data connections by clicking the button. 

If Check strings for illegal characters in the Options section is selected, all string literals
that shall be exported from database are scanned for illegal non-printable characters and
matches are replaced by a double exclamation mark ("‼") in the output file. Although
DiversityDescriptions can handle non-printable characters, especially in case of SDD XML files
some applications may have problems opening files with illegal characters.  

With option Include data entry notes you allow the analysis step to store descriptor's data
entry notes in the analysis tree. Depending on the export format, these data may be exported
e.g. as "internal notes" (SDD).   

With option Include applicability data you allow the analysis step to write available
descriptor applicability data to the analysis tree as a dedicated "Dependency tree".   

With option Include resources you allow the analysis step to write availble resource data to
the analysis tree. This option is not relevant if you only want to export to a DELTA file.   

If you select a descriptor tree in combo box Restrict descriptors to tree: only that
descriptor tree and its descriptors will be included in the analysis tree (see next section). Be
aware that you might get warnings during the analysis step when the respective descriptor
data are omitted.   

With option Include translations you allow the analysis step to write availble translations to
the analysis tree. If you check this option and translations are available, you will see the
available languages in the Export language: combo box after the analysis step.    
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Analysis 

After clicking the Analyse data button the data for export are collected in the database
an included into an analysis tree in the lower part of the window. The analysis tree contains
all data in a suitable format for the final export step. During data analysis the icon of the
button changes to  and you may abort processing by clicking the button. 

 

After analysis a message window inform you if any warnings or errors occured. If there are
descriptions that reference descriptors that are not part of the export project, these
descriptor data wil be omitted and the descriptions will be marked with yellow background
(warning). When you move the mouse curser over the marked entries, you get information
about the omitted descriptors as tool tip (see examples below). Anyway you may continue
export or fix the problem by including the missing descriptors in the descriptor tree (see
section "Editing the descriptor"). If errors are indicated, please save the error log file and send
a feedback by pressing the button. 
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Export 

Before starting the export, the export file name should be checked. Either a single SDD rsp.
DELTA file can be generated or output to several files may be chosen by selecting the 
Multi-file option. In case of SDD export currently the data will always be stored in a single file
("SDD1.xml") located in the directory specified in the "File name" text box.

If the "Multi-file" option for DELTA export is activated, the "File name" text box shows the
output path, which is by default generated as <resources directory>\Export\<Database
name>_<Project>. This default setting may be modified by editing the "File name" or by
navigating at the target location by pressing the button. For DELTA export in the target
directory the files "specs", "chars", "items" and "extra" will be generated. For SDD export you
will get the file "SDD1.XML". For EML export you will get the files "EML_MetaData.xml" and
"EML_DataTable.txt".  

If output to a single file is selected, by default the file name is generated as <resources
directory>\Export\<Database name>_<Project>_<Type> and additionally the exension
".xml" (SDD export) or ".dat" (DELTA export) will be appended. <Type> is "SDD1" for SDD and
"DELTA" for the DELTA format. This default setting may be changed by editing the "File name"
or by navigating at the target location by pressing the button. 

To start the export click on the Generate file button in the Write SDD group box to
generate an SDD file or the Generate file button in the Write Delta group box to generate
a DELTA file. Now the data from the analysis tree are written into the selected export file.
The Comptible option controls generation of files with most possible compatibility to the
DELTA rsp. SDD standard. On the other hand some data might not be present in the
generated file, if this option is activated. 

As an additional option you may generate file according the EML schema, which consists of a
data table (tabulator separated text file) and an XML file that contains the metadata including
column descriptions. Click on the Generate file button in the Write EML group box. The
generated file names will have the endings "_EML_DataTable.txt" and
"_EML_Metadata.xml". 

Pressing the drop down button DELTA settings in the Write DELTA group box opens the
DELTA writer options. You can chose to include some detail text and notes in the DELTA
output (see left image below). For descriptions, descriptors or categorical states the details
will be appended as DELTA comments (included in angle brackets "< ... >") to the respective
titles. The notes will be appended as DELTA comments of the corresponding summary data. If
you already generated DELTA files, the used settings will be automatically saved and you may
restore them using the option Load last write settings. Finally click button DELTA
settings to close the option panel.  

Pressing the drop down button EML settings in the Write EML group box opens the EML
writer options. You can chose to include a special sign for empty column values or set the
columns values in quotes (see center image below). Furthermore you may shose the column
separator (tab stop rsp. comma) an decide if multiple categorical states shall be inserted as
separate data columns. If you already generated EML files, the used settings will be
automatically saved and you may restore them using the option Load last write settings.
Finally click button EML settings to close the option panel.  
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Pressing the drop down button SDD settings in the Write SDD group box opens the SDD
writer options. You can chose to include translations in the SDD output (see right image
above).  If you already generated SDD files ,the used settings will be automatically saved and
you may restore them using the option Load last write settings. Finally click button 
SDD settings to close the option panel.  

For all three output formats you have the option Diversity Projects metadata. If this option
is selected, additional information from the corresponding project in the linked projects and
agents databases will be retrieved. An EML metadata file (XML) will be generated that includes
the retrieved metadata and references the generated data file(s).  

While SDD can handle molecular sequence data, for DELTA export these data will be exported
as text data. To preserve the sequence specific descriptor data, they will be inserted into the
text character as a special comment with the format, e.g. "#6. Sequence descriptor <
[SequenceCharacter][ST:N][SL:1][GS:-][/SequenceCharacter]>/". If during DELTA import
this special comment is detected, it will be removed and the descriptor will be imported as a
sequence descriptor using the given settings. 

If the analysis tree includes sample data (see option Export sample data), they will be
included as items at the end of the DELTA file. The naming of those spetial items will be 
<description name> - <event name> - Unit <number>. Sampling event data will not be
included in the DELTA file. 
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Export questionnaires
With this form you can export description data from the database to HTML forms. You can
open the generated HTML files, edit the data in the form and re-import the changes by using
the import questionaire data function. Choose Data -> Export -> Export
questionnaires ... from the menu to open the window for the export. 

 

In the Export project section all projects of the database are shown as a tree. Select here
the project that shall be exported. In case of hierarchically organized projects the
subordinated projects will be included for export, if the Include child projects option is
checked. You may pass a description list to the form by starting a query in mode "Edit
descriptions". If all descriptions in the list belong to the same project, you have the option to
select single descriptions for export. In this case the Export project section shows the
button  to switch to the list view (see below). 
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In the Expot descriptions section you find all description titles that have been passed to the
export form (see below). You may select all entries by clicking the all button, deselect all
entries by clicking the none button or toggle your selection by clicking the swap
button. By clicking the button you will return to the Export project view.

The Withheld data section allows control over export of datasets that contain entries with
data status "Data withheld". Option Supress whole description (default) excludes all
descriptions form export where at least on descriptor is marked with "Data withheld". Option 
Hide withheld descriptor excludes only the corresponding descriptor data from the
description. Option Export withheld data does not exclude any data from export.

The Options section allows the selection of a Descriptor tree to determine the sequence
and selection of descriptors for output. If a structured descriptor tree is selected, the first
level descriptor tree nodes will be inserted as headers to structure the document. If option 
Adapt names to headers is checked, the descriptor names will be prefixed with the headers
from the derscriptor tree. If Generate index page is checked, an alphabetically sorted index
with links to the individual description pages will be generated. You may Hide descriptor
status data in the generated forms (only visible in Web browser, not in the preview). With
options Include notes and Include modifier/frequency you can control if notes and
modifier or frequency values shall be included in the generated questionaires. 

Check Include resources to include images for descriptions, descriptors, categorical states
and descriptor tree nodes in the questionnaire. In the generated HTML questionnaire the
images will be zoomed by a dedicated factor, when the mouse cursor is moved over it. The
zoom factors may be adjusted by clicking on button (see image below on the left). 
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Check Include scopes to include a section for scope data in the questionnare. The scope
values of the types "Sex", "Stage", "Part" and "Other scopes", which may be administered in
the Edit project section, are included as check boxes. For the other scope types input boxes
will be generated, where new values may be entered or existing values may be edited. If a
scope value has been linked to a database entry, e.g. of a DiversityTaxonNames database, it
cannot be modified. Therefore only a fixed text with the reference to the target database will
be inserted in the questionnaire. By clicking on button you may decide for with scope types
an input box for a new scope values shall be inserted or if scopes that cannot be modified
shall be displayed (see image above on the right). 

If for the selected projects translations are stored in the database, you may chose the 
Export language. If for any element no translation in the chosen export language is present,
automatically the original text will be used. With field Language settings you can control the
presentation of floating point values in the output, in field Send answer to you may enter the
mail address to return the results. The Colors of several elements may be adapted to the
personal preferences. Finally, the Layout options Hide state no. rsp. Hide descriptor no.
my be checked to suppress the ordinal numbers before the desriptor titles and/or the state
check boxes.  

 

Test 

To check the export, click on the Test export button. In the Output preview section an
empty form for entering a new item will be displayed (see picture below). The file name is
generated as <resources directory>\Questionnaires\<Database name>_<Project>.txt
. This default setting may be changed by editing the File name or by navigating at the target
location by pressing the button besides the file name. Button opens the form in an
external web browser. 
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Export 

Before starting the export, the export file name should be checked. The file name is generated
as <resources directory>\Questionaires\<Database name>_<Project>.txt. This
default setting may be changed by editing the File name or by navigating at the target
location by pressing the button besides the file name. To the selected name the description
id rsp. "_Index" will be appended for the generated file. 
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To generate the HTML files press the Start export button. During export the icon of the
button changes to  and you may abort processing by clicking the button. Button opens
the form visible in the Output preview section in an external web browser (see image
above). 

 

Send reply 

When you opened a HTML form in the web browser and modified data, you may download
them as a text file for database import. At the bottom of the HTMS form click the button
Download revised description (see image below). Since data collection is done using
javascript, please take care that the script is not blocked by the web browser. 
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Export CSV
Notes:

 The Export CSV function provides a direct copy of selected database table as
tabulator separated text file. If you want to generate flles that give a strutured
overview of descriptors or description data, you should prefer the Export ... Lists or
the Export Wizard (coming soon). 

 The Export CSV function requires the "Bulk Copy" tool, which is part of a local
Microsoft SQL Server installation. If "Bulk Copy" is not available on your computer, you
will get an error message after opening the window. 

To export the tables of the database in the a tabulator, comma or semicolon separated
format, choose Data -> Export -> Export CSV ... from the menu. A window as shown
below will open where you can select the tables to be exported in sections Selection criteria
and in the Tables for export. 

To start the export click on the Start export button. By default the data will be exported
into a directory <working directory>\Export\<database_name>. Click on the button
to select a different target directory before starting export. 
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After export the tables are marked with green backgound, if table schema and data were
exported successfully. If only the data were exported, this is marked with yellow background,
if nothing was exported, the background is red. A detailled export report can be viewd by a
click on the export result file name.  
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File operations
Without any database access data files may be converted in the following directions: 

Convert SDD file: Read an XML file according to the SDD schema 1.1 rev 5 and generate
DELTA or EML files. 

Convert DELTA file: Read DELTA text file(s) and generate SDD or EML files. 

Additionally XML file check tools are available: 

Check SDD file: Check if a text file is an XML file according to the SDD schema 1.1 rev 5. 

Check EML file: Check if a text file is an XML file according to the EML schema 2.1.1. 
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Convert SDD file to DELTA or EML
With this form you can directly convert data from a file in XML file according schema SDD 1.1
rev 5 into a DELTA file. No connection to a database is needed for the conversion. Choose
Data -> File operations -> Convert data file -> SDD to DELTA ... from the menu to
open the window. In the window click on the button to select the file with the data you
want to convert. If during analysis any problem occurs, you may click on the button to
reload the file and re-initialize the window. 

 

The contents of the file will be shown in the upper part of the File tree tab page. In the
Analysis settings part you find the documents' default language. If additional laguages are
contained in the document, you may select one of them as the new language of the DELTA
file. By checking Import translations you select all additional document languages for the
analysis step. This option is automatically pre-selected if more than one language has been
found in the file. In the bottom part of the window you find the actual processing state.

In the file tree you may deselect entries that shall not be imported into the database. Use
that option very carefully, because if you deselect entries that are being referenced by other
parts of the input tree, e.g. descriptors referenced by descriptions, the analysis step might
become erronous! 

 

Analysis 

To analyse the data in the file click on the Analyse data button. During the analysis the
program checks the dependencies between the different parts of the data and builds up an
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analysis tree in the lower part of the window. The analysis tree contains all data in a suitable
format for the final step. During data analysis the icon of the button changes to  and you
may abort processing by clicking the button.  

 

After analysis a message window informs you if any warnings or errors occured. You can find
detailled error and warning information at the file and/or analysis trees by entries with red text
(error) or yellow background (warning). When you move the mouse curser over the marked
entries, you get additional information as tool tip or the tree node text itself tells the problem
(see examples below). By clicking on the status text besides the progress bar, you can open
an analysis protocol (see below, right). 

 

 

If an analysis error occured, you are not able to proceed. You will first have to correct the
problem, e.g. by excluding the erronous descriptor in the example above (after reloading the
file). If a warning occured, it might not cause further problems, but you should take a closer
look if the converted data will be correct.

Page 446



 

Write data 

Pressing the Generate file button in the Write Delta group box opens a window to select
the target delta file. By default the target file has the same name as the SDD file, followed by
the extension ".dat". The Comptible option controls generation of files with most possible
compatibility to the DELTA standard. On the other hand some data might not be present in
the generated file, if this option is activated. 

As an additional option you may generate file according the EML schema, which consists of a
data table (tabulator separated text file) and an XML file that contains the metadata including
column descriptions. Click on the Generate file button in the Write EML group box. The
generated file names will have the endings "_EML_DataTable.txt" and
"_EML_Metadata.xml". 

Pressing the drop down button DELTA settings in the Write DELTA group box opens the
DELTA writer options. You can chose to include some detail text and notes in the DELTA
output (see left image below). For descriptions, descriptors or categorical states the details
will be appended as DELTA comments (included in angle brackets "< ... >") to the respective
titles. The notes will be appended as DELTA comments of the corresponding summary data. If
you already generated DELTA files, the used settings will be automatically saved and you may
restore them using the option Load last write settings. Finally click button DELTA
settings to close the option panel.  

Pressing the drop down button EML settings in the Write EML group box opens the EML
writer options. You can chose to include a special sign for empty column values or set the
columns values in quotes (see right image above). Furthermore you may shose the column
separator (tab stop rsp. comma) an decide if multiple categorical states shall be inserted as
separate data columns. If you already generated EML files, the used settings will be
automatically saved and you may restore them using the option Load last write settings.
Finally click button EML settings to close the option panel.  

 

Handling of special sequence data 

Page 447

https://knb.ecoinformatics.org/#external//emlparser/docs/eml-2.1.1/index.html


While SDD can handle molecular sequence data, for DELTA export these data will be exported
as text data. To preserve the sequence specific descriptor data, they will be inserted into the
text character as a special comment with the format, e.g. "#6. Sequence descriptor <
[SequenceCharacter][ST:N][SL:1][GS:-][/SequenceCharacter]>/". 

If the analysis tree includes sample data, they will be included as items at the end of the
DELTA file. The naming of those spetial items will be <description name> - <event name>
- Unit <number>. Sampling event data will not be included in the DELTA file. 
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Convert DELTA file to SDD or EML
With this form you can directly convert data from a file in DELTA format into an XML file
according schema SDD 1.1 rev 5. No connection to a database is needed for the conversion.
Choose Data -> File operations -> Convert data file -> DELTA to SDD ... from the
menu to open the window. In the window click on the button to select the file with the
data you want to convert. If the Multi-file option is selected before pressing the button, a
folder selection window opens to select the folder where the DELTA files are located. For
muti-file processing currently the files "chars", "items", "specs" and "extra" are evaluated. If
during analysis any problem occurs, you may click on the button to reload the file and
re-initialize the window. 

 

The contents of the file will be shown in the upper part of the File tree tab page. If special
characters are not displayed corretly, try a different Encoding setting, e.g. "ANSI", and
reload the document using the button. 

The Insert "variable" state controls the handling of the DELTA state "V" for categorical
summary data. If possible, a categorical state "variable" is inserted to the descriptor data and
set in the summary data, when the state "V" is present in the description data. 

If the Check strings for illegal characters  option is checked, all string literals that shall be
exported from database are scanned for illegal non-printable characters and matches are
replaced by a double exclamation mark ("‼"). Activating this option may increase the analysis
processing time.

In the file tree you may deselect entries that shall not be converted. Use that option very
carefully, because if you deselect entries that are being referenced by other parts of the
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input tree, e.g. descriptors referenced by descriptions, the analysis step might become
erronous! 

If during reading of the files expressions cannot be interpreted, suspicious entries are maked
with yellow background (warning) in the file tree. When you move the mouse curser over the
marked entries, you get additional information as tool tip or the tree node text itself tells the
problem (see example below).  

 

 

Analysis 

To analyse the data in the file click on the Analyse data button. During the analysis the
program checks the dependencies between the different parts of the data and builds up an
analysis tree in the lower part of the window. The analysis tree contains all data in a suitable
format for the final step. During data analysis the icon of the button changes to  and you
may abort processing by clicking the button.  

In the Analysis settings section (see image below) you set the document's Language. You
man change the display and sorting of the entries in the Language combo box from "<code>
- <description>" to "<description> - <code>" (and back) by clicking the button . If you
need language codes that are not included in the list, click the button. For more details
see Edit language codes. 

The Insert "variable" state controls the handling of the DELTA state "V" for categorical
summary data. If possible, a categorical state "variable" is inserted to the descriptor data and
set in the summary data, when the state "V" is present in the description data. 

If the Check strings for illegal characters  option is checked, all string literals that shall be
exported from database are scanned for illegal non-printable characters and matches are
replaced by a double exclamation mark ("‼"). Activating this option may increase the analysis
processing time.

In DELTA text in angle bracket (<text>) usually denotes comments, which are by default
imported into the "Details" fields of the database. In the lower parts of the Analysis settings
you may adjust a different handling for description, descriptor and categorical state items.  

 For DELTA comments in descriptions you may Move comments to details (default)
or Keep comments in description titles. 

 For DELTA comments in descriptors you may Move comments to details
(default), Move comments to notes or Keep comments in descriptor titles.  

 For DELTA comments in categorical states you may Move comments to details
(default) or Keep comments in categorical state titles. 

After changing one of these settings click on the Analyse data button to make the
changes effective. 
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After analysis a message window informs you if any warnings or errors occured. You can find
detailled error and warning information at the file and/or analysis trees by entries with red text
(error) or yellow background (warning). When you move the mouse curser over the marked
entries, you get additional information as bubble help or the tree node text itself tells the
problem (see example below). By clicking on the status text besides the progress bar, you can
open an analysis protocol (see below, right). 

 

If an analysis error occured, you are not able to proceed. You will first have to correct the
problem, e.g. by excluding the erronous descriptor in the example above (after reloading the
file). If a warning occured, it might not cause further problems, but you should take a closer
look if the converted data will be correct.

 

Write data 
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Pressing the Generate file button in the Write SDD group box opens a window to select
the target XML file. By default the target file has the same name as the DELTA file, followed
by the extension ".xml". The Comptible option controls generation of files with most possible
compatibility to the SDD standard. On the other hand some data might not be present in the
generated file, if this option is activated. 

As an additional option you may generate file according the EML schema, which consists of a
data table (tabulator separated text file) and an XML file that contains the metadata including
column descriptions. Click on the Generate file button in the Write EML group box. The
generated file names will have the endings "_EML_DataTable.txt" and
"_EML_Metadata.xml". 

Pressing the drop down button EML settings in the Write EML group box opens the EML
writer options. You can chose to include a special sign for empty column values or set the
columns values in quotes (see left image below). Furthermore you may shose the column
separator (tab stop rsp. comma) an decide if multiple categorical states shall be inserted as
separate data columns. If you already generated EML files, the used settings will be
automatically saved and you may restore them using the option Load last write settings.
Finally click button EML settings to close the option panel.  

  

 

Handling of special DELTA states 

In the DELTA format the special states "-" (not applicable), "U" (unknown) and "V" (variable)
are available for categorical and quantitative characters. These states are treated in the
folloging manner during import:

 "-" (not applicable) 
The data status "Not applicable" is set. 

 "U" (unknown)
The data status "Data unavailable" is set. 

 "V" (variable) 
The data status "Not interpreterable" is set. 
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Check SDD file
With this form you can check if an XML file is compliant to the SDD 1.1 rev 5 schema. Choose
Data -> File operations -> Check SDD file ... from the menu. After opening the
window shown below the schema files will be automatically loaded. 

 

In the window click on the button to select the file you want to check. The check results
will be diplayed in the center part of the window. If you generated a SDD file using Diversity
Descriptions with deactivated Comptible option, the check result may show warnings for
elements with missing schema information. You may check the option Include specific
schema extensions, then the Diversity Descriptions specific schema definitions will be
included. By clicking the reload button  or selecting another file you can start a new check
(see image below).   
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Check EML file
With this form you can check if an XML file is compliant to the EML 2.1.1 schema. Choose
Data -> File operations -> Check EML file ... from the menu. After opening the
window shown below the schema files will be automatically loaded. 

 

In the window click on the button to select the file you want to check. The check results
will be diplayed in the center part of the window. By clicking the reload button  you can
start a new check (see image below).   

Page 455

https://knb.ecoinformatics.org/#external//emlparser/docs/eml-2.1.1/index.html


 

Page 456



Cache database
The cache databases for DiversityDescriptions are designed as sources for preformatted data
for publication in e.g. public user portals like GBIF. The cache database by default has a name
corresponding to the main source database, e.g. DiversityDescriptionsCache and is located on
the same server. By itself it is the source for the data in Postgres (Version 10 or above)
cache databases located on any Windows or Linux server (see image below). An overview for
the basic steps is provided in chapter Basic steps for publication of data via the cache
database. 

 

 

Generating the cache database 

To create a cache database you need to be a system administrator (s. Login administration).
The creation of the cache database is described in the chapter Creation of the cache
database. 

 

Projects 

The publication and transfer of the data is always related to a local project . Every local
project has its own database schema containing the data tables etc. The metadata are
defined via settings in a DiversityProjects database. The Projects module provides a stable
identifier for each Project. The basic address has to be set in the Project module (choose
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Administration - Stable identifier ... in the menu). Please turn to the module DiverisityProjects
for further information. The metadata will be transferred into a table in the cache database.
For further details see chapter Projects in the cache database. 

 

Collections, references, taxonomy and other sources 

As well as data from DiversityDescriptions, data from other modules like DiversityCollection
containing specimen or observations, DiversityReferences containing citations and
DiversityTaxonNames containing the taxonomy, including accepted names and synonyms are
transferred into the cache database and may be retrieved from the local server or a linked
server. The data of these sources are stored and transferred independent from the project
data. 
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Basic steps for publication of data via the
cache database 
1 - Create the cache database 

To create a cache database as shown in the chapter Creation of the cache databasee you
need to be a system administrator (s. Login administration). After this step the cache
database should be available and you can create a Postgres database as final target of your
data. 

2 - Create a Postgres database 

The final formatting of the data e.g. for publication via webservice are performed in a Postgres
database. If no server providing Postgres is available, you may install Postgres on your local
machine (see https://www.postgresql.org/ for further information). The creation and
administration of a Postgres database is described in chapter Administration of the Postgres
cache databasess. 

3 - Insert sources for taxonomic names, collection specimen, references etc. 

This step is optional and depends upon the availability of a source for e.g. taxonomic names.
You may either use sources from your local server or the public available sources provided by
tnt.diversityworkbench.de (turn to http://www.snsb.info for further information). The needed
settings are described in chapter Sources from other modules.   

4 - Insert a project 

The data published in the cache database are organized according to the (local) projects. Add
a project as shown in chapter Projects in the cache database. Check the Mapping of IDs in
the source database and make sure that the data within this project are not withheld from
publication and that the ranges you want to publish are set properly (see chapter Restrictions
for the datatransfer into the cache database).   

5 - Transfer the data 

The final transfer of the data is described in chapter Sources for other modules and chapter
Transfer of the data. 

6 - Publish or export the data 

To export the data or prepare them for publication according to the specifications of
webservices etc. the data frequently need to be formatted. This is done with packages as
described in chapter Administration of the Packages. 
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Create the cache database 
To create a cache database you need to be a system administrator (s. Login administration).
To create the cache database, choose Data -> Cache database .... from the menu. If so
far no cache database exists, you will be asked if a new one should be generated. After the
generation of the cache database a window as shown below will open. 

Click on the Update button to update the database to the latest version. A window as
shown below will open. Click on Start updatee to execute all the scripts needed for the
latest version of the database. 

You may now continue with the Administration of the Postgres cache databasess or insert
Sources from other modules. Anyway, close and re-open the cache database window before
you insert Projects in the cache database. 
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Sources from other modules
Currently not yet supported! 
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Projects in the cache database
The data transferred into the cache database are always transferred according to a project
they belong to. Choose Data -> Cache database ... from the menu and select the tab 
Projects. If no projects were added so far the window will appear like shown below. 

To add a new project for the transfer into the cache database, click on the Add project 
button. In the area below a new entry as shown below will appear. The area on the right
shows the number of datasets in the project in the source database together with the date of
the last update. To ensure the separation of the data between the projects,
DiversityDescriptions creates a separate schema for every project named Project_[name of
the project] together with needed roles, tables etc.. 

Before transferring data you have to update the project schema to the latest version,
indicated by the appearance of an update button . Click on the button to open a window
as shown below. Click on the Start update button to update the schema to the latest
version. For adding a project and performing the database update you need to be a system
administrator (s. Login administration).  

Page 462



After the update the database is ready to transfer data into.  
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But before starting the cache transfer you should take a look on the ID mapping, data
withholding and data restrictions. The first two items are stored in the descriptions
database, the latter in the cache database.

With the ID mapping you can determine how description items, descriptors and categorical
states shall be identified in the cach database and how changes are handled in subsequent
cache transfers. Click on the button to edit the ID mapping behaviour for the data of the
project (see below). 

If any descriptors are marked with the data status Data withheld, you have the options to
exclude the whole description the export, to hide only the marked descriptor data or to export
the whole dataset. Click on the button to edit the data withholding behaviour for the data
of the project (see below). 

Besides the restrictions in the source database, you can set further data restrictions for this
transfer. Click on the button and choose the data restrictions for the cache transfer (see
below). 
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To transfer the data you have 3 options as described in the Transfer chapter.

Afterwards the number and date of the transferred data are visible as shown below. 

To inspect the transferred data use the View content button. A window as shown below
will open where all tables containing the data of the project are listed. 
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Click on the button to filter the content. A window as shown below will open. Choose the
column for the filter, the operator (e.g. = ) and the filter value (see below). 

Now click on the button to add the filter criteria to the table filter. You may add as many
criteria as needed (see below). With the button you can clear the filter.. 

Before you can transfer the data into the Postgres database, you have to connect to the
Postgres database and click on the button to establish the project and run necessary
updates . After the project is established and up to date, use the button to transfer the
data in the Postgres area (see below).
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If a project is exported into another Postgres database on the same server, these
databases will be listed underneath the Postgres block (see image below). For an overview of
all target Postgres databases click on the button. 

If the target is placed on the current server, the text will appear in black (see image below).
Packages will be listed for the other targets as well. 

In the Postgres database you can install packages to adapt the data to any needed
format. 
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Mapping of IDs for the data transfer into the
cache database 
In the Diversity Descriptions database the main tables Description, Descriptor and
CategoricalState have a numeric "id" as key, which is set by the MS SQL server when the
dataset ist crated. All relations between the tables are set by using these unique values. For
various reasons those internal IDs are not seen as suitable for all purposes of the cache
database. Therefore a mapping of the internal IDs is performed before the transfer of data to
the cache database. 

 

Default mapping

The default mapping of the IDs is mainly oriented on the way the states and characters are
identified in the widely spread DELTA standard:

 Descriptors are numbered starting with "1" in ascending order and transferred into the
cache database table CacheCharacter. The order is determined by the descriptor
parameter "display_order" and the alphabetical order. The original "id" is stored as
"CharID" in the target table, the descriptor number as "CID". 

 CategoricalStates are numbered for each character starting with "1" in ascending
order and transferred into the cache database table CacheState. The order is
determined by the categorical state parameter "display_order" and the alphabetical
order. The original "id" is stored as "StateID" in the target table, the categorical state
number as "CS". 

 Since the categorical state numbers ("CS") are not unique, each state is identified,
e.g. in a description item, by the character and state number ("CID", "CS").

 Descriptions are numbered starting with "1" in ascending order and transferred into
the cache database table CacheItem. The order is determined by the alphabetical
order. The original "id" is stored as "ItemID" in the target table, the description number
as "IID". As an alternative the "IID" may be derived from the field "alternate_id" of the
"Description" table (see following section. 

The mapping data are stored related to the project in the tables CacheMappingDescriptor,
CacheMappingState and CacheMappingDescription of the original database.   

 

Mapping adjustment

To set the mapping adjustments, click on the  button (see below).

A window as shown below will open.
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If no option is selected, the default mapping algorithm described above will be performed for
every transfer to the cache database. Any changes, e.g. insertion of a descriptor or
re-arrangement of categorical states, will affect the "CID", "CS" and "IID" of the cache
database. 

If option Keep fixed IDs after first export is selected, the default mapping algorithm
described above will be performed only for the first transfer to the cache database. Any
changes, e.g. insertion of a descriptor or re-arrangement of categorical states, will NOT
affect the "CID", "CS" and "IID" of the cache database. New elements will get a number higher
than the last one present. If an element is deleted, this will result in "missing" numbers in the
cache database. Pure re-arrangements will have no effect. 

The last option Take "IID" from "AID" field only affects the description mapping. By default
the descriptions are numbered in alphabetical order. If this option is chosen, it is tried to use
the field "alternate_id" ("AID" in the GUI) as item number. Preconditions are that the "AID" is a
pure number and that the values are unique. If the "AID" is not supplied or an alpha-numeric
string or if the number is already occupied, a new ascending value will be set. By using this
option a foreign numbering scheme may be used for the cache database.   
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Restrictions for the data transfer into the
cache database 
The restrictions of the published data are defined in the main database via local projects 
and data withholding . In the cache database further restrictions can be set for every
project. You may set a filter on description data to restrict the Descriptions, select the

Descriptors and the Scopes that are transferred. 

To set the restrictions, click on the  button (see below).

A window as shown in the following sections will open.

 

Descriptions tab

The Descriptions filter works mainly the same way as the Extended query. Use button 
Add filter item to insert a filter item, select the descriptor and set the filter conditions. With
button Remove filter item you may remove the currently selected filter item. In the lower
right corner Matches: shows you the current count of description items that match the
adjusted filter criteria. In the center part the resulting SQL filter is shown. 
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Descriptors tab

With the Descriptors filter you can select the descriptors for which summary data shall be
transferred. Use button the arrow buttons  << ,   <  ,   >   and  >>  for moving the entries
between the Not published and Published list. Click button Transfer existing to move all
descriptors that are used within the database to the Published list. 
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Scopes tab

With the Scope filter you can select the scope type for description scopes shall be
transferred. Use button the arrow buttons   <   and   >   for moving the entries between the
Not published and Published list. Click button Transfer existing to move all scope types
that are used within the database to the Published list. 
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Maintenance
To open the maintenance form choose Administration -> Database ... -> 
Maintenance ... from the menu. The maintenance form offers functions for evaluation and
update of multiple datasets that can hardly be achieved by the regular editing options, which
focus on a single dataset. Currently the functions Synchronize databases, Update
description scopes, Update resource data, Maintain descriptor trees, Maintain
descriptors and Maintain descriptive data are available. 

With the button  you can set the timeout for critical database queries, with the button 
 you can set the timeout for web requests used within maintenance. Feedbacks can be sent
with the button .
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Maintenance - Synchronize databases
To open the maintenance form choose Administration -> Database ... -> 
Maintenance ... from the menu and select the Synchronize databases tab. With the
maintenance functions you can update values cached from other modules or external
webservices. Entries in Diversity Descriptions can be linked with several other modules of the
Diversity Workbench, e.g. by the Description scopes. If you link a data source to another
module, the URI of the data set in the other module together with one or several cached
values will be stored in Diversity Descriptions. Due to changes in the source modules these
cached values may differ from the original values. To get the actual values you can use the 
synchronize functions for taxonomic names, specimen and observations,  geographical
names and references. Additionally broken links can be searched an repaired.

 

Commonly used database synchronization options

In the sub-panels several commonly used options and controls are available. First the source
database must be selected, where the referenced data are stored. In the example shown
below this is the Taxonomy database. Click on button to open the connections
administration form where you may connect missing databases. The second parameter that
has to be specified is the Descriptions project that contains the datasets which have to be
checked or updated. If datasets of Diversity Descriptions are not yet linked to another
module, the project of the source database may be specified (Taxonomy project in example
below).
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By starting a query (button Check for differences, Check for identical names or Start
check) you will get a result list of database entries that can be updated (see image below).
In this example the first result entry represents two datasets in Diversity Descriptions
(column Number). In column DescriptionIds the range of the affected database internal IDs
is shown. You may select or deselect single entries of the result list for the database update
in column OK. 

The size of the query result list may be adapted by changing the value Number of results or
unchecking this option to get the complete list (see image below). If datasets of Diversity
Descriptions are not yet linked to another module, the query in Diversity Descriptions may be
restricted by specifying a value in the field Restrict to names starting with. You may select
or deselect all entries of the result list for the database update by clicking the buttons 
Select all rsp. Select none.  

If you select the option Include description IDs the button Inspect dataset will be
shown. By starting a new query (button ) the result list will now include the columns
Description and DescriptionID instead of DescriptionIds and Number (see image below).
Furthermore each dataset entry will now be shown in an own result line. By selecting an entry
and clicking the button Inspect dataset you may directly navigate to that dataset.  
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Maintenance - Taxonomic names
To synchronize the entries for the taxonomic names derived from the module
DiversityTaxonNames select the Synchronize databases tab and choose the tab 
Descriptions <-> TaxonNames. There are two ways to synchronize taxonomic names. You
may either Synchronize taxonomic names linked to an external data source for entries
where the link to a taxonomic database is already established or you may Synchronize
taxonomic names missing a connection where no link is established and you can query for
identical names in one of the databases. The meaning of some generally used controls is
explained in the introduction page of database synchronization. 

Synchronize taxonomic names linked to an external data source

The taxonomic names are stored as field "label" of table DescriptionScope, where the scope
type TaxonName is specified. Select a taxonomy database and the descriptions project that

shall be synchronized. Start the query with a click on the  button. 

 

The form will list all differences found. To update the database click on the 
button. 

 

Synchronize taxonomic names missing a connection

Select a taxonomic database, optionally a project within this database and a project in the
descriptions database to search for identical names. Start the query with a click on the 
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 button. You may either restrict the search to an exact match
(= Compare whole name) or to the first parts of the name (= Compare first parts) as
shown below. If the names do not match exactly, you may either update the name (= Update
similar name) in the descriptions database or import the name from the DiversityTaxonNames
as a new scope (= Insert as new name - see options in the window depicted below). In the
result list only matching names will be checked (column OK). The other results will be marked
indicating the difference. Yellow indicates a difference in the authors while red indicates
differences in main parts of the name. To use these similar names check them in the OK
column. 

 

The form will list all matches found. To insert the links to the database click on the 

button. 
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Maintenance - Collection
To synchronize the entries for the specimen or observations derived from the module
DiversityCollection select the Synchronize databases tab and choose the tab 
Descriptions <-> Collection. There are two ways to synchronize specimen and
observations. You may either Synchronize entities with a link to DiversityCollection for
entries where the link to a taxonomic database is already established or you may 
Synchronize entities missing a link to DiversityCollection where no link is established and
you can query for identical names in one of the databases. The meaning of some generally
used controls is explained in the introduction page of database synchronization. 

Synchronize entities with a link to DiversityCollection

The specimen and observations are stored as field "label" of table DescriptionScope, where the
scope type Specimen or Observation specified. Alternatively the field collection_specimen of
table SamplingUnit can be updated. Select a collection database, the descriptions project and
the scope type that shall be synchronized. Start the query with a click on the 

 button. 

 

The form will list all differences found. To update the database click on the 
button. 

 

Synchronize entities missing a link to DiversityCollection
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Select the collection database, optionally a project within this database, a project in the
descriptions database, the descriptions teble and the scope type Specimen or Observation to

search for identical names. Start the query with a click on the 
button. To use these similar names check them in the OK column. 

 

The form will list all matches found. To insert the links to the database click on the 

button. 
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Maintenance - Gazetteers
To synchronize the entries for the geographic places derived from the module
DiversityGazetteers select the Synchronize databases tab and choose the tab 
Descriptions <-> Gazetteers. There are two ways to synchronize geographic names. You
may either Synchronize places linked to DiversityGazetteers for entries where the link to
a gazetteers database is already established or you may Synchronize places missing a link
to DiversityGazetteers where no link is established and you can query for identical names in
one of the databases. The meaning of some generally used controls is explained in the 
introduction page of database synchronization. 

Synchronize places linked to DiversityGazetteers

The geographic names are stored as field "label" of table Description scope with the scope
type GeographicArea or in filed "geographic_area" of table SamplingEvent. Select a gazetteers
database, the descriptions project and the descriptions table that shall be synchronized. Start

the query with a click on the  button. 

 

The form will list all differences found. To update the database click on the 
button. 

 

Synchronize places missing a link to DiversityGazetteers

Select the gazetteers database, optionally a project within this databas, a project in the
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descriptions database and the descriptions table to search for identical names. Start the
query with a click on the  Start check button. To use these similar names check them in
the OK column. 

Many places have identical names in different regions. Names where several results were
found are marked in blue. To choose the correct name among the list of results, click on the 

 Select name button and select the correct name from the list as shown below. 

Finally, click on the button to enter the results in the database. 
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Maintenance - References
To synchronize the titles of the references which are linked to the module DiversityReferences
select the Synchronize databases tab and choose the tab Descriptions <->
References. Select the references database and the project for which the reference titles
should be synchronized. The references are stored as field "label" of table DescriptionScope,
where the scope type Citation is specified. The meaning of some generally used controls is
explained in the introduction page of database synchronization. 

Start the query with a click on the  button. 

The form will list all differences found. To update the database click on the 
button.
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Maintenance - Broken links
Broken links to other databases occur when the database's name has been change or if it was
moved to a different server. To find and repair broken links to the modules of the Diversity
Workbench select the Synchronize databases tab and choose the tab Broken links.
The meaning of some generally used controls is explained in the introduction page of database
synchronization.  

Select the Link type, e.g. "Taxon name" to search broken links to DiversityTaxonNames and
the Descriptions project. Start the query with a click on the Search for broken links 
button. If the link type "Geographic area" or "Specimen" has been selected, an additional
selection box for the Descriptions table appears, where you may select from "Description
scope" or " Sampling event" rsp. " Sampling unit". Each link of the selected type and project
will checked if it can be connected to the referenced database and unsuccessful connection
attemts will be listed in the data grid view (see image below). 

Keep in mind that the connection check might be unsuccessful for remote databases, if the
database connection was not set up before (see first and third entry in picture above)!  

If you prefer to remove some broken links, you may now select them and then click button 

. If you want to connect the links to a database, chose the new target in
combo box Database and click the Check matches in database button. The check is
successful, if the new databese contains an entry with the same ID and display text and the
results will be selected and shown with white background (see image below). 

Page 484



If in the new database a matching link was found but the display text differs, the entries are
marked  with yellow background. For these lines you should check the "New name" column and
if the found entry is applicable you may select the entry for update. If no matching entry in
the database was found, it is marked with grey background (see image above). To update the

database click on the button.

 

Delete unlinked scope entries

As an additional option you may search for unlinked scope entries and remove them
completely from the database. Select the the Seach for unlinked entries and then click on
the Search for broken links button. Deselect the entries you want to keep and click

button (see image below). 
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Maintenance - Update description scopes
To open the maintenance form choose Administration -> Database ... -> 
Maintenance ... from the menu and select the Update description scopes tab. If you
want to generate scope entries from description data, select the Generate scopes tab. To
find and delete empty scopes choose the Clean empty scopes tab.  
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Maintenance - Generate scopes
Especially if data are imported, e.g. from a DELTA file, data that can be stored as scope of a
description are often contained in dedicated text descriptor data. For taxonomic descriptions
generally the item/description names reflect the taxonomic names. To generate formal scopes
from such "embedded" data select the Update description scopes tab and choose the
tab Generate scopes.

Select the Scope type, e.g. "Taxon name" and the Project. You may generate the Scope
from description name or select a Source descriptor. Furthermore the whole source text
(description name or text descriptor data) may be selected (option Copy whole text) or only
the first parts (option Copy first parts). Click on Check for missing scopes and all
descriptions will be listed where no scope of the specified type is present and source data are
available (see image below). 

The size of the query result list may be adapted by changing the value Number of results or
unchecking this option to get the complete list (see image below). You may select or deselect
all entries of the result list for the database update by clicking the buttons Select all rsp.

Select none.  
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If you select the option Include description IDs the button Inspect dataset will be
shown. By starting a new query (button Check for missing scopes) the result list will now
include the column DescriptionID. By selecting an entry and clicking the button Inspect
dataset you may directly navigate to that dataset. To update the database click on the

button.
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Maintenance - Clean empty scopes
If you want to find and delete scope entries that do not contain any data, select the 
Update description scopes tab and choose the tab Clean empty scopes.

Select the Scope type, e.g. "Taxon name" and the Project. Click on Check for empty
scopes and all descriptions will be listed where no scope of the specified type is present
and source data are available (see image below). 

The size of the query result list may be adapted by changing the value Number of results or
unchecking this option to get the complete list. You may select or deselect all entries of the
result list for the database update by clicking the buttons Select all rsp. Select none.  

If you select the option Include description IDs and start a new query (button Check for
empty scopes) the result list will include the column DescriptionID. By selecting an entry
and clicking the button Inspect dataset you may directly navigate to that dataset. If you
click on button Close form and check list in database , you will return to the main form
and find the selected entries in the description result list.

To update the database click on the button.
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Maintenance - Update resource data
To open the maintenance form choose Administration -> Database ... -> 
Maintenance ... from the menu and select the Update resource data tab. In the
resource edit forms the resource data, e.g. the file size, of a single resource can be obtained
from the remote server addressed by the resource link. If for a large number of resouces the
data shall be updated it is much easier to select the Get resource data tab. To find and
delete empty resources choose the Clean empty resources tab.  
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Maintenance - Get resource data
In the resource edit forms the resource data, e.g. the file size, of a single resource can be
obtained from the remote server addressed by the resource link. If for a large number of
resouces the data shall be updated it is much easier to select the Update resource data
tab and choose the tab Get resource data.

Select the Resource target, ("Description", "Descriptor", "Categorical state" or "Descriptor
tree node"), the Resource type ("image", "audio", "video", "text", "application" or "other") and
the Project. Click on Check for missing resource data and all resource links of the
specified type will be listed where the remote data of ("Mime type", "File size", "Width",
"Height" or "Duration") differ from the database values (see image below). 

The size of the query result list may be adapted by changing the value Number of results or
unchecking this option to get the complete list. Usually only database links are checked that
do not have any entry for "File size", "Width", "Height" and "Duration". Select Check links with
data to check entries with data, e.g. to update manually entered values. You may select or
deselect all entries of the result list for the database update by clicking the buttons Select

all rsp. Select none. To update the database click on the button. 

You may open a table editor for the selected resource variants by clicking the Open table
editor button (see image below). 
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Some resources, especially for resource types like "text" or "application", do not even provide
a file size. Therefore you might not get any new matches for subsequent check and update
sequences if the number of results is limited. In those cases you should try to increase the
number of results or deactivate the Number of results option.
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Maintenance - Clean resources
In the database the "Resource" table holds the general resource data, e.g. copyright
information, and links the resource to the target entity. The "ResourceVariant" table holds the
link to the resource and allows to associate several links with distinguished quality levels to a
single resource. To find resource entries that are not associated with any resource variant
("empty resources"), select the Update resource data tab and choose the tab Clean
empty resources.

Select the Resource target ("Description", "Descriptor", "Categorical state" or "Descriptor
tree node") and the Project. Click on Check for empty resources and all resource links of
the specified type will be listed where no resource variants are present in the database (see
image below). 

You may select or deselect all entries of the result list for the database update by clicking the
buttons Select all rsp. Select none. To delete the selected resource entries from the

database click on the button. Instead of updating the selecting entries you
may click Close form and check list in database to return to the main program with the
corresponding data sets. 

You may open a table editor for the selected resources by clicking the Open table editor 
button (see image below). 
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Maintenance - Maintain descriptor trees
To open the maintenance form choose Administration -> Database ... -> 
Maintenance ... from the menu and select the Maintain descriptor trees tab. With the
descriptor trees the assignment of descriptors to certain projects is done. Furthermore it is
possible to administer the recommended statistical measures and modifiers for quantitive
descriptors and the recommended modifier and frequency values for categorical descriptors. If
a description item references entities that are not correctly assigned in the descriptor trees,
this can be seen in the continious view. In the tab Missing description entities you can
easily find and fix such kind of inconsistencies. Furthermore a centralized function to
administer Statistical measures,  Modifier values and Frequency values is provided.
Finally superfluous entries may be deleted by using the Clean descriptor trees tab.
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Maintenance - Missing description entities
To find description entities that are not correctly assigned to the project's descriptor trees,
select the Maintain descriptor trees tab and choose the tab Missing description
entities. Select the Project and the Entity type that shall be checked. Currently the
following entity types are supported:

 Descriptor - Search for descriptors that are referenced in the description data but not
assigned to the project's descriptor tree

 Statistical measure - Search for statistical measures that are referenced in the
description data but not assigned to the quantitative descriptor

 Modifier - Search for modifier values that are referenced in the description data but
not assigned to the quantitative rsp. categorical descriptor

 Frequency - Search for frequency values that are referenced in the description data
but not assigned to the categorical descriptor

By default the option Ignore inherited entities is checked, therefore only descriptors of the
own project and recommended values directly assigned to the project descriptor are
evaluated. If option Include description IDs is checked you will have the option to inspect
the found data sets after the query. Start the query with a click on the Check for missing
entities button. 

 

If you selected the option Include description IDs the button Inspect dataset will be
shown. By selecting an entry and clicking the button Inspect dataset you may directly
navigate to that dataset. 

Before database update select the Target descriptor tree where missing entities shall be
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inserted. By default only descriptor trees that are marked as "complete" are shown. You may
uncheck option Show only complete trees to display all present descriptor trees. 

To update the database click on the button. Instead of updating the
selected entries you may click Close form and check list in database to return to the
main program with the corresponding data sets. 
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Maintenance - Statistical measures
To administer the recommended statistical measures select the Maintain descriptor trees
tab and choose the tab Statistical measures. Select the Project and the Descriptor
tree that shall be checked and click on the Check for statistical measures button.
Behind the "Descriptor" column all used statistical measures are shown in the output table.
Descriptors that have not assigned any statistical measures are marked with yellow
background. Values that are not assigned for the selected descriptor tree but anyway
available in the project, e.g. due to a different descriptor tree or inherited by a superior tree
node, are diplayed with blue background (see image below). 

 

New values may be inserted in the table by selecting them in the check list on the left and
clicking the Add >> button. By clicking the button All >> rsp. None >> may check
or uncheck all checked values from the list box in the table. The buttons All project >>
and No project >> check or uncheck the project specific entries with blue background in
the table. If one or more lines in the output tables are selected (click on the fields before the
"OK" column), the mentioned functions operate only for the selected lines, otherways for the
whole table. With option Fix descriptor columns you may fix the first data grid columns to
scroll horizontally thru the value list.  

To store the modifications to the selected descriptor tree click on the 
button. Instead of updating the selected entries you may click Close form and check list in
database to return to the main program with the corresponding data sets.  

 

Page 499



Maintenance - Modifier values
To administer the recommended modifier values select the Maintain descriptor trees tab
and choose the tab Modifier values. Select the Project and the Descriptor tree that
shall be checked and click on the Check for modifier values button. Behind the
"Descriptor" column all used modifier values are shown in the output table. Values that are not
assigned for the selected descriptor tree but anyway available in the project, e.g. due to a
different descriptor tree or inherited by a superior tree node, are diplayed with blue
background (see image below). 

 

New values may be inserted in the table by selecting them in the check list on the left and
clicking the Add >> button. The check list shows the modifier values available in your
database. Additional values can be inserted in the Modifier/Frequency tabs of Edit descriptor
 or Edit project. By clicking the button All >> rsp. None >> may check or uncheck all
checked values from the list box in the table. The buttons All project >> and No
project >> check or uncheck the project specific entries with blue background in the table. If
one or more lines in the output tables are selected (click on the fields before the "OK"
column), the mentioned functions operate only for the selected lines, otherways for the whole
table. With option Fix descriptor columns you may fix the first data grid columns to scroll
horizontally thru the value list. 

To store the modifications to the selected descriptor tree click on the 
button. Instead of updating the selected entries you may click Close form and check list in
database to return to the main program with the corresponding data sets.  
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Maintenance - Frequency values
To administer the recommended frequency values select the Maintain descriptor trees
tab and choose the tab Frequency values. Select the Project and the Descriptor tree
that shall be checked and click on the Check for frequency values button. Behind the
"Descriptor" column all used frequency values are shown in the output table. Values that are
not assigned for the selected descriptor tree but anyway available in the project, e.g. due to
a different descriptor tree or inherited by a superior tree node, are diplayed with blue
background (see image below). 

 

New values may be inserted in the table by selecting them in the check list on the left and
clicking the Add >> button. The check list shows the frequency values available in your
database. Additional values can be inserted in the Modifier/Frequency tabs of Edit descriptor
 or Edit project. By clicking the button All >> rsp. None >> may check or uncheck all
checked values from the list box in the table. The buttons All project >> and No
project >> check or uncheck the project specific entries with blue background in the table. If
one or more lines in the output tables are selected (click on the fields before the "OK"
column), the mentioned functions operate only for the selected lines, otherways for the whole
table. With option Fix descriptor columns you may fix the first data grid columns to scroll
horizontally thru the value list.  

To store the modifications to the selected descriptor tree click on the 
button. Instead of updating the selected entries you may click Close form and check list in
database to return to the main program with the corresponding data sets. 
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Maintenance - Clean descriptor trees
To administer the recommended modifier values select the Maintain descriptor trees tab
and choose the tab Clean decriptor trees. Select the Project, the Descriptor tree and
the Entity type ("Statistical measure", "Modifier" or "Frequency") that shall be cleaned.
Currently three cleaning options are supported:

 Unsuitable recommended values - Clear recommended values the do not match the
descriptor type, e.g. statistical measures for a categorical descriptor. 

 Recommended values for tree nodes - Clear recommended values that are not
directly assigned to a descriptor, but a tree node. You should only perform this
operation if you are sure that the neccessary values have been directly assigned to
the approriate descriptors.   

 All values in the descriptor tree - Delete all recommended values. Only descriptor
trees can be selected for this option, that are not marked as "complete". You should
only perform this operation if you are sure that the neccessary values have been
assigned to a complete descriptor tree of the project.   

To start the search click on the Check for values to clean button.  

 

To start the update of the selected descriptor tree click on the button.  
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Maintenance - Maintain descriptors
To open the maintenance form choose Administration -> Database ... -> 
Maintenance ... from the menu and select the Maintain descriptors tab. In the 
Categorical states tab you may shift and copy categorical states to a different descriptor or
delete selected categorical states.   
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Maintenance - Categorical states
To shift and copy categorical states to a different descriptor or delete selected categorical
states, select the Maintain descriptors tab and choose the tab Categorical states. In
this panel you operate on the categorical states of the descriptors. If you want to shift or
copy categorical summary data in descriptions, please use Maintenance - Categorical summary
data.  

Select the Project, the Source descriptor and the Target descriptor. Click on Show
categorical state mapping and all categorical state values of the selected Source
descriptor will be listed in the upper table (see image below). Select the categorical states
you want to modify in column >>.

The following operations are available: 

 Delete the categorical state by leaving the Target state empty 
 Move the categorical state by entering the Target state
 Copy the categorical state by entering the Target state and selecting the New

column 

In case the categorical states are moved or copied, associated fields as abbreviation and
detail will be processed. State resources will not be copied.  

After adjusting the required operations for the selected categorical states click on Check for
categorical states and the number of affected summary and sampling data will be listed in
the lower table (see image above). For each State the Action (DELETE, MOVE or INSERT)
and New state are specified. You may select or deselect all entries of the result list for the
database update by clicking the buttons Select all rsp. Select none. To perform the
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selected operations click on the button. If  Instead updating the database
you may click Close form and check list in database to return to the main program with
the affected descriptions. 
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Maintenance - Maintain descriptive data
To open the maintenance form choose Administration -> Database ... -> 
Maintenance ... from the menu and select the Maintain descriptive data tab. In the 
Descriptor status data tab you may set or reset the descriptor status of a categorical
descriptor depending on the categorical states in its summary data. In the Categorical
summary data tab you may shift and copy categorical summary data to a different descriptor
or delete values for selected categorical states. In the Quantitative summary data tab you
may perform such operations concerning statistical measures. To find and delete corrupted
descriptive data choose the Clean descriptive data tab.  

 

Commonly used description selection options

In the sub-panels you may set a descriptor status and move or copy categorical rsp.
quantitative summary data. By default all descriptions from the selected project will be
searched that fulfill the specified conditions, i.e. a certain categorical state or statistical
measure. In certain cases it is neccessary to restrict the possibly affected descriptions by
some additional conditions. For this purpose there is the option to define a restriction and/or
an exclusion list (see example below).
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By starting an extended query (button ) you can generate a list of descriptions (see image
below) that shall be used to restrict the search rsp. excluded from the search. 

The resulting numbers of restricted and excluded descriptions will be displayed in the controls.
You may check the selected items by double-clicking the numbers  (see images below below). 
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Maintenance - Descriptor status data
To set or reset a certain descriptor status for dedicated categorical summary data, select
the Maintain descriptive data tab and choose the tab Descriptor status data.  

Select the Project, the Source descriptor and the Target descriptor status. Select the
Categorical state value for which the data status shall be set or reset and the requested
Action.

After adjusting the required operations for the selected categorical state click on Check for
descriptor status and all affected summary data will be listed in the lower table (see
image above). For each affected Description and State of the categorical summary data the
Action (DELETE or INSERT) and the Status are specified. If you check the option No state
selected, you may search for descriptions that do not reference any state of the Source
descriptor and set the data status of the selected Source descriptor (see image below).  
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You may select or deselect all entries of the result list for the database update by clicking the
buttons Select all rsp. Select none. To perform the selected operations click on the

button. If  Instead updating the database you may click Close form and
check list in database to return to the main program with the affected descriptions. 

 

Page 513



Maintenance - Categorical summary data
To shift and copy categorical summary data to a different descriptor or delete values for
selected categorical states, select the Maintain descriptive data tab and choose the
tab Categorical summary data. In this panel you operate on the categorical summary
data of the descriptions. If you want to shift or copy categorical states between descriptors,
please use Maintenance - Categorical states.  

Select the Project, the Source descriptor and the Target descriptor. Click on Show
categorical state mapping and all categorical state values of the selected Source
descriptor will be listed in the upper table (see image below). Select the categorical states
for which you want to modify the summary data in column >>.

The following operations are available: 

 Delete the summary data by leaving the Target state empty 
 Move the summary data by selecting the Target state
 Copy the summary data by selecting the Target state and selecting the New column 

In case the summary data are moved or copied, all relevant data including modifier and
frequency values and notes will be processed.  

After adjusting the required operations for the selected categorical states click on Check for
categorical states and all affected summary data will be listed in the lower table (see
image above). For each affected Description and State of the categorical summary data the
Action (DELETE, MOVE or INSERT) and New state are specified. If you check the option No
state selected, you may search for descriptions that do not reference any state of the
Source descriptor and set a state of the selected Target descriptor (see image below).  
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You may select or deselect all entries of the result list for the database update by clicking the
buttons Select all rsp. Select none. To perform the selected operations click on the

button. If  Instead updating the database you may click Close form and
check list in database to return to the main program with the affected descriptions. 
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Maintenance - Quantitative summary data
To shift and copy quantitative summary data to a different descriptor or delete values for
selected statistical measures, select the Maintain descriptive data tab and choose the
tab Quantitative summary data.  

Select the Project, the Source descriptor and the Target descriptor. Click on Show
statistical measure mapping and the assigned statistical measures of the selected
Source descriptor will be listed in the upper table (see image below). If you want so process
all available statistical measures, not only that ones assigned to the descriptors in the
descriptor tree, check Show all source measures rsp. Show all target measures. Select
the statistical measures for which you want to modify the summary data in column >>.

The following operations are available: 

 Delete the summary data by leaving the Target statistical measure empty 
 Move the summary data by selecting the Target statistical measure
 Copy the summary data by selecting the Target statistical measure and selecting

the New column 

In case the summary data are moved or copied, all relevant data including modifier values and
notes will be processed.  

After adjusting the required operations for the selected categorical states click on Check for
statistical measures and all affected summary data will be listed in the lower table (see
image above). For each affected Description and Measure of the quantitative summary data
the Action (DELETE, MOVE or INSERT) an New measure are specified. You may select or
deselect all entries of the result list for the database update by clicking the buttons Select
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all rsp. Select none. To perform the selected operations click on the 
button. If  Instead updating the database you may click Close form and check list in
database to return to the main program with the affected descriptions. 
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Maintenance - Clean descriptive data
Descriptive data, which can be summary or sampling data, are stored in the database in
several tables, that reference the corresponding descriptor rsp. categorical state and hold
some additional data. Depending on the descriptor type - categorical, quantitative, text or
sequence - different tables are used to represent the descriptive data. Although Diversity
Descriptions does not allow to change the type of a descriptor if descriptive data are present,
in some cases it cannot be assured that such an action is performed. The resulting data are
then meaningless and will not be displayed within Diversity Descriptions. To find, check and
delete such kinds of corrupted descriptive data, select the Maintain descriptive data tab
and choose the tab Clean descriptive data.

Select the Data type ("Summary data" or "Sampling data"), the Entity type (i.e. the type of
descriptive data in database: "categorical", "quantitative", "text" or "sequence") and the 
Project. Click on Check for invalid data and all invalid data will be listed (see image
below). 

You may select or deselect all entries of the result list for the database update by clicking the
buttons Select all rsp. Select none. To delete the selected entries from the database

click on the button. Instead of deleting the selecting entries you may click
Close form and check list in database to return to the main program with the affected
descriptions. 

You may open a table editor for the selected entries by clicking the Open table editor 
button (see image below). Here you may check the corrupted data to decide if further
measures are required.  
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Access to the data
To get access to the data, you have to take several hurdles. In DiversityDescriptions, you
must be a member of one of the user groups. You have only access to those data, that are
listed in the projects you have access to. Administration of the acces rights is done in the 
login administration. Depending on the user group or if a project carries the appropriate flag, a
read only access to certain data is available. In the description data descriptors may be
marked with the data status Data withheld, which affects export of data and document
generation.  
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Security
A user can be in 6 groups with diverse rights in the database where certain higher groups
have all rights of lower groups in addition to special rights for this group, e.g. the group
DataReader can only read the data while DescriptionsEditor has the rights of DataReader and
additionally can edit the data in descriptor tables - see overview below.

Summarzied overview of the permissions of the groups

Role Permissions in addition to lower role
resp. user group Inculded rights 

Administrator Edit own user permissions; use database
maintenance functions ProjectManager 

ProjectManager Create, edit and delete project data; import
data with project information TerminologyEditor 

TerminologyEditor 
Create, edit and delete descriptor data;
import data without changing project
information   

DescriptionsEditor 

DescriptionsEditor Create, edit and delete description data DataReader 

DataReader View description, descriptor, project and
cache mapping data; export data DataUser 

DataUser View descriptions without "withheld"
descriptors and without resource data   

Two additional roles have been introduced for the handling of the cache database 

Role Permissions in addition to lower role
resp. user group Inculded rights 

CacheAdmin Edit cache related table data CacheUser 
CacheUser View cache database and project data DataReader 

In addition to the mentioned roles a "System Aministrator" may use the Login administration to
add other users to one of these groups and grant access to one ore more workbench projects
. If you are an "Administrator" you have the right to modify the workbench projects assigned
to your own login. 

To place a user in one of the groups, go to the login administration. In the window that will
open select a login and a database. The roles available in the selected database will be listed
as shown below. Use the > and < buttons to add or remove roles for the login in the database
(see below).   
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To see the detailed permissions of a role, select it in the list of Available roles and click on
the button. A window as shown below will open listing all objects in the database the role
has permissions for (see below). 
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Projects
Within DeversityDescriptions you have to distinguish the locally defined projects, that can be
created, edited and deleted in edit projects mode, from the workbench projects, which are
references to data stored in module DiversityProjects. Each local project is uniquely assigned
to a workbench project that determines the access rights for the database users (see login
administration). As a general default the workbench project "DiversityWorkbench" is present in
the descriptions database. It should only be used if DiversityDescriptions shall be used as a
stand-alone application without DiversityProjects. 

If in your installation DiversityProjects is available you may load additional workbench projects
with menu item Administration -> Projects.... A window as shown above will open.
Workbench projects already in the database will be listed in green, missing projects in red (see
below). Check all projects you need in your database and click the Start download 
button. 

The local project is assigned to exactly one workbench project, which can be adjusted in
the Edit project panel. Assumed you use DiversityProject for project administration, it is
reasonable to have a 1:1 relation between the local projects and the workbench project.
Since in the Login administration the access rights are done based on the workbench project,
you can give each user individual rights for every single local project. 

If you use Diversity Descriptions as stand-alone application, the only available workbench
project will be the predefined "DiversityWorkbench". In this case every local project must be
assigned to this single workbench project. As a consequence you may assign an individual
database role to each user but you will not be able to distinguish the access rights according
the local project. 

Each description is uniquely assigned to a local project (see picture below from Edit
description). Usually only projects that are assigned to the user are displayed in the project
tree. The example above shows two projects assigned to the user that have a parent that is
not assigned to the user. Therefore the parent ("Vögel") is displayed with grey text colour to
indicate missing access rights. 
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A descriptor is not directly assigned to a project, instead "descriptor trees" are used. One
descriptor may be included in several descriptor trees and therefore belong to several projects
or it might be unassigned. The picture below (from Edit descriptor) shows that one descriptor
belongs to two projects, since it is part of two different descriptor trees. As in the description
example, the picture shows a parent project ("Vögel") that is not read-only for the actual user
and therefore displayed in grey text colour. Contained in that parent project therea are two
parallel projects that include the same descriptor: "Vögel Deutschlands" and "Vögel weltweit",
which is read-only and therefore displayed in grey colour.  

The project is assigned to exactly one workbench project. The Edit project panel provides
the panel to edit descriptor trees, too. But here all descriptors visible for the project are
displayed (see picture below). 
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Login administration
To administrate the logins on the database server, their permissions resp. roles and access to
projects choose Administration -> Database ... -> Logins ... from the menu. A
window as shown below will open. 

 

Statistics

To see the activity of a login click on the button. A window will open as shown below listing
all databases and tables together with the timespan (From - To) and the number of data sets
where any activity of the current login has been found.
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To see the current activity on the server click on the button. A window as shown below will
open listing all user related processes on the server.

 

Create a login

To create a new login, click on the button in the lower left corner. Another window will
open.
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Here you can enter the name of the new login, the password and the informations about the
user which will be stored in a DiversityAgents database. Either create a new entry in this
database or select an existing one: Click on the button to search for a name in the
database (see below).
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Copy a login

To copy a login including all permissions etc. into a new login, select the original login in the
list and click on the button. 

 

Edit login data

To edit the access for a login on the server, select the login in the list. If a login should be
disabled , uncheck the enabled checkbox.

All databases on the server will be listed, with the current database showing a yellow
background. The databases where the login has no access will be listed in gray while the
databases accessible for a login are black. 

 

Access of a login to a database

To allow a login the access to a database, select the database from the list and choose the
database as shown below. 

 

Roles of a login in a database

Use the > and < buttons to add or remove roles for the login in the database (see below). By
clicking the button you get an overview of the access rights for the selected role. 
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Projects for a login in a database

Depending on the database you can edit the list of projects accessible for a login (see below).
Next to the projects with full access a second list provides projects with Read Only access
(see image below). Use the and buttons to move projects between Accessible and Read
Only.  Projects are related to the module DiversityProjects. To get additional informations
about a project, select it in the list and click on the button.  

To load additional projects, click on the Load projects button. A window as shown below
will open. Projects already in the database will be listed in green, missing projects in red (see
below). Check all projects you need in your database and click the Start download button.
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Overview for a login

If you want to se see an overview of all permissions and project for a login, click on the 
button. A window as shown below will open. It lists all modules and their databases, the

roles, accessible projects and read only projects for a login.  

To copy the permissions and projects of the current login to another login, select the login
where the settings should be copied to from the list at the base of the window and click on
the button to copy the settings for all databases or the button to copy the settings of
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the selected database into this login.  

 

Overview for a database 

If you see an overview of all user and roles in a database, click on the button. A window a
shown below will open. It lists all user and roles in the database.  

To remove a user, select it in the list and click on the button.  

 

Correction of logins

If you select one of the databases, at the base a button may appear. This indicates, that
there are windows logins listed where the name of the login does not match the logins of the
server. This may happen if e.g. a database was moved from one server to another. To correct
this, click on the button. A list of deviating logins will be shown, that can be corrected
automatically. 

If logins with the same name but different server are found, one of them has to be deleted to
make the correction possible. You will get a list where you can select those that should be
removed. 
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Select the duplicate logins that should be removed and click OK. 
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Availability of the data
In the description data descriptors may be marked with the data status Data withheld (see
below).  

    

When you export data the export forms include the "Withheld data" options where you can
decide how to handle those data (see below).   

  

 The default setting Suppress whole description will exclude the whole description
dataset from the export.  

 The setting Hide withheld descriptor will include the description dataset in the
export, but descriptor data that are marked as "Data withheld" will be suppressed.  

 The setting Export withheld data will include all data in the export.  

The options mentioned above are also available for the cache database. Additionally there are
powerful filters to restrict the exported description items and dedicated descriptor and scope
data may be excluded from export.   
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Finally the document generation by default excludes all descriptions that have any descriptor
with data status "Data withheld". This is indicated by the button in the upper right corner
of the form. By clicking this button the descriptions may be included, which is indicated with
the inactive icon . Withheld descriptors will be skipped. For the document generators there
is no option to include them.   
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Database
The database for DiversityDescriptions is based on Microsoft SQL-Server 2008 and higher.

Organisation of the data

The database consits of three major parts:

1. The "Descriptive terminology" with the main tables "Descriptor" and "CategoricalState"
provides the means to express the description details. The two fixed enumeration tables
"DataStatus_Enum" and "StatisticalMeasure_Enum" provide values defined in the SDD standard
1.1 rev 5.

2. The "Descriptions" part with the main table "Description" reflects the items themselves.
Each description must be assigned to a project (see part 3) and references entries from the
descriptive terminology. These references are reflected by the tables
"CategoricalSummaryData", "QuantitativeSummaryData" and "TextDescriptorData", where
additional item specific data are stored.

3. The "Projects" part with the main tables "Project", "DescriptorTree" and
"DescriptorTreeNode" build the anchor for the descriptions, which must be assigned to a
project. Further functions are a hierarchical organization of the descriptors and restriction of
the descriptive terminology to certain projects. Additionally it is possible, to define
recommended values of statistical measure, modifier and frequency associated to certain
branches of a descriptor tree or single descriptors. If for a certain project no descriptor tree is
created, there is no restriction, i. e. all descriptors are allowed.

The image below shows the main tables of the database.
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In the graphic the tables of the database are marked according to their logical groups.
Additionally the database group "Resources" provides the option to assign links to resource
files (pictures, audio, video) to certain descriptors, categorical states or descriptions. The 
"Auxilliary" group with the main table "BaseEntity" provides unique keys for the most of the
other tables for building of relations. Furthermore it allowes a centralized realization of some
features, e.g. support of translations supply imports and export to a cache database.

Further details: tables, projects, access.
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Installation of the database
DiversityDescriptions uses Microsoft SQL-Server 2008 R2 or higher as database engine. We
recommend to use one of the latest versions Microsoft SQL-Server 2012 or 2014. The
database files provided at the DiversityWorkbench homepage are generated for Microsoft
SQL-Server 2008 R2 but can be attached to these versions. You may use a centralized
SQL-Server that is accessible by several users, e.g. over a local area network or run a local
database server on your own PC.

If you do not have a database server with DiversityDescriptions already available, you have to
install the database engine first. Download the free version of Microsoft SQL Server Express
(e.g. SQLEXPRADV_x86_DEU.exe ) from http://www.microsoft.com/downloads/. Start the
program and follow the instructions for the installation. After the installation make shure to
get the latest updates using Windows Update.

Download the database files DiversityDescriptions_Base.MDF  and
DiversityDescriptions_Base_log.LDF  from http://www.diversityworkbench.net/Portal/
 provided as a zip archive (DiversityDescriptions.zip) and copy them into your database
directory. 

 

Server configuration 

To configure your server, launch the SQL Server Configuration Manager (see image below,
please consider that in this example the two SQL-Servers "SQLEXPRESS" and "MSSQLSERVER"
are installed). 

Then click on the "Protocols for SQLEXPRESS" node. Right click on "TCP/IP" in the list of
Protocols and choose "enable" for TCP/IP.
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Right click on the TCP/IP node and select "Properties" to open a window as shown below. 

In the part IPALL clear out the value for "TCP Dynamic Ports". Give a TCP-Port number to
use when making remote connections, e.g. "5432" as shown above. You have to restart the
SQL Server Express service before you can connect to your database. 

If you use a database on a centralized server that shall be reachable over a computer
network, make sure that the firewall of the server allows access via the port you set for the
connections (see below). 
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Start the Microsoft SQL Server Managment Studio and attach the database as shown below.
Choose the node "databases" and right-click on it to open the context menu (see below).
Then choose "attach" from the context menu. A window will open where you can choose the
file DiversityDescriptions_Base.MDF from your database directory and attach it to the
database engine.
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Database configuration 

To configure your Database, use the Client as described in Database configuration.

 

Connect to database 

Start the program DiversityDescriptions.exe and in the main window click on the button
or choose Connection -> Database ... from the menu. A window as shown below will
open. Here enter the server name or the IP address (here "localhost" for a local database on
the own PC) and its IP port (5432 in example below) to connect to your SQL-server and
select the database file in your directory. 
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Configuration of the database
To configure your Database, choose Administration -> Database -> Rename
database ... to change the name of the database according to your requirements. During this
renaming all processes in the database will be terminated (you will get a warning if processes
from other host are active). 

Afterwards you should adapt the address that is published by the database for access by
other modules. Choose Administration -> Database -> Set published address ...
from the menu. This will change the published address to the name of the server where your
database is located and an identifier for you database, e.g. 
http://xy.diversityworkbench.de/Descriptions/.  

Renaming of the database and adapting of the published address should be done before you
start to use the database and name and address should not be changed afterwards as
datasets from other modules linked to data in the database would point to outdated addresses
otherwise. 
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Connections to the databases and services
The program will automatically try to connect to all the modules within the Diversity
Workbench. To edit these connections choose Connection -> Module connections ...
from the menu. A form as shown below will open, where you can edit these connections. 
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To requery the connections use the button. If you want to add a connection to a different
server click on the  button and connect to the database you want to add to the list. Added
databases will be displayed in green. To remove a connection from the list select it and click
on the button. If you have added connections in a former program run, click on button to
insert them into the available connections (see right image). If an added connection misses a
password, this will be indicated by a red backcolor. Click on the button to enter the missing
password.  

Webservices like Index Fungorum will be displayed in blue. 
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Linked server
Databases not available on the local server may be accessible via a linked server. To
administrate the linked servers, choose Administration -> Linked servers ... from the
menu. A form (see below) will open where you can add linked servers and inspect the content
of the available databases. 

Use the  resp. buttons to add or remove a linked server. To add a linked server, you need
the name of the server and the port, e.g. tnt.diversityworkbench.de, 5432, the login
associated with the connection of the linked server e.g. TNT and the password for this login.
The available databases will be listed as shown above. To inspect the content, select
among the tables or views listed in the right part as shown above. Linked servers have certain
restrictions for the availability of data, e.g. XML and geography data are not available via a
linked server. For a table or view containing incompatible content you may encounter a
corresponding error mentioning the reason for the incompatibility. 
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Database - access
The database engine for DiversityDescriptions is Microsoft SQL-Server 2008 or higher.

If you are connected to a database this is indicated by the icon of the connection button 
in left upper corner. If you are not connected this will be indicated by the icon . To access
any database, you must specify the server where the database is located. For the
configuration of this connection choose Connection -> Database... from the menu or click
on the button. 

If you want to use a database on a local or remote SQL-server, start the program 
DiversityDescriptions.exe and in the main window click on the button or choose Connection
-> Database ... from the menu. A window as shown below will open. Here set the
connection parameters as described below. 

 

Database name, IP-address and Port

A dialog will open, to specify the name or IP-address and port number of the server and to
select the authentication mode. The SQL-Server may be addressed by its IP-address, e.g.
127.0.0.1 or by its name, e.g. localhost. You can either choose Windows authentication (see
left image below) or SQL-Server authentication (see below - central middle image). 
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The standard port number for SQL-Server is 1433 and will be set as a default. If the database
server is configured using a port different from that port, you must give the port number in

the field Port. Click on the button to connect to the server. If the
connection informations are valid, you can choose a database from the server from the
combobox at the base of the window (see right image above). To restart the connecting

process click on the button. In menu you find a list
of the latest login data (server and port) used. 

If you access a database for the first time you will be asked to consent to the storage and
processing of your personal data (see below) according to the General Data Protection
Regulation. Without your consent the access is not possible.

 

Password

If you are logged in with a SQL-Server account and are not restricted to the group 
DataUser or DataReader, you can change your password. Choose Administration -> 
Change password... from the menu. In the window that will open, enter your current
password and the new password (see below). The password must match the restrictions set
by the database server.
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Module connections

The program will automatically try to get connect to Diversity Workbench databases and
webservices. For further details see the Connections section. 
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Logging
Changes within the database will be documented for each data set together with the time and
the responsible user in the columns shown in the image below.

All main tables have a corresponding logging table. If you change or delete a data set, the
original data set will be stored in this logging table together with information about by whom
and when changes were made last.
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History
To inspect the history of a data set click on the button. A window will open showing all
former states of the data in tables with the current data set at the top.  

  

If you have sufficient access rights for the database (role administrator), the buttons 
Restore deleted and Restore data as in selected line are available (see image below). If
you want to restore an old version of a data set, choose the corresponding line in the table
and click on the Restore data as in selected line button. 
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If you want to restore a whole data set including the dependent data, click on the Restore
deleted button. This function is as well available from the menu Data -> Restore from log
.... In the upcoming dialogs choose the basic table to start for the search. In the upcoming
dialogs enter the date where the query should start and the number of lines from the log table
that should be displayed. Finally select the datarow(s) of the root table that should be
restored. After that the program will try to recover the data with all depending information. 

Depending on selected edit mode ("Descriptions", "Descriptors" or "Projects") the marked
tables in the overview below may be selected as basic tables for restorage. With "->"
dependent tables are marked that will be restored automatically, if the parent has been
successfully restored. 

 Edit mode "Descriptions": 

Translation 

Description -> SamplingEvent -> SamplingUnit 

-> DescriptionScope -> CategoricalSamplingData 

-> CategoricalSummaryData ->
QuantitativeSamplingData 

->
QuantitativeSummaryData -> TextSamplingData 

-> TextDescriptorData 
->
MolecularSequenceSampling
Data 

-> MolecularSequenceData 
-> Resource * -> ResourceVariant 
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 Edit mode "Descriptors": 
Translation 
Descriptor -> CategorialState     

-> Resource * -> ResourceVariant 

 Edit mode "Projects": 
Translation 
Project -> OtherScope     
DescriptorTree -> DescriptorTreeNode   

  
->
DescriptorTreeNodeRecFreq
uency 

  

  
->
DescriptorTreeNodeRecModif
ier 

  
->
DescriptorTreeNodeRecStat
Measure 

-> Resource * -> ResourceVariant 

* Remark: If you restore an object that assigns resources, be aware that during delete
processing in many cases the link from the resource to the deleted object was set to null
before deleting the resource itself. In those cases after restoring the target object you have
take a look in the history to restore the resource link using the button Restore data as in
selected line. 

After successful restorage a message will give you an overview of the performed actions.
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Backup
Database copy

If you need to backup your database, you have to use the functionality provided by
SQL-Server. To do this, you need administration rights in the database you want to create a
backup. Open the Management Studio for SQL-Server, choose the database and detach it
from the server as shown in the image below.

After detaching the database, you can store a copy of the ..._Data.MDF File to keep it as a
backup.

After storing the backup you have to attach the database.

A dialog will appear where you have to select the original database file in your directory.

Note: A database copy can only be attached to an SQL server with the same or a higher
version. For example if a database that was attached to an SQL-Server 2008 R2 (internal
version 10.50) is copied, it is not possible to attach the copy to an SQL-Server 2008 (internal
version 10.00).

 

Database backup

If you are logged in to a database with administrator rights, you can start a backup within
DiversityDescriptions with menu item Data-> Backup database. In this case the name of
the backup is automaticallly generated from the SQL-server version, the database name and
data/time of backup. In case of backup success the resulting file path at the SQL server disk
will be displayed as in the example below. 
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To restore the backup to a new database, right-click at "Database" in the Managment Studion
for SQ-Server and select "Restore database...". 

In the following panel specify the database name, select "Restore from medium" to specify
your backup file and select the backup source (see below). You can overwrite an existing
databse by selecting it in that panel instead of specifying a new database name. 
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Note: The same limitations concerning the SQL-Server versions as mentioned in section
"Database copy" are valid for backup handling, too. A backup can only be restored at the
same or a higher version of SQL-Server.
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Database documentation
This tool is used to generate a structured documentation of database parts. To use this tool,
choose Administration -> Database ->  Documentation ... from the menu. A window
will open as shown below.

Select the tables that should be included in the documentation, choose among the provided
options and click on the button Create ... documentation to create a documentation in one of
the available formats (HTML, MediaWiki, JSP-Wiki, Semantic Media Wiki). If you create a HTML
documentation, a local file named <Database name>.htm is generated in the application
directory, that might be copied and edited for own purposes. For MediaWiki and JSP-Wiki you
may simply copy and paste the needed parts from the output window. 

If you select format "Semantic Media Wiki" an output is generated that fits to terminology
platforms as used e.g by TDWG. In this scheme the most important entities are "Concept" and
"Collection". Each "Concept" represents a single table column, which is shown on an own page
named <prefix>:<table>.<column>. Each "Collection" represents a single table, which is shown
on an own page named <prefix>:<table> (see image below). The "Semantic Media Wiki" option
currently only supports output of Tables. Views, Functions and Roles will be ignored.  
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If "Generate: XML" is selected, the output is generated in an XML format that may be
imported to a semantic media wiki. To show all generated data, the two templates
"dwb_concept" and "dwb_relation" must be inserted in the wiki. 
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Index
 BaseEntity

 BaseEntityTable_Enum

 CacheDatabase

 CacheMappingDescription

 CacheMappingDescriptor

 CacheMappingState

 CacheProject

 CategoricalSamplingData

 CategoricalState

 CategoricalSummaryData

 DataStatus_Enum

 Description

 DescriptionScope

 Descriptor

 DescriptorInapplicability

 DescriptorStatusData

 DescriptorTree

 DescriptorTreeNode

 DescriptorTreeNodeRecFrequency

 DescriptorTreeNodeRecModifier

 DescriptorTreeNodeRecStatMeasure

 Frequency

 ImportMapping

 ImportSession

 Modifier
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 MolecularSequenceData

 MolecularSequenceSamplingData

 OtherScope

 Project

 Project_AvailableScope

 QuantitativeSamplingData

 QuantitativeSummaryData

 Resource

 ResourceVariant

 ResourceVariant_Enum

 SamplingEvent

 SamplingUnit

 SexStatus_Enum

 StatisticalMeasure_Enum

 TextDescriptorData

 TextSamplingData

 Translation

 TranslationColumn_Enum

Table BaseEntity
The BaseEntity is used within the database to provide unique keys

Column Data type Description Nullable 

id int 

Database-internal
object ID, unique
across all tables in
database (primary
key) 

NO 

table_id int 

References the table
name of table entries
associated with the
BaseEntity; NULL
indicates orphaned

YES 
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entries and may be
used for garbage
collection of otherwise
deleted object ids
Default value: NULL 

specific_rights_text nvarchar (255) 

To be used where the
licence for an object
differs from the default
project licence
Default value: NULL 

YES 

specific_licence_uri nvarchar (255) 
URI of licence, where
different from project
licence
Default value: NULL 

YES 

Table BaseEntityTable_Enum
The BaseEntityTable_Enum contains the names of tables that reference the
BaseEntity table

Column Data type Description Nullable 

id int 
Database-internal
object ID of this
record (primary key) 

NO 

table nvarchar (255) 
Name of table that
references the
BaseEntity table 

NO 

Table CacheDatabase
Table holding the cache databases connected to the database

Column Data type Description Nullable 

Server varchar (50) 
The name or IP of the
server where the
cache database is
located 

NO 

DatabaseName varchar (50) The name of the
cache database NO 

Port smallint 
The port of the server
where the cache
database is located 

NO 

Version varchar (50) The version of the
cache database YES 

Table CacheMappingDescription
Table holding the description key mappings for the cache database
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Column Data type Description Nullable 

id int 
Database-internal ID
of this record (primary
key) 

NO 

project_id int 
Reference to the
description project
(foreign key) 

NO 

description_id int 
Reference to the
description to which
these data belong
(foreign key) 

NO 

target_key int 
Mapped key value for
the target of the
cache database. 

NO 

Table CacheMappingDescriptor
Table holding the descriptor key mappings for the cache database

Column Data type Description Nullable 

id int 
Database-internal ID
of this record (primary
key) 

NO 

project_id int 
Reference to the
descriptor project
(foreign key) 

NO 

descriptor_id int 
Reference to the
descriptor to which
these data belong
(foreign key) 

NO 

target_key int 
Mapped key value for
the target of the
cache database. 

NO 

last_state_key int 
Highest value of state
key. Relevant for
key_mapping_level > 0
Default value: (0) 

YES 

Table CacheMappingState
Table holding the categorical state key mappings for the cache database

Column Data type Description Nullable 

id int 
Database-internal ID
of this record (primary
key) 

NO 

project_id int Reference to the state
project (foreign key) NO 

state_id int Reference to the
categorical state to NO 
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which these data
belong (foreign key) 

target_key int 
Mapped key value for
the target of the
cache database. 

NO 

Table CacheProject
Table holding the project settings for the cache database

Column Data type Description Nullable 

id int 
Database-internal ID
of this record (primary
key) 

NO 

project_id int 
Reference to the
description project
(foreign key) 

NO 

withheld_data_level tinyint 

Flag for handling of
withheld descriptor
data. 0=withhold
description;
1=withhold descriptor;
2=do not withhold
data
Default value: (0) 

YES 

key_mapping_level tinyint 

Flag for handling of
key mapping.
0=re-build mapping for
each update; 1=keep
first mapping;
2=additionally take
numeric values of
alternate ID for items;
>2 as 2 but
re-initialize table
Default value: (0) 

YES 

last_char_key int 

Highest value of
character key.
Relevant for
key_mapping_level > 0
Default value: (0) 

YES 

last_item_key int 
Highest value of item
key. Relevant for
key_mapping_level > 0
Default value: (0) 

YES 

last_changes datetime 

The recent date when
data within the project
had been changed
Default value:
getdate() 

YES 
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Table CategoricalSamplingData
The categorical data recorded for a sampling event

Column Data type Description Nullable 

id int 
Database-internal ID
of this record,
references BaseEntity
(primary key) 

NO 

sampling_unit_id int 
Reference to the
sampling unit (foreign
key) 

NO 

state_id int 
Reference to the state
(descriptor is implicit in
state_id) (foreign key)
 

NO 

notes nvarchar (MAX) 
Free-form text
detailing special cases
or additional data
beyond the values 

YES 

modifier_id int 

Optional reference to
a modifier definition
(e.g. "strongly", "at
the base", "in
autumn") (foreign key)
Default value: NULL 

YES 

frequency_value int 

Number of times this
category was
observed within a
single sampling unit
Default value: NULL 

YES 

Table CategoricalState
The categorical states available for categorical descriptors

Column Data type Description Nullable 

id int 
Database-internal ID
of this record,
references BaseEntity
(primary key) 

NO 

descriptor_id int 
Reference to the
descriptor to which
the state belongs
(foreign key) 

NO 

label nvarchar (255) Short label (or name)
of descriptor state NO 

abbreviation nvarchar (255) 
Abbreviated label of
descriptor state
Default value: NULL 

YES 

detail nvarchar (MAX) Additional detail text
explaining or YES 
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commenting on the
descriptor state
definition 

wording nvarchar (255) 

Optional separate
wording for natural
language generation
(label will be used if
this is missing)
Default value: NULL 

YES 

display_order int 

A positive number
defining the sequence
in which descriptor
states are displayed
Default value: '0' 

NO 

Table CategoricalSummaryData
The categorical data of a description

Column Data type Description Nullable 

id int 
Database-internal ID
of this record (primary
key) 

NO 

description_id int 
Reference to the
description to which
these data belong
(foreign key) 

NO 

state_id int 
Reference to the state
(the descriptor is
implicit in state_id)
(foreign key) 

NO 

notes nvarchar (MAX) 
Free-form text
detailing special cases
or additional data
beyond the values 

YES 

modifier_id int 

Optional reference to
a modifier definition
(e.g. "strongly", "at
the base", "in
autumn") (foreign key)
Default value: NULL 

YES 

frequency_id int 

Optional reference to
a frequency modifier
definition (e.g.
"rarely", "usually",
"mostly") (foreign key)
Default value: NULL 

YES 

Table DataStatus_Enum
Values of data status used for descriptions according to SDD 1.1 rev 5
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Column Data type Description Nullable 

id int 
Database-internal ID
of this record,
references BaseEntity
(primary key) 

NO 

label nvarchar (255) Short label (or name)
of data status NO 

code nvarchar (255) Code of data status NO 

abbreviation char (1) Single (intuitive)
character NO 

detail nvarchar (MAX) 
Additional detail text
explaining or
commenting on the
data status definition 

YES 

Table Description
The description in the database

Column Data type Description Nullable 

id int 
Database-internal ID
of this record,
references BaseEntity
(primary key) 

NO 

label nvarchar (255) 
Short label (or name)
of description
Default value: NULL 

YES 

detail nvarchar (MAX) 
Additional detail text
explaining or
commenting on the
description definition 

YES 

project_id int 
Each description
belongs to exactly one
project (required,
foreign key) 

NO 

alternate_id nvarchar (30) 

Optional alternate id of
a description item -
should be unique
within one project, but
not checked by
database
Default value: NULL 

YES 

wording nvarchar (255) 

Optional separate
wording for natural
language generation
(label will be used if
this is missing)
Default value: NULL 

YES 

Table DescriptionScope
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The scope of the description

Column Data type Description Nullable 

id int 
Database-internal ID
of this record (primary
key) 

NO 

description_id int 
Reference to the
description to which
these data belong
(foreign key) 

NO 

label nvarchar (255) 
Short label (or name)
of scope
Default value: NULL 

YES 

dwbURI nvarchar (255) 
Reference to
DiversityWorkbench
component
Default value: NULL 

YES 

type nvarchar (255) 

Scope type
("GeographicArea",
"Citation",
"Observation",
"Specimen",
"TaxonName",
"OtherConcept",
"Stage", "Part" or
"Sex")
Default value: NULL 

YES 

taxon_id int 

Reference to one of
potentially several
taxa described by the
description (not used,
foreign key)
Default value: NULL 

YES 

specimen_id int 

Reference to one of
potentially several
specimens (collected
and preserved) that
are being described
(not used, foreign key)
Default value: NULL 

YES 

observation_id int 

Reference to one of
potentially several
observations (not
preserved) that are
being described (not
used, foreign key)
Default value: NULL 

YES 

source_reference_id int 

Reference to one or
several literature
references on which
the description is
based (not used,
foreign key)
Default value: NULL 

YES 

geographicarea_id int Reference to one of YES 
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potentially several
geographic areas
refered to in a
description (not used,
foreign key)
Default value: NULL 

other_scope_id int 
Reference to further
scopes, e.g. stage,
sex etc. (foreign key)
Default value: NULL 

YES 

Table Descriptor
Descriptor (= characters, features) define variables

Column Data type Description Nullable 

id int 
Database-internal ID
of this record,
references BaseEntity
(primary key) 

NO 

label nvarchar (255) Short label (or name)
of descriptor NO 

abbreviation nvarchar (255) 
Abbreviated label of
descriptor
Default value: NULL 

YES 

detail nvarchar (MAX) 
Additional detail text
explaining or
commenting on the
descriptor definition 

YES 

display_order int 

A positive number
defining the sequence
in which descriptors
are displayed
Default value: '0' 

NO 

subclass nvarchar (255) 

The four character
subclasses of SDD are
all combined here in
one entity and
distinguished by this
attribute
("categorical",
"quantitative", "text"
or "sequence")
Default value:
'categorical' 

NO 

statistical_measureme
nt_scale nvarchar (255) 

Scale of descriptor:
Categorical may be
nominal (unordered,
“red/green/blue”) or
ordinal (ordered,
“bad/medium/good”);
Quantitative may be
interval (°C) or ratio
(mass, length, time, K)

NO 
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Default value:
'nominal' 

usually_exclusive tinyint 

Applicable to
categorical
(nominal/ordinal)
descriptors only. If
usually exclusive = 1,
then by default the
user interface allows
only entering one
state. Nevertheless,
multiple states in the
data are valid.
Default value: '0' 

NO 

state_collection_model
 nvarchar (255) 

Handling of multiple
values: OrSet/AndSet:
unordered set
combined with or/and,
OrSeq/AndSeq:
ordered sequence
combined with or/and,
WithSeq: example is
“green with brown”,
Between: an example
is “oval to elliptic”
Default value: 'OrSet' 

NO 

mandatory tinyint 

Is the scoring of this
descriptor mandatory
(required) in each
item?
Default value: '0' 

NO 

repeatability nvarchar (255) 

How reliable and
consistent are
repeated
measurements or
scorings of the
descriptor by different
observers and on
different objects?
("ignore", "very low",
"low", "below average",
"slightly below
average", "standard",
"slightly above
average", "above
average", "high" or
"very high")
Default value:
'standard' 

NO 

availability nvarchar (255) 

How available is the
descriptor or concept
for identification?
("ignore", "very low",
"low", "below average",
"slightly below
average", "standard",
"slightly above
average", "above

NO 
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average", "high" or
"very high")
Default value:
'standard' 

measurement_unit nvarchar (255) 

A measurement unit
(mm, inch, kg, °C, m/s
etc.) or dimensionless
scaling factor
Default value: NULL 

YES 

measurement_unit_pre
cedes_value tinyint 

Set to 1 if the
measurement unit
precedes the value
Default value: '0' 

NO 

values_are_integer tinyint 
Set to 1 if the values
are integer
Default value: '0' 

NO 

min_plausible_value float 

Applicable to
quantitative
descriptors only; in
support of a
plausibility check for
values. Example: for
tree height this could
be 0, i.e. only positive
values allowed
Default value:
'-1.79e308' 

NO 

max_plausible_value float 

Applicable to
quantitative
descriptors only; in
support of a
plausibility check for
values. Example: for
tree height this could
be 99
Default value:
'1.79e308' 

NO 

sequence_type nvarchar (255) 

Type of molecular
sequence, "Nucleotide"
or "Protein". The value
"Nucleotide" covers
RNA and DNA
sequences
Default value:
'Nucleotide' 

NO 

symbol_length tinyint 

The number of letters
in each symbol.
Nucleotides are always
codes with 1-letter
symbols, but proteins
may use 1 or 3-letter
codes (e.g. A or Ala
for alanine)
Default value: '1' 

NO 

enable_ambiguity_sym
bols tinyint Set to 1 if ambiguity

symbols are supported NO 
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in the sequence string,
e.g. R, Y, S, W for
nucleotides or B, Z for
proteins
Default value: '1' 

gap_symbol nvarchar (3) 

A string identifying the
"gap" symbol used in
aligned sequences.
The gap symbol must
always be
symbol_length long
Default value: NULL 

YES 

wording_before nvarchar (255) 

Representation for
natural language
output, inserted
before the
states/value
Default value: NULL 

YES 

wording_after nvarchar (255) 

Representation for
natural language
output, inserted after
the states/value
Default value: NULL 

YES 

data_entry_note nvarchar (MAX) 
A note or prompt when
entering or dealing
with data 

YES 

wording nvarchar (255) 

Optional separate
wording for natural
language generation
(label will be used if
this is missing)
Default value: NULL 

YES 

Table DescriptorInapplicability
The descriptor dependency rules

Column Data type Description Nullable 

id int 
Database-internal ID
of this record (primary
key) 

NO 

controlled_descriptor_i
d int 

Reference to the
descriptor to which
the rule will apply, e.g.
which will be
inapplicable if
controlling state
applies to the same
description (foreign
key) 

NO 

controlling_state_id int 
Reference to the
controlling categorical
state; if present in a
description, controlled

NO 
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descriptor is affected
according to rule 

rule nvarchar (255) 

The kind of rule
creating a descriptor
inapplicability
("inapplicable-if",
"applicable-if",
"inapplicable-computed
-from-applicable")
Default value:
'inapplicable-if' 

NO 

Table DescriptorStatusData
The status data of a descriptor for a certain description

Column Data type Description Nullable 

id int 
Database-internal ID
of this record (primary
key) 

NO 

description_id int 
Reference to the
description to which
these data belong
(foreign key) 

NO 

descriptor_id int 
Reference to the
descriptor to which
the status value
belongs (foreign key) 

NO 

datastatus_id int 

Reference to a status
definition. Status is
like a marker why data
is missing or in need of
revision (examples:
"unknown", "not
applicable", "to be
checked", "data
withheld" etc.)
(foreign key) 

NO 

notes nvarchar (MAX) 
Free-form text
detailing additional
information (rarely
used, not multilingual) 

YES 

Table DescriptorTree
The root and definition of a descriptor tree

Column Data type Description Nullable 

id int 
Database-internal ID
of this record,
references BaseEntity
(primary key) 

NO 
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is_complete tinyint 

Set to 1 if this tree
includes the largest
possible set of
descriptors for the
taxon set associated
with a project (i.e. the
"master-descriptor
tree", other trees
being subsets)
Default value: '0' 

NO 

label nvarchar (255) Short label (or name)
of descriptor tree NO 

type nvarchar (255) 
"mixed", "part-of",
"property" or
"generalization" 

NO 

project_id int 
Each tree belongs to
exactly one project
(required, foreign key) 

NO 

Table DescriptorTreeNode
The descriptor tree nodes representing either nodes of the tree or
descriptors ("leafes" of the tree)

Column Data type Description Nullable 

id int 
Database-internal ID
of this record,
references BaseEntity
(primary key) 

NO 

parent_node_id int 

Reference to a parent
node, creating a true
tree; NULL for a root
node (foreign key)
Default value: NULL 

YES 

label nvarchar (255) 

Short label (or name)
of internal node
associated with a
concept; NULL for a
descriptor node
Default value: NULL 

YES 

abbreviation nvarchar (255) 
Abbreviated label of
node
Default value: NULL 

YES 

display_order int 

A positive number
defining the sequence
in which child nodes
are displayed
Default value: '0' 

NO 

descriptortree_id int 

Reference to a
descriptor tree; all
nodes must have a
direct link to the tree
definition (foreign key)
 

NO 

Page 571



descriptor_id int 

Reference to a
descriptor; NULL if the
present node is an
inner concept node
defining a hierarchy of
nodes or descriptors
(foreign key)
Default value: NULL 

YES 

detail nvarchar (MAX) 
Additional detail text
explaining or
commenting on the
node definition 

YES 

Table DescriptorTreeNodeRecFrequency
Selection of recommended frequency values for descriptor tree parts or
single descriptors

Column Data type Description Nullable 

id int 
Database-internal ID
of this record (primary
key) 

NO 

node_id int 
Reference to the
descriptor tree node
(foreign key) 

NO 

frequency_id int 
Reference to the
recommended
frequency modifier
(foreign key) 

NO 

Table DescriptorTreeNodeRecModifier
Selection of recommended modifier values for descriptor tree parts or single
descriptors

Column Data type Description Nullable 

id int 
Database-internal ID
of this record (primary
key) 

NO 

node_id int 
Reference to the
descriptor tree node
(foreign key) 

NO 

modifier_id int 
Reference to the
recommended modifier
(foreign key) 

NO 

Table DescriptorTreeNodeRecStatMeasure
Selection of recommended statistical measures for descriptor tree parts or
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single descriptors

Column Data type Description Nullable 

id int 
Database-internal ID
of this record (primary
key) 

NO 

node_id int 
Reference to the
descriptor tree node
(foreign key) 

NO 

measure_id int 
Reference to the
recommended measure
(foreign key) 

NO 

Table Frequency
Definition of frequency modifier values

Column Data type Description Nullable 

id int 
Database-internal ID
of this record,
references BaseEntity
(primary key) 

NO 

label nvarchar (255) 
Short label (or name)
of frequency modifier
(e.g. "very rare",
"rare", "usually" etc.) 

NO 

lower_estimate float 

Each frequency
modifier defines a
frequency range, this
is the estimated
lowest frequency
Default value: '0' 

NO 

upper_estimate float 

As above, estimate of
upper range for the
border; note: ranges
may overlap!
Default value: '1' 

NO 

display_order int 

A positive number
defining the sequence
in which frequency
modifiers are to be
displayed
Default value: '0' 

NO 

Table ImportMapping
The import mappings to support mapping of external file keys to database
keys

Column Data type Description Nullable 
id int Database-internal ID NO 
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of this record (primary
key) 

object_id int 

Reference to the
object to which the
mapping belongs,
references BaseEntity
(foreign key) 

NO 

session_id int 

Reference to the
import session to
which the mapping
belongs, references
ImportMapping (foreign
key) 

NO 

table_name varchar (50) Name of the import
table NO 

parent_key varchar (255) Symbolic key of the
parent table NO 

external_key nvarchar (255) External key in the
import file NO 

Table ImportSession
The import sessions to support import of data spread over several files

Column Data type Description Nullable 

id int 
Database-internal ID
of this record (primary
key) 

NO 

project_id int 
Each import session
belongs to exactly one
project (required,
foreign key) 

NO 

detail nvarchar (MAX) 
Detail text explaining
the import session
definition 

YES 

create_timestamp datetime 

Date and time when
the import session was
created
Default value:
getdate() 

NO 

update_timestamp datetime 

Date and time when
the import session was
updated
Default value:
getdate() 

NO 

Table Modifier
Definition of modifier values

Column Data type Description Nullable 
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id int 
Database-internal ID
of this record,
references BaseEntity
(primary key) 

NO 

class nvarchar (255) 

Grouping of modifiers
into classes
("Certainty",
"Seasonal", "Diurnal",
"TreatAsMisinterpretati
on" or
"OtherModifierClass") 

NO 

label nvarchar (255) 
Short label (or name)
of modifier (e.g.
"strong", "probably"
etc.) 

NO 

display_order int 

A positive number
defining the sequence
in which modifiers are
to be displayed
Default value: '0' 

NO 

Table MolecularSequenceData
The molecular sequence data of a description

Column Data type Description Nullable 

id int 
Database-internal ID
of this record (primary
key) 

NO 

description_id int 
Reference to
description to which
these data belong
(foreign key) 

NO 

descriptor_id int 

Reference to a
molecular sequence
descriptor to which
the sequence text
belongs (foreign key) 

NO 

sequence nvarchar (MAX) 
Molecular sequence
text referring to
information on one
descriptor 

NO 

notes nvarchar (MAX) 
Free-form text
detailing special cases
or additional data
beyond the values 

YES 

Table MolecularSequenceSamplingData
The molecular sequence data recorded for a sampling event

Column Data type Description Nullable 
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id int 
Database-internal ID
of this record (primary
key) 

NO 

sampling_unit_id int 
Reference to a
sampling unit (foreign
key) 

NO 

descriptor_id int 

Reference to a
molecular sequence
descriptor to which
the sequence text
belongs (foreign key) 

NO 

sequence nvarchar (MAX) 
Molecular sequence
text referring to
information on one
descriptor 

NO 

notes nvarchar (MAX) 
Free-form text
detailing special cases
or additional data
beyond the values 

YES 

Table OtherScope
Scope values for description scope values for scope types "Other scope",
"Part", "Stage" and "Sex"

Column Data type Description Nullable 

id int 
Database-internal ID
of this record,
references BaseEntity
(primary key) 

NO 

label nvarchar (255) 
Short label (or name)
of scope (e.g. "male",
"female", "adult",
"juvenile" etc.) 

NO 

detail nvarchar (MAX) 

Additional detail text
explaining or
commenting on the
scope and delimitation
of the present
description 

YES 

type nvarchar (255) 
Describes the scope
type ("sex", "stage",
"part" or "other") 

NO 

sex_status_id int 
Reference to sex
status value according
SDD V5.1 (foreign key)
Default value: NULL 

YES 

Table Project
Projects define separated workareas in a single database
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Column Data type Description Nullable 

id int 
Database-internal ID
of this record,
references BaseEntity
(primary key) 

NO 

parent_project_id int 

Reference to a parent
project, creating a
subproject; NULL for a
root project (foreign
key)
Default value: NULL 

YES 

label nvarchar (255) 

Short label (or name)
of project (or
subproject); each
project defines a
separate work
environment within a
shared database by
means of defining sets
of descriptors (through
DescriptorTree) 

NO 

rights_text nvarchar (255) 

The default rights and
licence statement for
the entire project;
BaseEntity provides
means to override this
for individual objects
Default value: NULL 

YES 

licence_uri nvarchar (255) 

URI of licence for the
project; BaseEntity
provides means to
override this for
individual objects
Default value: NULL 

YES 

detail nvarchar (MAX) 

Additional detail text
explaining or
commenting on the
project (or subproject)
 

YES 

primary_language_cod
e nvarchar (3) 

Language of primary
text version (fields
directly in tables, may
be translated in table
Translation);
Examples: "de", "en"
etc. (ISO 639
language code) 

NO 

ProjectProxyID int 

Reference to a project
definition of
DiversityProjects that
allows control of
access rights
Default value: (0) 

NO 
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Table Project_AvailableScope
Scope values available for a certain project

Column Data type Description Nullable 

id int 
Database-internal ID
of this record (primary
key) 

NO 

project_id int 
Reference to the
project for which a
shall be available
(foreign key) 

NO 

scope_id int 
Reference to a scope
definition in
OtherScope (foreign
key) 

NO 

Table QuantitativeSamplingData
The quantitative data recorded for a sampling event

Column Data type Description Nullable 

id int 
Database-internal ID
of this record (primary
key) 

NO 

measure_id int 

Optional statistical
measure (minimum,
mean, maximum,
ranges, sample size,
variance etc.)
recorded in value; if
NULL, value is a direct
measurement (foreign
key)
Default value: NULL 

YES 

sampling_unit_id int 
Reference to a
sampling unit (foreign
key) 

NO 

descriptor_id int 
Reference to
descriptor which the
values record (foreign
key) 

NO 

value float 

The value for the
statistical measure or
single
measurement/recordin
g 

NO 

notes nvarchar (MAX) 
Free-form text
detailing special cases
or additional data
beyond the values 

YES 

modifier_id int Optional reference to
a modifier definition YES 
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(e.g. "strongly", "at
the base", "in
autumn") (foreign key)
Default value: NULL 

Table QuantitativeSummaryData
The quantitative data of a description

Column Data type Description Nullable 

id int 
Database-internal ID
of this record (primary
key) 

NO 

measure_id int 

Reference to the
statistical measure
(minimum, mean,
maximum, ranges,
sample size, variance
etc.) recorded in value
(foreign key) 

NO 

description_id int 
Reference to the
description to which
these data belong
(foreign key) 

NO 

descriptor_id int 
Reference to the
descriptor which the
values record (foreign
key) 

NO 

value float The value of the
statistical measure NO 

notes nvarchar (MAX) 
Free-form text
detailing special cases
or additional data
beyond the values 

YES 

modifier_id int 

Optional reference to
a modifier definition
(e.g. "strongly", "at
the base", "in
autumn") (foreign key)
Default value: NULL 

YES 

Table Resource
Hyperlinks to separate rich text/media objects

Column Data type Description Nullable 

id int 
Database-internal ID
of this record,
references BaseEntity
(primary key) 

NO 

terminology_role nvarchar (255) Role in relation to NO 

Page 579



descriptors or states
("unknown"=role not
known or not
specified;
"diagnostic"=optimized
for identification;
"iconic"=icon/thumbnail
, needs text;
"normative"=defines a
resource object;
"primary"=display
always, informative
without text;
"secondary"=display
only on request)
Default value:
'unknown' 

ranking_for_terminolog
y tinyint 

Ranking of the
resource with respect
to terminology; range:
0 to 10
Default value: NULL 

YES 

descriptor_id int 

Optional reference to
a descriptor (at least
1 of description_id,
node_id, descriptor_id,
state_id or taxon_id
must be present)
(foreign key)
Default value: NULL 

YES 

state_id int 

Optional reference to
a categorical state (at
least 1 of
description_id,
node_id, descriptor_id,
state_id or taxon_id
must be present)
(foreign key)
Default value: NULL 

YES 

taxon_role nvarchar (255) 

Role in relation to taxa
or descriptions
("unknown"=role not
known or not
specified;
"diagnostic"=optimized
for identification;
"iconic"=icon/thumbnail
, needs text;
"normative"=defines a
resource object;
"primary"=display
always, informative
without text;
"secondary"=display
only on request)
Default value:
'unknown' 

NO 
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ranking_for_taxon_use tinyint 

Ranking of the
resource with respect
to taxa or
descriptions; range: 0
to 10
Default value: NULL 

YES 

taxon_id int 

Optional reference to
a taxon (at least 1 of
description_id,
node_id, descriptor_id,
state_id or taxon_id
must be present)
(foreign key)
Default value: NULL 

YES 

description_id int 

Optional reference to
a description (at least
1 of description_id,
node_id, descriptor_id,
state_id or taxon_id
must be present)
(foreign key)
Default value: NULL 

YES 

scope_id int 

Reference to the
scope of the resource
(e.g. "sex", "stage",
"season" etc.)
Default value: NULL 

YES 

display_embedded tinyint 

false/0: display as link,
true/1: display as
embedded media
object
Default value: '0' 

NO 

label nvarchar (255) 

Short label of (or
caption for) the
resource, e.g. a text
displayed below an
image or instead of
the link 

NO 

detail nvarchar (MAX) 
Additional detail text
explaining or
commenting on the
resource definition 

YES 

language_code nvarchar (3) 

Language of the
resource itself, use zxx
for language
neutral/no linguistic
content (ISO 639-1)
Default value: NULL 

YES 

rights_text nvarchar (255) 
The rights and licence
statement for the
resource
Default value: NULL 

YES 

licence_uri nvarchar (255) 
URI of licence for the
resource
Default value: NULL 

YES 
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display_order int 

A positive number
defining the sequence
in which multiple
resources are
displayed
Default value: '0' 

NO 

node_id int 

Optional reference to
a descriptor tree node
(at least 1 of
description_id,
node_id, descriptor_id,
state_id or taxon_id
must be present)
(foreign key)
Default value: NULL 

YES 

Table ResourceVariant
Different resource variants/instances/service access points

Column Data type Description Nullable 

id int 
Database-internal ID
of this record,
references BaseEntity
(primary key) 

NO 

resource_id int 

Reference to the
resource to which
these variants provide
access points (foreign
key) 

NO 

variant_id int 

Reference to the
definition of a variant
class e.g. "tiny
sample", "small
sample", "lower
quality", "medium
quality", "good quality"
or "best quality"
(foreign key) 

NO 

url nvarchar (255) URL of the resource
variant NO 

pixel_width int 
Where applicable (still-
or moving image): the
width in pixel
Default value: NULL 

YES 

pixel_height int 
Where applicable (still-
or moving image): the
height in pixel
Default value: NULL 

YES 

duration int 

Where applicable
(sound or moving
image): the duration in
seconds
Default value: NULL 

YES 
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size int 
The size of the
resource in bytes
Default value: NULL 

YES 

mime_type nvarchar (255) 

Type of the resource
as MIME type like
image/jpeg; color as
color/hexrgb
Default value: NULL 

YES 

Table ResourceVariant_Enum
Classes for resource variants, values are predefined in the database

Column Data type Description Nullable 

id int 
Database-internal ID
of this record,
references BaseEntity
(primary key) 

NO 

label nvarchar (255) 

Short label (or name)
of resource variant
class ("tiny sample",
"small sample", "lower
quality", "medium
quality", "good quality"
or "best quality") 

NO 

code nvarchar (255) Brief code equivalent
to the (longer) label NO 

detail nvarchar (MAX) 
Additional detail text
explaining the resource
variant class 

YES 

quality_order int 

A positive number
providing a filter
mechanism for "tiny
sample" to "best
quality"; the smaller
the number, the less
quality a resource has
Default value: '0' 

NO 

Table SamplingEvent
A sampling event may contain many sampling units

Column Data type Description Nullable 

id int 
Database-internal ID
of this record (primary
key) 

NO 

description_id int 
Reference to the
description to which
these sampling data
belong (foreign key) 

NO 
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label nvarchar (255) 

Free-form text
identifying a sampling
event to humans.
Sampling events have
time, location, perhaps
purpose and act as a
container for multiple
sampling units.
Default value: NULL 

YES 

detail nvarchar (MAX) 
Free-form text giving
detail or description of
sampling event 

YES 

date_time datetime 

Date and time when
the event occurred;
single point or start of
duration
Default value: NULL 

YES 

datetimespan_end datetime 

Optional end of a time
span or duration within
which or during which
the event occurred
Default value: NULL 

YES 

geographic_area nvarchar (255) 
A geographic area at
which the event
occurred
Default value: NULL 

YES 

geographic_area_uri nvarchar (255) 
Reference to a
geographic area in
DiversityGazetteers
Default value: NULL 

YES 

coord_dec_latitude float 

Latitude of
geographical
coordinates in signed
decimal degrees
Default value: NULL 

YES 

coord_dec_longitude float 

Longitude of
geographical
coordinates in decimal
degrees
Default value: NULL 

YES 

coord_literal nvarchar (255) 

Free-form string,
either in addition to or
instead of code (a
mapping to the
controlled vocabulary
may be unavailable or
considered ambiguous)
Default value: NULL 

YES 

coord_geodeticdatum nvarchar (50) 

Optional, only where
knowledge of the
geodetic datum is
readily available;
defaults to WGS84
used in GPS
Default value: NULL 

YES 
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Table SamplingUnit
Sampling unit data

Column Data type Description Nullable 

id int 
Database-internal ID
of this record (primary
key) 

NO 

sampling_event_id int 

Reference to a
sampling event; keeps
paired measurements
together (several
categorical or
quantitative
observations at the
same time on the
same object or object
part) (foreign key) 

NO 

collection_specimen nvarchar (255) 
A collection specimen
that is represented by
the sampling unit
Default value: NULL 

YES 

collection_specimen_ur
i nvarchar (255) 

Reference to a
collection specimen in
DiversityCollection
Default value: NULL 

YES 

Table SexStatus_Enum
Values of sex status predefined according to SDD 1.1 rev 5

Column Data type Description Nullable 

id int 
Database-internal ID
of this record,
references BaseEntity
(primary key) 

NO 

label nvarchar (255) Short label (or name)
of sex status NO 

code nvarchar (255) Code of sex status NO 

abbreviation nvarchar (255) One or two (intuitive)
characters NO 

detail nvarchar (MAX) 
Additional detail text
explaining or
commenting on the
sex status definition 

YES 

display_order int 

A positive number
defining the sequence
in which sex status
values are displayed
Default value: '0' 

NO 
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Table StatisticalMeasure_Enum
The statistical measures predefined according SDD 1.1 rev 5

Column Data type Description Nullable 

id int 
Database-internal ID
of this record,
references BaseEntity
(primary key) 

NO 

label nvarchar (255) Short label (or name)
of statistical measure NO 

code nvarchar (255) 
Code of statistical
measure according
SDD 1.1 rev 5 

NO 

abbreviation nvarchar (255) Abbreviation of
statistical measure NO 

display_order int 

A positive number
defining the sequence
in which statistical
measures are
displayed
Default value: '0' 

NO 

Table TextDescriptorData
The text data of a description

Column Data type Description Nullable 

id int 
Database-internal ID
of this record (primary
key) 

NO 

description_id int 
Reference to
description to which
these data belong
(foreign key) 

NO 

descriptor_id int 
Reference to a text
descriptor to which
the free-form text
belongs (foreign key) 

NO 

content nvarchar (MAX) 
Free-form text
referring to information
on one descriptor 

NO 

notes nvarchar (MAX) 
Free-form text
detailing special cases
or additional data
beyond the values 

YES 

Table TextSamplingData
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Free-form text data recorded for a sampling event

Column Data type Description Nullable 

id int 
Database-internal ID
of this record (primary
key) 

NO 

sampling_unit_id int 
Reference to a
sampling unit (foreign
key) 

NO 

descriptor_id int 
Reference to
descriptor to which
the free-form text
belongs (foreign key) 

NO 

content nvarchar (MAX) 
Free-form text
referring to information
on one descriptor 

NO 

notes nvarchar (MAX) 
Free-form text
detailing special cases
or additional data
beyond the data 

YES 

Table Translation
The translations of entries related to BaseEntity

Column Data type Description Nullable 

id int 
Database-internal ID
of this record (primary
key) 

NO 

object_id int 

Reference to the
object to which the
translation belongs,
references BaseEntity
(foreign key) 

NO 

language_code nvarchar (3) 
Language of
representation
translation (ISO 639
language code) 

NO 

column_id int 
References the
translated column
name 

NO 

contents nvarchar (MAX) Translated contents YES 

Table TranslationColumn_Enum
The TranslationColumn_Enum contains the column names that are
translated in the Translation table

Column Data type Description Nullable 
id int Database-internal NO 
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object ID of this
record (primary key) 

column nvarchar (255) 
Name of column that is
translated in the
Translation table 

NO 
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Workbench project related tables
Information concerning the workbench projects and related tables are stored in the tables
shown in the diagram below. The local project (table "Project") relates the workbench project
(table "ProjectProxy") with attribute "ProjectProxyID". The tables "UserProxy", "ProjectUser"
and "ProjectProxy" allow a independent administration of the basic functions related to
projects and users. 

 

 

Index
 ProjectProxy

 ProjectUser

 UserProxy

Table ProjectProxy
The projects as stored in the module DiversityProjects

Column Data type Description 

ProjectID int ID of the project to which the specimen belongs (Projects are
defined in DiversityProjects) 

Project nvarchar (50) The name or title of the project as shown in a user interface
(Projects are defined in DiversityProjects) 
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ProjectURI nvarchar (255) URI of a project in a remote module, e.g. refering to database
DiversityProjects 

Table ProjectUser
The projects that a user can access

Column Data type Description 

LoginName nvarchar (50) A login name which the user uses for access the
DivesityWorkbench, Microsoft domains, etc.. 

ProjectID int ID of the project to which the specimen belongs (Projects are
defined in DiversityProjects) 

ReadOnly bit If the user has only read access to data of this project
Default value: (0) 

Table UserProxy
The user as stored in the module DiversityAgents

Column Data type Description 

LoginName nvarchar (50) A login name which the user uses for access the
DivesityWorkbench, Microsoft domains, etc.. 

CombinedNameCache nvarchar (255) The short name of the user, e.g. P. Smith 

AgentURI nvarchar (255) URI of a user in a remote module, e.g. refering to
database DiversityAgents 

Queries xml (MAX) Queries created by the user 
ID int ID of the user 

PrivacyConsent bit If the user consents the storage of his user name in
the database 

PrivacyConsentDate datetime 
The time and date when the user consented or
refused the storage of his user name in the
database 
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Diversity Workbench
The Diversity Workbench is composed of components for building and managing biodiversity
information, each of which focuses on a particular domain. Each component can provide
services to the other components. DiversityDescriptions can link data to the
modules DiversityCollection, DiversityTaxonNames, DiversityGazetteers
and DiversityReferences as illustrated in the image below. DiversityProjects together with
DiversityAgents provide support for administration of data access rights. 

 

The modules communicate with each other to provide their services for the other modules.
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Modules
The Diversity Workbench  is a set of components for building and managing biodiversity
information, each of which focuses on a particular domain. 

DiversityAgents 
Administration of the agents, i.e. people and institutions which should be documented with e.g. their addresses 

DiversityCollection 
Administration of the scientific collections, specimens within these collections and observations 

DiversityDescriptions 
Administration of the descriptive data 

DiversityGazetteers 

A data collection to enable the linking of geographical records with the Getty Thesaurus of Geographical Names (TGN), the
German GN250 database and other sources of geographical names 

DiversityProjects 
Administration of projects 

DiversityReferences 
Administration of litarature references 

DiversityTaxonNames   
Administration of taxonomic names, their synonyms and hierarchical position 

Each module provides services for the other modules. To use the service of a module, you
need access to the database of the module and optionally the module application placed in
your application directory.  
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Module related entry
The Diversity Workbench  is a set of components for building and managing biodiversity
information, each of which focuses on a particular domain. Each module provides services for
the other modules. To use the service of a module, you need access to the database of the
module and optionally the module application placed in your application directory. Entries
related to an external module have a standard interface in the main form. There are 2
states of this interface:

1 - the value is only set in the local database with no connection to the remote module

In this state, you can either type the value or select it from the values that are already
available in the database. To get a list of the available values type the beginning of the value

(you may use wildcards) and click on the  button. If you want to set a relation to the
remote module, click on the  button. A window will open where you may select an
entry from the foreign database. 
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2 - the value is related to the remote module

If the value has a relation to the remote module, the interface will appear as shown above. To
release the connection to the remote module click on the button. If you need further
information about the value, click on the  button. This will open a form, showing an
overview of the related value. 
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If the client application of the module is available you can inspect the details of the entry.   

 

3 - relation to a webservice

Some modules provide the possibility to link your data to an external webservice. For
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example DiversityTaxonNames gives you access to the taxonomic names of IndexFungorum.
To establish a connection to an external webservice, click on the  button. As with the link
to modules within the Diversity Workbench a window will open where you can choose from
either Diversity Workbench modules or external Webservices. See Webservice for further
details
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Webservice - foreign sources
Some modules within the Diversity Workbench provide the possibility to link your data to an
external webservice. For example DiversityTaxonNames gives you access to the taxonomic
names of IndexFungorum. To establish a connection to an external webservice, click on the 

 button. A window will open where you can choose from either Diversity Workbench
modules or external Webservices. The currently provided webservices are:

The Catalogue of Life 

Index Fungorum 

MycoBank Database 

The Palaeontology Database 

Pan-European Species directories Infrastructure 
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Catalogue of Life - webservice 
Diversity Workbench provides the possibility to link your data to an external webservice. The
webservice provided by the Catalogue of Life allows linkage of taxon names. To establish a
connection to this external webservice, click on the  button. A window will open where you
can choose this webservice (see below). Remark: By selecting "CatalogueOfLife" you can
search in the 2014 annual check list, by selecting "CatalogueOfLife_2" you can search in a
newed, updated edition, which includes higher taxa. 

In the field Name in Query conditions enter you search string and click on the button to
start the query. In the list of the left upper part the results of the query will be listed. In the
right part of the window additional information is shown as provided by the webservice. If
available, the lower part of the window will show the webpage of the related information. 

Page 598

http://www.catalogueoflife.org/col


Higher taxa and for synonyms the accepted name will be shown as e.g. shown above. To
inspect one of these entries, click on the linked entry of the ID. To take the link from the
webservice into your database choose one of the entries in the list and click OK. The entry
will change as shown below.

If you double-click on the link area a window will open, providing you with the retrieval
information of the webservice. 

To get the information related to an entry as provided by the webservice, click on the 
 button. A window will open as shown below where the informations of the webservice are
listed in the upper part. If available, additional informations provided on a corresponding
website will be shown in the lower part.
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If you want to remove the link to the webservice, click on the  button. This will only remove
the relation to the webservice, not the cached name. 
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Index Fungorum - webservice
Diversity Workbench provides the possibility to link your data to an external webservice. The
webservice provided by the IndexFungorum allows linkage of taxon names. To establish a
connection to this external webservice, click on the  button. A window will open where you
can choose this webservice (see below).  

Enter the query restriction for the name in the Name field in Query conditions. The maximal

number of records you get can be set in the max. results field (choose a low
number if you have a slow connection to the internet). Then click on the search button to
start the query. In the list of the left upper part the results of the query will be listed. In the
right part of the window additional information is shown as provided by the webservice. For
certain entries buttons will appear, as e.g. shown above for the basionym and the current
name of a scientific name. Click on these buttons if you want to change to one of these
related datasets from the webservice. If available, the informations provided on the
corresponding website is shown in the lower part. To take the link from the webservice into
your database choose one of the entries and click OK. The entry will change as shown below.
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If you double-click on the link area a window will open, providing you with the retrieval
information of the webservice. 

To get the whole information related to this entry as provided by the webservice, click on the 
 button. A window will open as shown below where the informations of the webservice are

listed, If available, the lower part will show the corresponding informations of a website.

If you want to remove the link to the webservice, click on the the  button. This will only
remove the relation to the webservice, not the cached name. 
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MycoBank Database - webservice
Some modules within the DiversityWorkbench provide the possibility to link your data to an
external webservice. For example DiversityTaxonNames gives you access to the taxonomic
names of the MycoBank database. To establish a connection to this webservice, click on the

button. A window will open where you can choose MycoBank from the database list (see
below).  

Enter the query restriction for the name in the Name field in Query conditions. Click on the
search button to start the query. In the list in the left upper part the results of the query
will be listed. On the right part of the window additional information is shown as provided by
the webservice. If available, the information provided on the corresponding website is shown
in the lower part. To include the link from the webservice into your database choose one of
the entries and click OK. The entry will change as shown below.

If you double-click on the link area , a window will open providing you with the retrieval
information of the webservice. 
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To receive the entire information related to this entry as provided by the webservice click on
the button. A window will open as shown below where information on the webservice is
listed. If available, the lower part will show the corresponding information of a website.

If you wish to remove the link to the webservice, click on the button. This will only remove
the relation to the webservice, not the cached name. 
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The Palaeontolgy Database - webservice 
Diversity Workbench provides the possibility to link your data to an external webservice. The
webservice provided by the Palaeontology Database allows linkage of taxon names. To
establish a connection to this external webservice, click on the  button. A window will open
where you can choose this webservice (see below). 

In the field Name in Query conditions enter you search string and click on the button to
start the query. In the list of the left upper part the results of the query will be listed. In the
right part of the window additional information is shown as provided by the webservice. The
lower part of the window will show the webpage of the related information. 
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For synonyms, the accepted name will be shown as well as e.g. shown above. To change to
the accepted name, click on the linked entry of the ID - in the example above id: 57254. To
take the link from the webservice into your database choose one of the entries in the list and
click OK. The entry will change as shown below.

If you double-click on the link area a window will open, providing you with the retrieval
information of the webservice. 

To get the information related to an entry as provided by the webservice, click on the 
 button. A window will open as shown below where the informations of the webservice are
listed in the upper part. If available, additional informations provided on a corresponding
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website will be shown in the lower part.

If you want to remove the link to the webservice, click on the  button. This will only remove
the relation to the webservice, not the cached name. 
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Pan-European Species directories
Infrastructure - webservice
Some modules within the DiversityWorkbench provide the possibility to link your data to an
external webservice. For example DiversityTaxonNames gives you access to the taxonomic
names of the Pan-European Species directories Infrastructure (PESI). To establish a
connection to this webservice, click on the button. A window will open where you can
choose PESI from the database list (see below).  

Enter the query restriction for the name in the Name field in Query conditions. Click on the
search button to start the query. In the list in the left upper part the results of the query
will be listed. On the right part of the window additional information is shown as provided by
the webservice. If available, the information provided on the corresponding website is shown
in the lower part. To include the link from the webservice into your database choose one of
the entries and click OK. The entry will change as shown below.
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If you double-click on the link area , a window will open providing you with the retrieval
information of the webservice. 

To receive the entire information related to this entry as provided by the webservice click on
the button. A window will open as shown below where information on the webservice is
listed. If available, the lower part will show the corresponding information of a website.

If you wish to remove the link to the webservice, click on the button. This will only remove
the relation to the webservice, not the cached name. 
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